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1. Introduction
This manual covers features or areas of Cinelerra that are different or new in the Cinelerra-GG Infinity
version. Many of the new features were created by a lot of different people to include the original
author and were merged in from various sources and each person is to be commended for their efforts.
The content of this manual also came from various people/places/email and thanks to all.
The standard Cinelerra Manual covers “The Secrets of Cinelerra” and can be found at:
https://cinelerra-cv.org/docs/cinelerra_cv_manual_en.html

1.1 How to Build Cinelerra-GG Infinity from Developer's Git Repository
These are generic build instructions for building Cinelerra-GG Infinity. Known to work on ubuntu,
mint, suse, fedora, debian, centos, arch, and 32-bit slackware. It has not been tested on every single
possible distro yet so you might expect to have to make some minor changes. It has failed miserably
on FreeBSD. At least once, a Gentoo version was successfully created.
Alternatively, there are some pre-built dynamic or static binaries which are updated on a fairly regular
basis (as long as code changes have been made) available at link below. See Section 1.2.
https://cinelerra-gg.org/download/
There are 2 kinds of builds, the default system-build and a single-user build. A system build has results
which are installed to the system. The majority of the files are installed in the standard system paths,
but some customization is possible. The single user build allows for running completely out of a local
user directory so it doesn't affect the system.
We recommend the single-user version when possible. It makes it very easy to install a new version
without having to delete the older version in case you want it for backup – once you are happy with the
new version, all you have to do is delete the entire old directory path. Also, if you install a new
Operating System version and if you have Cinelerra on separate disk space that is preserved, you won't
have to reinstall Cinelerra. In addition for purposes of having the ability to interrupt or to see any
possible error messages, if you start the application from a terminal window command line you will
have more control to catch problems. The system builds can be useful in a university lab setting where
there are possibly multiple users, or multiple versions.
There are two notable differences between “standard” views of Cinelerra and this implementation for
the system builds. Both of these can be configured during installation. These differences make it
possible to have several different versions installed without having them “walk” on each other.
1) application name can be set during installation and defaults to: “cin”
2) the home configuration directory can also be set and defaults to: “$HOME/.bcast5”
To do a system build, you should read the README that is at the top level after you get the source.

1) You need at least 2.5GB of disk storage to operate a build. Need to have “git” installed.
2) Obviously in order to install into the system, you must run as root.
3) The "git" step has to download a bunch of stuff (approx 100MB) so allow time.
4) Run the following commands (this takes awhile):
cd /<build_path>/
# this is where you need the 2.5GB of disk space
git clone --depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5
cd cinelerra5/cinelerra-5.1 # toplevel directory
NOTE: if your system has never had Cinelerra-GG Infinity installed, you will have to make sure you
have all of the compilers and libraries necessary. So on the very first build you should run:
./blds/bld_prepare.sh <os> # where <os> represents the Operating System of
centos, fedora, suse, leap, ubuntu, debian.
./autogen.sh
./configure --prefix=/usr # optional parameters can be added here
make 2>&1 | tee log
# make and log the build
5) Check for obvious build errors:
grep "\*\*\*.*error" -ai log
If this reports errors and you need assistance or you think improvements can be made to the build s,
email the log which is listed below to cin@lists.cinelerra-gg.org :
/<build_path>/cinelerra5/cinelerra-5.1/log
6) If there are no build errors, finally just run:
make install
7) If it all worked, you are all setup. Just click on the “blue lady” cinelerra desktop icon.
To do a single-user build, read the README that is at the top level after you get the source.
1) You need at least 2.5GB of disk storage to operate a build. Need to have “git” installed.
2) Recommend you build and run as root, just to avoid permission issues initially.
3) The "git" step has to download a bunch of stuff (approx 100MB) so allow time.
4) Run the following commands (this takes awhile):
cd /<build_path>/
# this is where you need the 2.5GB of disk space
git clone --depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5
cd cinelerra5/cinelerra-5.1
NOTE: if your system has never had Cinelerra-GG Infinity installed, you will have to make sure all of
the compilers and libraries necessary are installed. So on the very first build you should run as root:
./blds/bld_prepare.sh <os> # where <os> represents the Operating System of
centos, fedora, suse, leap, ubuntu, debian.
./autogen.sh
./configure --with-single-user
# the “with-single-user” parameter makes it so
make 2>&1 | tee log
# make and log build (check for errors before proceeding)
make install
Then just start the application by keying in: ./cin in the bin subdirectory OR add a desktop icon by
using the appropriate directory to copy the files to, run as root, and edit to correct the directory path.
cd /cinelerra_directory_path
cp -a image/cin.{svg,xpm} /usr/share/pixmaps/.

cp -a image/cin.desktop /usr/share/applications/cin.desktop
change the “Exec=cin” line to be “Exec=<your_directory_path>/bin/cin”
The preceding directions for doing a single-user build has been meticulously followed to build and run
on a newly installed ubuntu 15 system WITHOUT BEING ROOT except for the bld_prepare.sh and
creating the desktop icon.

1.1.1 Notable Options and Caveats
These procedures and the Cinelerra-GG Infinity software have all been run as “root” on home
laptops/desktops. This provides the best chance to ensure all works correctly and also allows for
handling errors, other problems and potential crashes with the most success. Included in this section
are some of the build variations easily available for normal builds.
To see the full list of features use:
./configure –help
The default build is a system build which uses: ./configure –without-single-user
In the single-user build, the target directory is always “cin”. Because this is also the developer build,
constant names are used throughout. However, you can rename files after the install is complete.
If your distro/operating system has issues with the default install to /usr/local, you might have to
change the location to /usr for a system build. Then you will have to use:
./configure --prefix=/usr
If you wish to change the default directory for a system build you will have to add the destination
directory path on the “make install” line. For example:
make install DESTDIR=<your selected target directory path>
The application name can be set during installation, but defaults to cin so that the GG/Infinity build can
coexist with other Cinelerra builds if necessary. To override the default cin name, use:
./configure --with-exec-name=cinelerra
The home configuration directory can also be set, but defaults to $$HOME/.bcast5. For example:
./configure –with-config-dir=/myusername/.bcast5
NOTE: when you specify parameters to the configure program, it will create a make file as a
consequence. Since in a make file, the $ is a special character, it must be escaped so in order to
represent a $ as part of an input parameter, it has to be stuttered. That is, you will need $$ (2 dollar
signs) to represent a single dollar sign.
It may be necessary on some distros which have missing or incomplete up-to-date libraries, to build
cinelerra without Ladspa. To do so, use:
./configure --prefix=/usr --without-ladspa-build
Note that the with-ladspa-dir is the ladspa search path, and exists even if the ladspa build is not
selected. This gives you the ability to specify an alternate ladspa system path by utilizing the
LADSPA_PATH environment variable (that is, the default ladspa build is deselected).
To build a 10-bit version for x264, it is a sad truth that the x264 library requires “special” builds to

encode 10/12 bit output, and so a separate version of cinelerra is needed to create these kinds of codec
output. To build these:
./configure --with-exec-name=cinx - -enable-x264_hidepth
Unfortunately, this library can only be configured to encode either 8-bit or 10/12-bit but not both
compiled simultaneously. The 10-bit compiled Cinelerra can read 8-bit or 10-bit but can only render to
10-bit. Newer video equipment may take advantage of the 10-bit color depth for improved quality.
Note for 32-bit 14.2 Slackware, Debian, Gentoo, Arch, FreeBSD, before running the configure, you
will need to set up the following:
export ac_cv_header_xmmintrin_h=no
export FFMPEG_EXTRA_CFG=" --disable-vdpau"

1.1.2 Notes about Building from Git in your Customized Environment
Getting a build to work in a custom environment is not easy. If you have already installed libraries
which are normally in the thirdparty build, getting them to be recognized means you have to install the
"devel" version so the header files which match the library interfaces exist. Below is the list of
thirdparty builds, but this list may have changed over time:
a52dec
djbfft
fdk
ffmpeg
fftw
flac
giflib
ilmbase
lame
libavc1394
libraw1394
libiec61883
libdv
libjpeg
openjpeg
libogg
libsndfile
libtheora
libuuid
libvorbis
mjpegtools
openexr
tiff
twolame
x264
x265

yes
yes
auto
yes
auto
auto
yes
auto
auto
auto
auto
auto
auto
auto
auto
auto
auto
auto
yes
auto
yes
auto
auto
auto
auto
auto

libvpx

auto

The "yes" means force build and “auto” means probe and use the system version if the build operation
is not static. To get your customized build to work, you need to change the probe options for the
conflicting libraries from "yes" to "auto", or even rework the configure.ac script. There may be several
libraries which need special treatment.
An example of a problem you might encounter with your customized installation is with “a52dec”
which has probes (CHECK_LIB/CHECK_HEADER in configure.ac), but djbfft does not. In this case,
djbfft is only built because a52dec is built, so if your system has a52dec, set a52dec to auto and see if
that problem is solved by retrying the build with:
./confgure --with-single-user –enable-a52dec=auto .
With persistence, you can get results, but it may take several tries to stabilize the build. If you need
help, email the "log" and "config.log", which is usually sufficient to determine why a build failed.
If you have already installed the libfdk_aac development package on your computer because you prefer
this version over the default aac, you will have to do the following to get this alternative operational.
export FFMPEG_EXTRA_CFG=" --enable-libfdk-aac --enable-nonfree"
export EXTRA_LIBS=" -lfdk-aac"
for f in `grep -lw aac cinelerra-5.1/ffmpeg/audio/*`; do
sed -e 's/\<aac\>/libfdk_aac/' -i $f
done

1.1.3 Cloning the Repository for Faster Updates
If you want to avoid downloading the software every time an update is available you need to create a
local "repository" or repo. The repo is a directory where you first do a “git clone”. For the initial git
clone, setup a local area for the repository storage, referred to as <repo_path>. The “git clone” creates
a repo named "cin5" in the /<repo_path>/ directory. This accesses over 300MB of repo data, so the
device has to have at least that available. The repo path is always a perfect clone of the main repo.
Setting up the initial clone: (add “- - depth 1” before cin5 which is faster/smaller, but has no history)
# cd /<repo_path>/
# git clone "git://git.cinelerra-gg.org/goodguy/cinelerra" cin5
Cloning into 'cin5'...
remote: Counting objects: 20032, done.
remote: Compressing objects: 100% (11647/11647), done.
remote: Total 20032 (delta 11333), reused 16632 (delta 8189)
Receiving objects: 100% (20032/20032), 395.29 MiB | 3.26 MiB/s, done.
Resolving deltas: 100% (11333/11333), done.
Checking connectivity... done.
Update an existing repo:
# cd /<repo home>/cin5
# git pull

Useful git commands:
git clone "git://git.cinelerra-gg.org/goodguy/cinelerra" cin5
git pull - pull remote changes to the local version
git status - shows changed files
git clean -i - interactive clean, use answer 1 to "clean"

1.1.4 How to Build from a Previous GIT Version
# cd /<path>/cin5_repo
# git log
# git checkout <version>
The “git log” command produces a log file with hash values for commit keys. The hash ids are the
commit names to use when you use git checkout. Next is displayed sample output:
...
delete stray line in last checkin
commit 4a90ef3ae46465c0634f81916b79e279e4bd9961
Author: Good Guy <good1.2guy@gmail.com>
Date: Thu Feb 22 14:56:45 2018 -0700
nested clips, big rework and cleanup, sams new icons, leaks and tweaks
commit f87479bd556ea7db4afdd02297fc00977412b873
Author: Good Guy <good1.2guy@gmail.com>
Date: Sat Feb 17 18:09:22 2018 -0700
...
For the “git checkout <version>, you would then keyin the line below for the following results:
# git checkout f87479bd556ea7db4afdd02297fc00977412b873
Note: checking out 'f87479bd556ea7db4afdd02297fc00977412b873'.
You are in 'detached HEAD' state. You can look around, make experimental
changes and commit them, and you can discard any commits you make in this
state without impacting any branches by performing another checkout.
If you want to create a new branch to retain commits you create, you may
do so (now or later) by using -b with the checkout command again. Example:
git checkout -b <new-branch-name>
HEAD is now at f87479bd... more file size icon updates, and more to follow
Later to get the repo back to current, use:

1.1.5 Debuggable Single User Build

# git checkout master

To build from source with full debugging symbols, first build a full static (non_debug) build as follows
but with /tmp substituted with a permanent disk path if you want to keep it.
# git clone ...
# cp -a /path/cinelerra-5.1 /tmp/.
# cd /tmp/cinelerra-5.1
# ./bld.sh
Then, to run as a developer in the debugger:
# CFLAGS=-ggdb make -j8 rebuild_all
# cd cinelerra
# gdb ./ci

1.1.6 Unbundled Builds
There are some generic build scripts included in the Cinelerra 5 GIT repository for users who want to
do unbundled builds with ffmpeg already available on their system. This has been tested on Arch,
Ubuntu 18, FreeBSD, and Leap 15 (RPM) at the time this was documented. The names of the build
scripts are: arch.bld , bsd.bld , deb.bld , and rpm.bld . These scripts are in the “blds” subdirectory.
The bsd.bld should be used with the bsd.patch file in that same directory.
The reason that Cin 5 traditionally uses thirdparty builds (bundled builds) is because there are a lot of
different distros with varying levels of ffmpeg and other needed thirdparty libraries. However, some
users prefer using their current system baseline without another/different copy of ffmpeg. With
different levels of the user’s libraries, uncertainty, potential instability, and unknown issues may come
up while running Cin 5 and this will make it, for all practical purposes, impossible to diagnose and
debug problems/crashes. There may be no help in these cases. You are encouraged to report any errors
which potentially originate from cin5, but if the data indicates alternate library sources, please report
the problems to the appropriate maintainers.
With the unbundled builds, some features may not be available and no attempt to comment them out
has been made. So if you use a pulldown, or pick a render option, or choose something that is not
available, it just will not work.. For example, unless special options were set up by you, the LV2 audio
plugins will not be available. Nor will the codec libzmpeg, the file codec ac3, or DVD creation. The
old school file classes will all work, but some of the formats that come with ffmpeg may not because of
the way that ffmpeg was installed on your O/S. That is because the Cinelerra ffmpeg is a known static
build and is usually the latest stable/released version. In the current case of Leap 15, libx264 and
libx265 are not built in and this can be debilitating; You can always run “ffmpeg -formats” and
“ffmpeg -codecs” to see what is available on your system.

1.2 Just Install It! Binaries Already Built
If you prefer to not have to take the time to build Cinelerra-GG Infinity yourself, alternatively there are
some pre-built dynamic or static binaries for various versions of ubuntu, mint, suse, fedora, debian,
centos, and arch-linux. There are 32-bit i686 ubuntu and debian versions and a 32-bit slackware
version available also. These are updated on a fairly regular basis as long as significant code changes
have been made. They are in subdirectories of:
https://cinelerra-gg.org/download/tars
https://cinelerra-gg.org/download/pkgs
The “tars” directory contains single-user static builds for different distros. This is the recommended
usage of Cinelerra-GG because all of the files will exist in a single directory. To install the single user
builds, download the designated tarball from the ./tars subdirectory and unpack as indicated below:
cd /path
mkdir cin
cd cin
tar -xJf /src/path/cinelerra-5.1-*.txz # for the *, substitute your distro tarball name
Do NOT download the LEAP 10bit version unless you use h264 (it can't render 8bit h264).
The “pkgs” directory contains the standard packaged application for various distros. This will install a
dynamic system version for users who prefer to have the binaries in the system area and for multi-user
systems. In addition, performing the package install checks the md5sum in the file md5sum.txt to
ensure the channel correctly transmits the package. There is a README.pkgs file in the “pkgs”
directory with instructions so you can “cut and paste” and avoid typos; it is also shown next.
README.pkgs:
Depending on the distro, use the instructions below and select the appropriate
setup operations to install, update or remove cinelerra-gg.
To upgrade, refresh repo, then replace "install" with "update", or whatever.
Email problems to cin@lists.cinelerra-gg.org
If repository problems, usually you can manually do an install by using:
wget https://cinelerra-gg.org/download/pkgs/{substitute_name}/cin_5.1.<sub_name>.deb
and install it manually, for example: dpkg -i cin_5.1.{substitute_filename}.deb
# FEDORA
dnf install cinelerra --repofrompath cincv,https://cinelerra-gg.org/download/pkgs/fedora/
##dnf erase cinelerra
# CENTOS
# first create the file /etc/yum.repos.d/cincv.repo, with the following contents:
[cincv]
name=cincv
baseurl=https://cinelerra-gg.org/download/pkgs/centos
gpgcheck=0
# end of cincv

yum install cinelerra
##yum erase cinelerra
# UBUNTU, replace ub17 with your distro id: ub14,ub16,ub17,ub18
# Some ubuntu apt downloads register status as working 0% constantly while running the package
# download, like ubuntu 14. It may take a few minutes for this step so be patient.
apt install software-properties-common apt-transport-https
apt-add-repository https://cinelerra-gg.org/download/pkgs/ub17
# UBUNTU 16/17/18 note - This has been known to work, but things change quickly:
# VIP - for the first install, the above line adds cinelerra to /etc/apt/sources.list but...
# Version 16/17/18 of Ubuntu are more strict for licensing so you will have to edit
# the file /etc/apt/sources.list to add [trusted=yes] after deb and before https...cin...
# For example the line should be: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/ub16 xenial
main
# Or for ub17: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/ub17 zesty main
# Or for ub18: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/ub18 bionic main
# Also, on the install you will get an error message that you can either ignore as cinelerra
# will run anyway, or else (the first time only) on the commnand line keyin:
# echo > /etc/sysctl.d/50-cin.conf "kernel.shmmax=0x7fffffff"
apt update
apt install cin
#to update a previous install (ignore any i386 errors as only 64 bit version available):
apt update
apt upgrade cin
##apt remove cin
# MINT should use the same procedure as Ubuntu, but:
# Note: apt-add-repository did not work for me, I had to use the gui version:
# System_OR_Administration->Software Sources->Additional Repositories->Add a new repository
# deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/mint xenial main
# Or for Mint17: deb https://cinelerra-gg.org/download/pkgs/mint17 trusty main
apt update
apt install cin
#to update a previous install
apt update
apt upgrade cin
##apt remove cin
# DEBIAN uses the same basic procedure as Ubuntu,but:
# the latest version will be named just Debian and previous version Debian8
apt install software-properties-common apt-transport-https
apt-add-repository https://cinelerra-gg.org/download/pkgs/debian stretch main
OR apt-add-repository https://cinelerra-gg.org/download/pkgs/debian8 jessie main
# VIP - for the first install, the above line adds cinelerra to /etc/apt/sources.list but...
# Debian stretch and jessie are more strict for licensing so you will have to edit
# the file /etc/apt/sources.list to add [trusted=yes] after deb and before https...cin...
# For example the line should be: deb [trusted=yes] https://cinelerra-gg.org/download/pkgs/debian
stretch main
apt update

apt install cin
#to update a previous install
apt update
apt upgrade cin
##apt remove cin
# SUSE/LEAP
# Note: you may need libavc and libiec versions if not installed & ignore “Package is not signed!”
# openSUSE LEAP 42
zypper ar -f https://cinelerra-gg.org/download/pkgs/leap42/ cincv
# to remove the GPG check
zypper mr -G cincv
# openSUSE LEAP 15
zypper ar -f https://cinelerra-gg.org/download/pkgs/leap15/ cincv
zypper install -r cincv cinelerra
##zypper remove cinelerra
#to update a previous install (assuming you enabled autorefresh as above)
zypper refresh cinelerra
zypper up cinelerra # or cinelerra10bit for 10 bit
# SLACKWARE, substitute slk32 for slk64 and i486-1 for x86_64-1
wget -P /tmp https://cinelerra-gg.org/download/pkgs/slk64/cin-{date}-slk64-x86_64-1_cin.txz
installpkg /tmp/cin...
#to update a previous install
upgradepkg /tmp/cin...
##removepkg cin
# ARCH linux
# first edit the file /etc/pacman.conf, to include the following:
[cincv]
SigLevel = Optional TrustAll
Server = https://cinelerra-gg.org/download/pkgs/arch
# end of cincv
pacman -Sy
pacman -S cin
##pacman -R cin

1.3 The $HOME/.bcast5 Directory
A difference in Cinelerra-GG Infinity is the name of the user's default settings and saved files directory.
It is called .bcast5 as opposed to .bcast as a subdirectory in $HOME. Initially when cinelerra is
launched there is an empty project and there are program default settings, and from then on the .bcast5
directory will contain the settings that were created before the last closing. If you need to revert to the
default settings, delete the .bcast5 directory contents and restart Cinelerra. Or you may want to rename
it temporarily if you think you might want it back later.
Although the location defaults to $HOME/.bcast5, you can use the CIN_CONFIG variable to override
this location. For example: export CIN_CONFIG=/tmp/.bcast5 will use a temporary setup for testing
purposes. It is also useful for multiple users sharing the same home directory who would like to have
different configuration/preferences settings data. And if you are experiencing inexplicable errors or
crashes in cinelerra, they may be due to a problem with .bcast5 in which case taking it out of the picture
can at least eliminate this as the cause.

2. FFMPEG Early Probe Explanation
When you open media, a series of libraries and codec functions are used to "probe" the data, to see if it
can guess the type of file format and codec parameters needed to correctly decode the file. If ffmpeg
probes early - “Try FFMpeg first” is in effect for the button - it will usually find some way to try to
decode just about any contemporary media file. But there are some times that the built in codecs are
actually a better choice. A lot of this may fall into the category of personal preference. For example,
some may prefer the mpeg library in the cinelerra code over the ffmpeg code because it has more
decoding capability and seems to be more robust when the media is damaged. In that case you will
want the FF button to read “Try FFMpeg last” in the upper right hand corner of the main window.
So, if ffmpeg probes early, you will never get to use the built in libraries, and if you want to skip over
buggy old libraries, use ffmpeg early probe enabled so that the newest code will be tried first.
When the icon is red, ffmpeg probes early is enabled and you will see it reads “Currently: Try FFMpeg
first” when moving over the FF button in the upper right hand corner of the screen. When the icon is
black, ffmpeg probes early is disabled so that ffmpeg probes late and it reads “Currently: Try FFMpeg
last”. The initial default state of the icon is on, that is, ffmpeg probes first. This is the original code
behavior before ffmpeg code was added. Suggestion is to leave it on except in a few special cases
where it may be better to have early probes disabled. When you mouse over the main menu ff toggle
button, the text displays ffmpeg's “Currently” set position and “Click to” change it.
The ffmpeg early probe state is saved between sessions and is also affected by choices made in Probe
Order (see section 40.14). It is important to note that the various file indexes may need to be rebuilt if
you change which codec is being used to decode the file. There is a warning popup to remind you
when you change the default ffmpeg early probe state (unless you have checked the box to no longer
show you the warning).

Screenshots below show (1) reddish colored FF in upper right hand corner of main screen indicating
that ffmpeg early probes is enabled; (2) “Try FFMpeg last” indicator message for ffmpeg early probes
enabled (note that the color is different because you highlighted the icon); and (3) black colored FF
indicates ffmpeg will be used last and you are changing the behavior so that Cinelerra warns you
accordingly.
(1)

(2)
(3)

3. How to Create FFMPEG Options Files
This section describes how the FFMpeg options files work for decoding and encoding and goes into
great detail. It will make more sense if you look at cinelerra's ffmpeg config directory and the cinelerra
menus at the same time. It is meant to include everything necessary for complete understanding. You
will be able to personalize your own options files without knowing all of the information included
below if you know the basics. The word encoding is used interchangeably with the word rendering.
The possible combinations for ffmpeg options files are literally combinatorial – that is a lot (factorial!).
The allowed media file format / codec choices are much more flexible than you might realize. When
the ffmpeg design was initially added, some parameter files which describe the choices which the
program uses had to be created. There are way too many to enumerate in the deliverable Cinelerra
package. Some quite detailed information for how ffmpeg options work is given here and hopefully,
enough basics for simple understanding. It may all seem complicated at first, but will become obvious.

3.1 File naming convention
In Cinelerra's ffmpeg configuration directory you will see files as listed and described below. File type
and extension names are the key for Cinelerra's use of ffmpeg. Basically the .opts file extension
represents options; .dfl represents defaults; and all the rest are media types. For example one media
type is quicktime so that *.qt file names would be the “quicktime” choices. In the file names below,
“ext” refers to a set of files with file names matching the *.ext file extension. And “typ” refers to a
type of format / codec combination used, i.e, the media type.

In the ffmpeg configuration directory there are a series of options files used when encoding or decoding
audio or video. They are read in the order from top to bottom and only the files needed for the current
operation are added to the active configuration.
ffmpeg/ffmpeg.opts = global ffmpeg options, always used
ffmpeg/decode.opts = global decoder options, used when opening existing files for decoding
ffmpeg/encode.opts = global encoder options, used when creating new files for encoding
ffmpeg/audio/audio.opts = audio encoder options, used when creating audio streams
ffmpeg/video/video.opts = video encoder options, used when creating video streams
ffmpeg/plugin.opts = parameters for ffmpeg filters as audio/video plugins

Decoder options:
Normally, only ffmpeg.opts and decode.opts are used when reading/decoding files, but may be
specialized if a <path>/media.opts exists for a given <path>/media.ext file. For example, if you want
to only fail on fatal errors and to always use the video filter, edgedetect, when working with your media
file “dreaming.y4m”, then create a file “dreaming.opts” in the same directory with the contents of
“loglevel=fatal” on the first line and “video_filter=edgedetect” on the next. These specialized settings
will override the defaults. The fatal loglevel is especially handy for lesser quality media.

Encoder Options:
Within the audio /video subdirectories of the first level ffmpeg directory, the typ.ext files are for
encoder (rendering) setups.
ffmpeg/audio
= directory of audio encoder settings
audio.opts
= options used by all audio encoders
typ1.ext, typ2.ext, … = are all *.ext type choices for encoding audio
ext.dfl
= contains the default selection used when ext is first selected
ffmpeg/video
= directory of video encoder settings
video.opts
= options used by all video encoders
typ1.ext, typ2.ext, … = are all *.ext type choices for encoding video
ext.dfl
= contains the default selection used when ext is first selected
ffmpeg/format

= presets needed to initialize audio / video formats

3.2 Option File Format / Content
For the option files a specific format must be followed in creating the file content.
In typ.ext encoder parameter files, the first line is defined as:
or

muxer codec
muxer codec | bitstream filter [ bitstream filter options ]

where the | represents piping the codec data through the bitstream filter.

The rest of the lines in the file should look as follows:

or

# in column one is a comment
id1 value1
id2 = value2

Only one equals sign is allowed and it is just for readability. There may be any number of id / value
pair lines in a media definition, including zero. A typical line might be:
or

bitrate 4000000
bitrate = 5000000

There are 4 special id's recognized by cinelerra which cause special processing. They are:
duration
video_filter
audio_filter
loglevel

(overrides the probe duration when opening media for decoding)
(adds an video stream filter, eg. edge detect, … at the stream level)
(adds an audio stream filter, eg. echo, … at the stream level)
(sets the library logging level, as quiet, panic, … verbose, debug)

All other id's should be in the ffmpeg documentation, and correspond to the global, muxer, and codec
option names and values used by ffmpeg. For example to set the aspect ratio to 4:3, use:
aspect 4:3
Below shows an example: "decode.opts" which is used when the ffmpeg decoder is initialized.
# apply at init decode
loglevel=fatal
formatprobesize=5000000
scan_all_pmts=1
threads=auto
The encoder options you see in the cinelerra menus depend on the files in these directories, NOT THE
CODE. If you add files, you will get to use more variety.
In the "cinelerra" directory, which contains the ffmpeg configuration folder, there are the choices the
program uses. When you open an ffmpeg format popup dialog, the listbox contains all of the codec
types which are identified by the file.ext extensions. Decoding has only a few options, since the
ffmpeg file probes determine most of the options by looking at the media being opened, but encoding
media requires a lot of setup. Below are some of the folders and files used to determine the
configurations used by ffmpeg to decode and encode files.
These extensions create audio / video media classes:
dvd m2ts mkv mp3 mp4 mpeg qt pro
which become the choices in the render pulldown menu

So if you want to create a "mov" codec class, add two new files to the ffmpeg configuration directory:
audio/aud.mov and video/vid.mov
Now you will see this as what you can choose in the rendering choices for ffmpeg.
Inside the file you will see that the first line is special. It is the muxer and codec. For example:
h264 libx265
The contents may be something like: <path>/video/vid.mov =
mp4 libx265
bitrate 4000000
This will code an mp4 formatted file using the lib264 codec encoder.
For audio and video together, the mux format must agree between the aud.mov and vid.mov files
when they are to be used together. The stream muxer must be the same for the all the streams in the file
being written.
for example: <path>/audio/aud.mov =
mp4 pcm_mulaw
This will create mp4 media using audio format pcm_mulaw coding.
Both the audio and the video are using mp4 mux format, and so there will be 2 streams:
1) x265 video
2) pcm_mulaw audio
When the menu popup is created, there may be many choices for that class type, so you may want
defaults. That can be specified as:
so:
and:

audio/<class>.dfl and video/<class>.dfl
audio/mov.dft =
aud.mov
video/mov.dft =
vid.mov

The above will be the default choice when the menu opens.
When you see problems in using the new options files you have created and put into place, add the
following line to ffmpeg/encoder.opts:
loglevel=verbose
sometimes that will be enough to see what has caused a failure, or even catch unexpected results.
Now there is an EXCEPTION to all of the above because of a conflict between ffmpeg and the x264

person making the detection of default ffmpeg settings terminate with an error. If you get this error,
you must workaround this termination by including parameters that don't match 5 or more of the
normal expected values. So you just have to change a few parameters to avoid the probe detection.
Here is an example where you will notice the x264opts line tweaking values to throw off the detection/
error termination code.
<path>/ffmpegvideo/test.mp4 =
mp4 libx264
preset=slow
x264opts keyint=25:min-keyint=4:qpmin=3:qpmax=33:qp_step=4:merange=8
crf 20
Another EXCEPTION is for some forms of aac, which is the reason had to add bitstream filters.
If you think that you are in this situation, use:
<path>/ffmpeg/audio/test.mp4 =
mp4 libfdk_aac
For more examples, look around the ffmpeg dir for examples which may be close to what you are
trying to use, and see if the parameters look usable.
This is quite complicated, but that is because ffmpeg has a lot of parameters and history. Good results
are not that hard to create. Initially you should mostly use the defaults. If you send any new options
files to cin@lists.cinelerra-gg.org , it may be given consideration to being added to the baseline for the
possibility for future deliverables.
To get a listing of the current ffmpeg supported formats and codecs that can be made to work with
cinelerra, provided there are option files added, run the following commands. This should be done
from the <build>directory substituting the location of <build> where you have installed cinelerra on
your system and the ffmpeg may be a later version than 3.1.2 as used below. Then look at the output
created in /tmp/ff-formats.txt and codecs.txt.
/<build>/cinelerra-5.1/thirdparty/ffmpeg-3.1.2/ffmpeg -formats > /tmp/ff-formats.txt
/<build>/cinelerra-5.1/thirdparty/ffmpeg-3.1.2/ffmpeg -codecs > /tmp/ff-codecs.txt

3.3 Complete Options File Example
For illustrative purposes, here is an example of the options files that need to be added for using the
ffmpeg ProRes 422 format. This makes it possible to transcode to h264.mov with FFmpeg retaining 10bit yuv422p from the source to the target output video.
Add the file named “./ffmpeg/audio/acc256k.pro” which contains the following lines:
mov aac
strict -2
b 256000
(Note that in the example above, even though the bitrate is set here to 256000, it can be
overridden by the render menu settings).
Add the file named “./ffmpeg/audio/pro.dfl” which contains the following lines:
acc256k.pro
Add the file named “./ffmpeg/video/med422p10.pro” which contains the following lines:
mov prores
preset medium
pix_fmt yuv422p10le
Add the file named “./ffmpeg/video/pro.dfl” which contains the following lines:
med422p10.pro
Then to use and to get 10 bit depth and preserve depth from decode to encode:
1) load media
2) use settings->format to set the frame rate, sample rate/channels, aspect ratio,
color model = rgb_float or rgba_float if blending
3) press Shift-R and select FFMpeg format type “pro”
4) select target path
5) check ok, and watch for messages in the terminal window

3.4 Webm / Vp9 Usage and Documented Example File (credit Frederic Roenitz)
There are some common VP9 rendering options files that support creation of video for YouTube,
Dailymotion, and other online video services. Webm / VP9 is a media file format which is free to use
under the BSD license and is open-source; thus there are no licensing issues to be concerned about.
The Webm container is based on Matroska for video and Opus for audio.
Youtube easy startup steps are documented in section 41.7. These same steps have been verified to
work for creating Dailymotion videos – however, the created files must be renamed before uploading to
change the youtube extension to webm instead for Dailymotion.
-------------------------------------------Below is one of the VP9 rendering options file with documentation for specifics:
webm libvpx-vp9
# 20171114-2203
# from https://developers.google.com/media/vp9/settings/vod/
# 1280x720 (24, 25 or 30 frames per second)
#
#
# Bitrate (bit rate)
#
# VP9 supports several different bitrate modes:
# mode
# Constant Quantizer (Q) Allows you to specify a fixed quantizer value; bitrate will vary
# Constrained Quality (CQ) Allows you to set a maximum quality level. Quality may vary within
bitrate parameters
# Variable Bitrate (VBR) Balances quality and bitrate over time within constraints on bitrate
# Constant Bitrate (CBR) Attempts to keep the bitrate fairly constant while quality varies
#
# CQ mode is recommended for file-based video (as opposed to live
# streaming). The following FFMpeg command-line parameters are used
# for CQ mode:
#
# FFMpeg
# -b:v <arg>
Sets target bitrate (e.g. 500k)
# -minrate <arg> Sets minimum bitrate.
# -maxrate <arg> Sets maximum bitrate.
# -crf <arg> Sets maximum quality level. Valid values are 0-63, lower numbers are higher quality.
#
# Note: Bitrate is specified in kbps, or kilobits per second. In video
# compression a kilobit is generally assumed to be 1000 bits (not
# 1024).
#
# Note: Other codecs in FFMpeg accept the -crf parameter but may
# interpret the value differently. If you are using -crf with other
# codecs you will likely use different values for VP9.

bitrate=1024k
minrate=512k
maxrate=1485k
crf=32
# Tiling splits the video into rectangular regions, which allows
# multi-threading for encoding and decoding. The number of tiles is
# always a power of two. 0=1 tile, 1=2, 2=4, 3=8, 4=16, 5=32.
tile-columns=2
# modified from https://trac.ffmpeg.org/wiki/EncodingForStreamingSites
# To use a 2 second GOP (Group of Pictures), simply multiply your output
# frame rate * 2. For example, if your input is -framerate 30, then use
# -g 60.
g=240
# number of threads to use during encoding.
threads=8
# May be set to good, best, or realtime
quality=good
# This parameter has different meanings depending upon whether quality
# is set to good or realtime. Speed settings 0-4 apply for VoD in good
# and best, with 0 being the highest quality and 4 being the
# lowest. Realtime valid values are 5-8; lower numbers mean higher
# quality
speed=4

3.5 The FFMPEG Image2 Streams
Another feature gained from using ffmpeg in cinelerra takes advantage of what is being referred to as
the “%d trick”. This trick uses the ffmpeg muxer image2 and a filename template to create a series of
image files of a given kind. A specific example is described below.
To encode a series of 48 bit tiff output image files, add a file to the cinelerra data ffmpeg/video
subdirectory as in:
filename: .../ffmpeg/video/tiff.dfl containing the line:
tiff48.tif
Then create an ffmpeg video encoder parameters file in the same directory:
filename: .../ffmpeg/video/tiff48.tiff containing the next 2 lines:
image2 tiff
pixel_format=rgb48
This will define a new ffmpeg encoder format which is a video image file format that uses the tiff

codec for encoding, and a pixel_format of rgb48 (or a similar equivalent such as rgb48le). Next load
up your project and set up for a Render using File→Render in the usual way. Now the tricky part; the
output file name should contain a %d which will be the frame number used in the image output
filename as in: Select a file to render to = /tmp/tiff_images/img%03d.tiff. You will get multiple files as
output – one for each frame!
The resulting directory of images can be opened for reading by simply opening the template path. As
in: File→Load Files = /tmp/tiff_images/img%03d.tiff. You will notice a file named as same as the
template, which has been automatically created, is empty,is needed, and has to remain with the set.

3.6 Ffmpeg Common H.264 Rendering
Because H.264 is so widely used, the method in Cinelerra-GG Infinity is outlined below. These setup
steps make it easy to just get started.
File->Render
File Format->FFMPEG + mp4
Video Wrench->Preset->h264.mp4 + bitrate: 6000000 (or whatever) +OK
Audio Wrench->Preset->h265.mp4 + bitrate: 224000 (or whatever) + OK
Set your target path in: Render=>Select a file to render to
Set your timeline in: Render=>Render range + click Project
Set your insertion strategy: Replace project (or whatever)
Press OK to start rendering.

3.7 Extra “cin_” options for Render with ffmpeg
There are several special parameters that can be used in the ffmpeg options file to pass values to the
codecs that are not normally available. These are explained below.
1) cin_pix_fmt
The Render menus allows you to choose the codec input pixel format. The Pixels selection provides
the available pixel format options for the chosen codec type; valid choices vary for the different file
types. This list represents the formats that the codec advertises. It is not always complete, and it may
include options that are not legal with all parameter configurations.
Screencast below shows the Render menu and the Video Preset menu shown after clicking on the Video
wrench, and producing the listbox popup for Pixels.

← ffmpeg file format

← video presets compression

← This down arrow shows optional
pixel formats for ffmpeg m2ts.

- The Bitrate, Quality, and Pixels fields are only updated when the Video Options are reloaded. This
occurs when you either change the fffmpeg file format, or video presets compression fields.
- If the video options preset has cin_pix_fmt defined, its value will be loaded as the default. If you
override the default, the value you specify will be used.
- If the video options preset does not have cin_pix_fmt, the default pixel format will be computed by
ffmpeg (avcodec_find_best_pix_fmt_of_list), using the session format as the source choice. The

“best” is usually the format which is most similar in color and depth.
- If no choices are available, yuv420p for video will be used.
- You can also specify ffmpeg pixel formats which are not in the list. The list is provided by ffmpeg
as input selection, but is more like suggestions than fact. For example, the raw formats can take
almost any format, but the rawvideo codec actually specifies no legal formats.
Some option files provide cin_pix_fmt to suggest a choice for good quality output or to prevent
parameter errors when the other provided parameters conflict with the “best” pixel format. This is the
case in faststart_h264.mp4 where the profile=high parameter dictates that the pixel format must be
yuv420p.
2) cin_bitrate
If you specify the bitrate, you can not specify the quality.
Example: cin_bitrate=2000000
3) cin_quality
If you specify the quality, you can not specify the bitrate.
Example: cin_quality=7
4) cin_stats_filename
This parameter is useful for 2 pass operations.
Example: cin_stats_filename /tmp/cin_video_vp9_webm
5) cin_sample_fmt
For audio the preset sample format default is computed in a similar way as stated above for video or
can be set with the cin_sample_fmt parameter. If no choices are provided, s16 will be used.
Example: cin_sample_fmt=s16

← ffmpeg file format

← audio presets compression

← pulldown choices of s32p, fltp, s16p

4. Viewing & Modifying Ffmpeg Format Options inside Cinelerra
There are thousands of options for using ffmpeg. Now it is possible to “view” the available options for
a particular video and audio choice by using the “wrench icon” and then clicking on the “view” box.
Ffmpeg has to be the selected file format for this feature to be visible. It makes it a lot easier since only
the applicable options show up as opposed to everything that ffmpeg can do. These options are just
“Hints” and some may be missing due to the way that ffmpeg options are coded – Cinelerra shows the
option data ffmpeg has exposed.
As an example, instead of reading the entire 264 library information, you only have to look at the
shown available options. Both the video and the audio are browsable. The options visible in the Audio/
Video Preset textbox are the final values which are used when rendering once you have checked OK.
For assistance in choosing the options you want, use the view popup to see the objects that go with the
selected format tool, highlight the option, modify the parameter value in the box at the top of the
“Options” window based on what you want, and then click apply. Updates modify parameter values or
new parameters will be appended at the bottom. Note that when you highlight an option a tooltip will
show up when available in the lower right hand corner which describes the option. Also note that the
Format and Codec types are shown on the top line of the Options window.
Parameters exist in 3 layers: ffmpeg, codec, and an interface layer. You can apply parameters to each
layer. The top 2 layers are accessed with the Kind popup menu. The ffmpeg layer is topmost, and is
selected as Kind: ffmpeg. It can specify many of the more common parameters, such as the bitrate,
quality, and so on. The middle layer is selected as Kind: codec. These options can specialize your
choices, and frequently includes presets and profiles useful for coding well known parameter sets, like
profile=high422, preset=medium, or tune=film, etc. The interface layer may or may not be available.
It is usually accessible only by an “opts” parameter, like x264opts=key=value:key=value:... These
options are passed directly to the low level codec library.

The 2 screenshots next show “ffmpeg” for as the Kind: for Video first and then “codec” Audio second.
Note the x264opts in the Video Preset window immediately below.

Note the yellow tooltip in the lower right hand corner describing the highlighted option. Also note the
allowed “Range” values above the box provided for keyins.

5. FFMPEG Items of Note
Quality Option when rendering: Ffmpeg responds variably to the quality option in the render option
but seems to respond well to bitrate. The subranges used by quality even seem to vary somewhat
depending on how old the codec is. Some use 0 to 35, some use 0 to 500 or so. The quality is supposed
to cause the codec to output data until the noise level is below a limit determined by the quality setting.
Your specific results may vary.
Previous Changes when rendering: With ffmpeg there are 2 cases that the defaults will be used. The
first time when you have nothing set up and any other time when you reset the render File Format in
the Render Menu. Otherwise with ffmpeg if you change a video compression type for the render (for
example h265.mp4 to h265.mp4), the settings will be from the previous session settings.
Outstanding Issues with ffmpeg: There are some problems that need to be addressed by the ffmpeg
developer group that adversely affect Cinelerra. These are stated below with the hopes that that group
will fix them as time permits.
1) Make all the default parameters operational. When they are not, the Cinelerra plugins can't
be initialized since the initial state of the filter is not operational. If that is not possible, then
provide a set of nominal parameters for each plugin, so that they can be used as the plugins
initial default state.
2) Make the filter config function project the new parameter data into the filter function at any
point during filter operation. This is so that continuous updates can be done as the plugin
operates.
3) Improve seek codec restarts. The past predictor must be reset or reconstructed after a seek.
The only documented way to seek is open/seek/play. Reopening the format layer is very
expensive.

6. Problem Resolution Help
You can report potential problems, bugs, and crashes to the Cinelerra-GG website via email address:
cin@lists.cinelerra-gg.org . At a minimum, instead of starting cinelerra from the icon, run from a
terminal window so that if there are error messages related to the problem, they can be captured on the
screen and passed along. The command to run from a terminal window is: <directory_path of where
you installed cinelerra>/bin/cin – for example if installed at directory /mnt0/build5/cinelerra-5.1, you
would execute the following command to start the program /mnt0/build5/cinelerra-5.1/bin/cin. The
problem you are experiencing may be as simple as a problem with $HOME/.bcast5 subdirectory so you
may want to first delete or rename your current .bcast5 to start with default settings.

6.1 What to Include in Problem Reports
For the best help, if you have a reproducible problem the following list of descriptive items makes it
possible to figure out what the problem is and how to fix it. It may be a usage/setup mistake or a real
bug which a programmer might like to fix rather quickly. Although it is not always necessary to
provide this much information, it eliminates the “try this” or “did you do this?” and a lot of “guessing”
rather than heading straight for a solution.
Basically we need to see what you see with the input, output, and session file:

1)
2)
3)
4)
5)

need a detailed description of the problem;
supply a small representative sample of the original input that exhibits the issue;
if possible, also provide the rendered output, again using that representative sample;
save a session file used with that same sample which will contain a lot of setup parameters;
to make sure that the same rendering setup is used, it may be necessary to send an additional
session file at the definition point just before rendering starts.

It is better to upload any files to a datahostfile site as sometimes they can be larger than the cin mailing
list would like.
How to create a session file: from the menubar pulldown File→Save_as… and choose a filename,
for example /tmp/beforerender.xml . Do this after you have the situation setup so can see values in use.
How to create a representative small sample:
- open the input media, setup as you normally would to start the project render;
- select 5-15 seconds of media using the edit mode ptr1 button drag highlighting on the timeline;
- start the render dialog (Shift R), set the filename path, and set “Render range” to “Selection”;
- recommended “Insertion strategy” is “Replace current project”; then press the checkmark OK.
(The result will “load replace” the current project for review.)

6.2 Crash Dumps for Analysis
If you get a SEGV signal crash and can explain what steps you took, a /tmp/cinelerra_<pid>.dmp file is
very useful for analysis. You can also use Ctrl-C in the controlling terminal window to force an INTR
signal interrupt when you think the program is hung up. It is best to upload the .dmp, input files and
other files to datafilehost or similar temporary site as they may be quite large. The .dmp filename looks
like /tmp/cinelerra_<pid>.dmp. Email all helpful information on the crash, location of uploaded files,
and list of setup steps that illustrate the problem to cin@lists.cinelerra-gg.org .
1) Use the latest version of Cinelerra as you want to make sure problem hasn't been fixed.
2) Be sure gdb is installed (usually installed but if not, easily downloaded/installed by anyone)
3) Run as root (this enables using gdb to create a /tmp/cinelerra*.dmp).
4) Be sure Settings->Preferences->Interface->trap SEGV/INTR are checked.
5) Invoke the error. This should create /tmp/cinelerra-<pid>.dmp .
For those who can not run as root or can not create the problem while running as root, another method
to create a dump is available. Here are the steps to do so – you must first install gdb:
1) Temporarily login as root and keyin: echo 0 > /proc/sys/kernel/yama/ptrace_scope
This opens up ptrace, used by gdb (the debugger). You will want to reverse this when done.
2) Run cinelerra as an ordinary user from a terminal window using the command line and try to create
the problem. If the program crashes, this should produce a file named /tmp/cinelerra*.dmp where *
is a number. The dump usually takes about 30 seconds or so to complete after the failure invokes the
crash handler so be patient.
3) Email the output that shows in the terminal window from where you started up cin5 and upload or
directly email the /tmp/cinelerra*.dmp file (this file is too large for the Mailing List).
4) After you are finished creating/testing the problem, reverse the previous setting while logged in as
root by keying in: echo 1 > /proc/.../ptrace_scope .

6.3 When Things go Wrong
Sometimes things go wrong and there are some ways to continue your work without much trouble.
Below is a list of items to try before abandoning your session.
1) If you suddenly get hangs on media or strange looking tracks, you might want to rebuild indexes.
You can do this in the Resources window with a right mouse click on the media to get a pulldown
with the “rebuild index” option. Better yet, clear them for all of your media with Settings
→Preferences, Interface tab, Index Files section, “Delete existing indexes”.
2) On an older computer, if you are playing media and it can not keep up, you can turn off “Play
every frame” in the Video Out tab of Settings→Preferences, Playback A tab.
3) The buffer size can be lowered to 1048 if playback seems choppy or if you have problems with
lv2 plugins, or you can increase the buffer size for better flow. This can be changed in Settings →
Preferences, Playback A tab, under the Video Out section.
4) After saving your current session and exiting cinelerra, you might want to either rename or delete
your current $HOME/.bcast5 directory and start with the default setup. However, all of your
current preferences will be lost.
5) Some media has only a single keyframe at the beginning of the file so that moving anywhere on
the timeline results in just a black image in the compositor. Cinelerra needs more keyframes to
determine position. You can temporary use Settings→Proxy to ½ size to put in keyframes.

7. Speed / Fade Automation Usage and Auto Gang
Speed automation resamples the data at a higher or lower playback rate. Speed automation can operate
on all tracks of the same type, either video or audio, with a single click; or all tracks, both video and
audio, with a double click. The curves to be affected must be both armed and ganged in the track
patchbays to be included in the operation. You can see the advantage of having different media types
ganged the same so that they will remain synchronized. However, video will always snap to a frame,
whereas audio does not, so when video is present in order to maintain synchronization be sure to do the
double click on the video track. The single/double click feature also works in the same manner for
Fade Automation. It is suggested to keep the rate lower than 100, to avoid various resource failures.
The conversion algorithms that calculate the duration are approximate, not exact; this means that it can
be off quite a bit for longer media. Speed is not checked when inserting media on a track that already
has speed adjustments so duration will not be corrected in that case. Also, a difference between HV
and this implementation is that this implementation can not do negative time.
Steps to demonstrate Auto Gang of Speed/Fade on all of the audio and video tracks are listed below:
1) Use the pulldown menu “View” on the main canvas and ensure that there is a checkmark left
of the Speed or Fade selection.
2) Double click and hold button 1 on any point of the Speed line on any track of the main track
canvas and drag the handle where you want it, then release button 1.
3) Note how all video and audio boxes move together simultaneously for synchronization.
4) You can adjust the height at any time by doing the same single/double click on a keyframe.
5) To move the location left or right, hold down button 1 while moving it back and forth.
6) Use the status bar in the lower left hand corner to see position and playback rate.
Releasing button 1 ends the current dragging operation, but single clicking on a speed/fade keyframe
handle again will restart the drag operation on tracks of the same type. Double clicking will select all
tracks which have handles in the exact same cursor position. It is sometimes difficult to get the desired
value for the speed, but you can use an auto slider bar to get better control for more precision. This is
not ganged so you will have to do this on each track to achieve the same value.
1) click using the right mouse button on one of the auto speed keyframes on the timeline
2) a popup menu comes up with speed or fade auto type as the first menu item
3) click on speed or fade and a colored slider bar will appear (speed=yellow; fade=purple)
4) click the slider, press and hold the left mouse button and move the slider to update the value
5) a tooltip shows the slider value
6) release the button, the slider will be deleted from the canvas, and the value will be updated
An easy way to get an exact position is to set the "Automation range" in the bottom bar of the main
window to the low and high ends of the desired range. For example, 1.000 to 50.000, which makes it
so you can drag the speed/fade handle all the way to the left for 1.000 or all the way to the right for 50.

Screencast to the right shows yellow
keyframes and lines for the ganged speed
automation on all video/audio tracks.
Similarly the purple keyframes and lines
show the ganged fade automation. Note
the status bar numbers in the lower lefthand corner displaying 22.319 seconds as
the location and 18.00 as the playback rate.

Screencast to the left, shows the yellow
auto speed slider bar triangle with the
current value displayed via the tooltip.

8. How to Create Blu-ray and Standard DVDs
This section describes how to create a blu-ray DVD, or BD referring to a Blu-ray DVD, and a regular
DVD, or SD referring to a Standard DVD. The DVDs (plural usage of DVD means either BD or SD)
created are unencrypted, unlike commercially available movie DVDs. This Cinelerra version
conceivably can create different variations of DVD/Blu-ray media but for the casual user the most
standard usages are readily usable and will be described here.
Some preliminary information follows. For NTSC, SD media is almost always 720x480 interlaced (the
format in the United States, US). For PAL, SD media is almost always 720x576 interlaced (Europe,
EU, and most of the world). An SD can conceivably be created with a lower resolution – for example
352x240 MPEG-1 – but it is not useful. Aspect ratio for either NTSC or PAL can be 4:3 or 16:9.
Frames per seconds is usually 29.97 for NTSC and 25 fps for PAL. The standard SD dvd generally
uses the MPEG-2 program stream with a filename extension of m2v. BD blu-ray media is not normally
interlaced, but you can leave it interlaced. Blu-ray uses the MPEG transport stream which contains 1
or more program streams with a default filename extension of m2ts.
Requirements for creating DVDs is the hardware device to write the media on and, obviously, the blank
media for either BD or SD. When generating SD media, you will have to install dvdauthor and for BD
media, install udftools if they are not on your system. Also, keep in mind that to mount filesystems
for creating files and to burn DVDs, you will have to be root since you have to have privileges,
unless special permissions have been provided for a non-root user. It is also highly recommended to
run the cinelerra startup from a terminal window, instead of the icon, in order to see informative
messages of how to actually write the output (at prompt: keyin <install_directory_path/bin/cin).
A warning here – writing blu-ray BDs and regular SDs can take a large amount of clock time. Keep in
mind that a blu-ray can contain 25 hours of viewing, so would take multiple hours to just write one.
The max disk space needed is a little over 100GB for 50GB Double Layer (DL) media or 50GB for a
single layer BD blu-ray. A standard SD of 4.7GB needs about 10GB disk space. You probably can get
by with much less if the render for blu-ray is less than 25 hours of media. You will need twice as much
disk space as the media holds to ensure you have sufficient space for working and copying.
The most important thing you need to know about in order to get started is "Format" and "Scale" in the
"Create dvd or bd" window. Format settings shown in the Set Format window are set accordingly to an
algorithm. Basically, it will take whatever you say in the asset format. It matches that against the
known Presets available so that is what will be shown. If the asset format doesn't match any of the
Presets default formats, then that will be shown as the "User Defined" format. In addition when you
load media, the format is initially set to “same as source” so matches the source input and if that
matches a known preset, then that is what is shown. The PAL versus NTSC only comes into play when
there is no known correct matching format when you attempt to create a DVD Render batch job. It is
applied when you click OK. For example, if you load up a YouTube video, it will not match any known
format and will choose PAL or NTSC based on time zone.

Screenshot of Presets in Set Format window

When choose
PAL, values
get changed
in window to
reflect PAL ->

A quick set of basic steps to create DVDs is immediately below and usually just using the defaults
will get you something. However there is a serious issue with interaction between the Operating
System and bdwrite when creating a BD/blu-ray that requires automount to be turned off. Refer to the
details and more specific explanations below the following steps for how to do this.
0) If not logged in as root, you will get an error message in order to avoid doing a lot of work
and then failing out because root is required for automount and to write on DVD hardware.
1) Load your input source media via: File→Load files .
2) Choose PAL or NTSC for SD/dvd or 1080P/24 for blu-ray in Settings→Format .
3) For blu-ray, choose BD Render or for PAL/NTSC, choose DVD Render in File→ .
4) Designate a “work path” with sufficient disk space and then Chk-OK .
5) When the Batch Render window comes up, click on Start and the batch jobs will run.
6) Read the final messages echoed to the screen to see the command for burning… OR
7) Use the provided directory name to: cd /<target directory>bd_(or dvd_)<date-time> .
8) Load your media, format if needed, note device name to substitute for <bd> or <dvd>.
9) If rewritable blu-ray, use dd if=./bd.udfs of=/dev/<bd> bs=2048000
If write-once blu-ray, use growisofs -dvd-compat -Z /dev/<bd>=./bd.udfs
If any DVD media, use growisofs -dvd-compat -Z /dev/<dvd> -dvd-video ./iso
Any problems encountered will require that you read more information in this section to include
specific details, helpful hints, and problem resolution.
Details and specific explanations to create blu-ray or regular DVD are provided here. It is very
advantageous to startup cinelerra from the command line prompt instead of the icon. Also, please be
root or your hard work will be lost when the automount is issued and fails for bluray udfs mounting.
The general design of the DVD/blu-ray generation operations is to first render media using batch
rendering and then terminate Cinelerra to start a script which creates the target device filesystem data.
These scripts are the dvd.sh and bd.sh scripts written into the target directory. For DVD, the general
plan is to write a directory <target>/iso with the dvd filesystem via dvdauthor and then generate an
iso9660 filesystem and write it to a dvd via growisofs.

For blu-ray, the filesystem generation is slightly harder. First, it creates an empty filesystem image
<target>/bd.udfs using mkudffs which makes a big hole for the filesystem data. The hole is made just a
little bigger than the data written by bdwrite so that you don't have to write an entire 25GB or 50GB
disc even if no data exists. This empty filesystem is loopback mounted to make it writable, and the
linux kernel manages the filesystem image. The bdwrite program applies the blu-ray structure to the
UDF filesystem by creating the needed BDMV blu-ray filesystem, which the kernel stores onto the
image file bd.udfs. When udfs is unmounted, the kernel finalizes the disk image on bd.udfs. The
bd.udfs image can be written directly to a blu-ray disk via dd or growisofs.
NOTE of IMPORTANCE: there is a serious situation with the interaction between the Operating
System (OS) and bdwrite when creating blu-ray, that requires automount to be turned off. The blu-ray
automatic script unmounts the blu-ray/UDF filesystem but the system has not finalized the directories
so the OS creates a new loop file device and the data is loaded and cached for use by the new loop but
it is stale. Consequences is that not all of the data is written where it should be. The solution is for the
OS not to mount this second mount so we have to make sure it doesn't. There are 2 methods to fix this.
The first and easiest is by using the following command to disable automount:
gsettings set org.gnome.desktop.media-handling automount false
This can be reversed when you have completed the blu-ray generation via:
gsettings set org.gnome.desktop.media-handling automount true
A different and more complicated method you can use to turn off automount is to download and install
the dconf-editor. Automount is a system parameter and only needs to be done once unless you do not
want automounts to always be disabled.
1) run: dconf-editor
2) select: org→gnome→desktop→applications->media-handling
3) uncheck: automount
4) close dconf-editor window
Immediately below are the detailed steps with explanations for creating SD or BD media.
1) Construct a session with the desired presentation:
Format frame rates choices are 29.97 or 25 for SD, based on the user's timezone, with NTSC
29.97/US or PAL 25 /EU. For BD, the media input will be analyzed to automatically pick the
default format or if unknown, the user's timezone will be used to default to 1920/29.97i for US
or 1920/25i for EU. Be sure to set the rendering parameters in the settings -> format menu.
Choose audio stereo or 5.1, again depending on your media.
Target Geometry will be 720x480 (US) or 720x576 (EU) for SD.
2) From the main window, select file→BD Render or select file→DVD Render. Then:
In the “Title” textbox there will automatically be a unique name based on the current day and
time but you can change that to anything you want that is NOT already created.
Choose a “Work path” Target Directory in the work path textbox. Another big warning here is
to use a path that is NOT /tmp because a lot of linux distros wipe out /tmp on a regular basis
via cron, crash, or reboot. Furthermore, they tend to use ram based filesystems, which will be
way too small. You will lose your hard work so use disk space that is permanent. An icon in
the form of a magnifying glass is next to the work path which shows you file names/paths.
Disk space message will be green if you have at least 100GB/BD or 10GB/SD available
space (the disk space message will be red to warn you if you have less than these amounts).

Screenshot showing sufficient available disk space in green for blu-ray creation is below.

← Note the Scaled
options in the pull
down menu which
will be described
later.

Screenshot showing insufficient available disk space in red letters for SD dvd creation is below.

Note the pull -->
down displaying
the PAL and the
NTSC formats.

(Continuation of Step 2)
Select desired features, check / un-check as appropriate.
Click OK check button. It is very important to realize that when you check OK, the EDL will
be saved and that will be used for batch job rendering. If you bring up the Batch Render and
then change some parameters, they will not take effect UNLESS you remember to either check
“Save to EDL Path” or “Use Current EDL” in the Batch Render window. You will get a
reminder automatically if “warn if jobs/session mismatched” is checked.

Explanation of the choice boxes as seen in the previous 2 screenshots for both SD and BD menus is
given below. Many of them are plugins which allow you to further manipulate the settings for best
results. They are just suggestions set by the program automatically based on your input media, and can
be reset to suit your needs. These are listed in the next 4 points.
1) If the media does not match the DVD target geometry, and the scale plugin is not already in
use, then the scale plugin is applied with scaling set to fit the media dimensions to the DVD
format target geometry.
2) If the video height is at least twice the DVD height and the input media is interlaced, then the
deinterlace plugin is applied with odd line sampling.
3) Audio 5.1 will automatically be set to the wide-audio if you have 6 tracks of audio.
4) To allow video data to be accessible and overlay properly, the track buffers are “resized” to
the largest track frame size in use (Resize Tracks). The theory behind this is to make sure to
have enough memory to cover the entire presentation for transcoding.
All of the current choice boxes are further defined immediately following.
Deinterlace – remove the interlace. Interlacing is a video scanning system in which alternating lines
are transmitted so that half a picture is displayed each time the scanning beam moves down the screen.
You lose a lot and the quality is bad when you view interlacing on a progressive TV. You might not
really want to use deinterlace, because if you deinterlace non-interlaced media, it will look awful.
Scale – alter the spatial mapping of an image to increase or reduce the size; modifies the picture. When
some programs scale from 4:3 to 16:9 they will automatically cut off the appropriate section of the
image for you. It is necessary to keep in mind, that square pixels is the true end goal of scaling, not the
aspect ratio which could result in squished or stretched output. More information about scaling will be
provided on a subsequent page with usage of the “Scale Ratio” plugin.
Histogram – remaps the color space. The color space ranges from 0-255 for 8-bit color values. You
can use this tool to remap the color space to use the entire space or for stretching the contrast. Also, it
lets you perform global color-correction on the image. You can use this to correct for color screens that
are 'too blue', or for color Televisions that produce 'brownish' output, or whatever. In addition to colorcorrection, you can use the RGB modification tool to add color to images that didn't have color to begin
with. For instance, you can “pseudo-color” greyscale media.
Inverse Telecine - the reverse of 3:2 pulldown where frames, which were duplicated to create 60fields/second video from 24-frames/second film, are removed. MPEG-2 video encoders usually apply
an inverse Telecine process to convert 60-fields/second video into 24-frames/second encoded video.
The encoder adds information enabling the decoder to recreate the 60-fields/second display rate.
Telecine, i.e. 3:2 pulldown, is used to transfer film to video. That's where the 3:2 ratio comes in. To
ensure that there will consistently be 60 frames per second, the first frame is displayed on the TV
screen 3 times and the second frame is displayed 2 times. The following frame is repeated 3 times, the
next one 2 times, etc. throughout the film. For inverse telecine, you show 2 of the film frames for 3 of
output frames. Only check “Inverse Telecine” if you have film or something that is 24fps and want to
project to 30fps (most likely this will never be necessary).
Audio 5.1 – 6 channel surround sound. For most home systems, uses five full bandwidth channels and
one low-frequency effects channel. Could automatically get set as explained previously.

Aspect Ratio – aspect ratio may be automatically set to 4:3 or 16:9. Aspect ratio would better be
defined as the size of the display, monitor, or TV which will be used to view the output. If you measure
your old TV, which supposedly is 4:3 and your latest digital TV, which is supposedly 16:9, you will see
that those ratios aren't always correct anyway. Then measure your laptop monitor, your desktop
monitor, and your neighbor's, and lo and behold, the ratios don't fit either of the purported “standard”
aspect ratio. Maintaining square pixels via scaling is more important in the long run.
Use FFMPEG – this is user's choice; it is recommended and faster but more difficult to modify due to
numerous options. For blu-ray, ffmpeg must be used and is not an available option.
Resize Tracks – change track width and height as explained previously. The size is adjusted to the
largest frame size needed.
Chapters at Labels – without this checked, chapters markers are automatically inserted every 5
minutes. The chapter labels can then be “skipped to” when playing the DVD. If instead, you want to
put labels in at opportune times, you will have to run dvdauthor outside of Cinelerra and mark the
chapter labels yourself by hand. In that case, you should checkbox “Chapters at Labels” so that the
automatic 10-minute labels are not created. This checkbox is not currently available for blu-ray.
The screenshot below shows on the upper right side the “Create DVD” window with Deinterlace,
Histogram and Resize Tracks checked. Also Scale is set to “Scaled”. Once the green checkmark is
clicked, the “Batch Render” window comes up and in the main window you will see the 3 plugins
below the video track on the main window. By clicking on the magnifying glass that appears on the
rightmost side, the controls for each will popup and you can make any necessary adjustments. Note the
numerous choices for Deinterlace; the Value, Red, Green, and Blue for color adjustments in the
Histogram window; and Scale Ratio popup menu for numerical settings control.

The Scale parameter gives you a lot of flexibility. A default based on your input media is provided for
you but possible choices are None, Scaled, Cropped, Filled, Horiz Edge, and Vert Edge. You will have
the opportunity to manipulate the desired results in the “Scale Ratio” window. Values for W (width), H
(height), and X/Y coordinates are the number of pixels. For example, if video is 720 x 432, that is
obviously 720 pixels by 432 pixels and this would be the values for Dst W and for Dst H. So if you
have some media that is off center you can crop by changing the SRC Y value AND then change DST
X/Y to non-zero. It will become the output origin. To see what it does, change them from 0.0 to 400.0
and you will see big changes in the compositor window.
For example, if you have the Cropped choice for the Scale, you will want to manipulate the ScaleRatio
plugin (the magnifying glass on the main window video track) which brings up the Scale window. For
cropped top instead of crop both top and bottom, modify the "Src Y". As you change the Y scale, you
will see the cropping take place in the Compositor.
Scaling options are provided in order to preserve image aspect ratio. To determine which scaling
option to use, it is important to correctly identify your source/destination video aspect ratios. Next is a
short explanation of possible options.
None – do not do any scaling. The destination output matches the source input. There is no resizing.
Scaled – do not use uniform scaling on X and Y. Just make it fit and you will might end up with
squishing/stretching in one direction or the other in order to do that. This happens when the input
aspect ratio is different than that displayed on the output.
Cropped – removes outer edges of a source image in order to fit the image on the output display. This
is done in order to maintain uniform geometry scale on the destination display without being affected
by the particular factor of original media aspect ratio. Since cropping omits image area, and the areas
which you wish to view may not be viewed when the image is centered, you can pan the image source
using the Src X/Y to modify which area is in view. You can also think of this as “scaled up”.
Filled – the entire output display will be filled with image content but in order to do so, some of the
image may have had to be cut. Any mismatch between the two will be filled with black. Centering of
the image can be modified by using the Dest X/Y variables in the Scale Ratio controls. You can also
think of this as “scaled down”.
Horiz Edge – this indicates preserving of the Horizontal edge.
Vert Edge – this option preserves the Vertical edge.
Horizontal and Vertical are duplicates or restatement of same functionality as Cropped or Filled but are
provided as options to accommodate different ways of thinking. In any case, you can choose which
outer edges of the image to crop by using the “Show Controls” of the Scale Ratio plugin. For example,
you can ensure that no “action” is lost by displaying the center of the screen only or making sure that
any textual information on the bottom is not lost by cutting only the top off.
Step 3:
3) Batch render menu appears with “m2ts” format selected for blu-ray or “dvd” format selected for
regular/standard DVD when File Format selected is ffmpeg in the previous “Create DVD” menu. It will
work just fine without selecting ffmpeg for DVD and may be advantageous not to. Using the audio /
video wrench tools (you will have to have the video batch job highlighted to manipulate the video or

audio batch job for audio).
Setup the audio bitrate (192000 recommended). Data rate is 192K default.
Setup the video bitrate (6000000 - 12000000 recommended). 10Mb/sec is the current default.
Click OK check button.
The default bitrate is the largest value possible. The actual 'target' bitrate is calculated based on a
formula from the blu-ray/DVD code. It divides the media size (in bits) by the video time (in seconds)
to find the bitrate that will "just fit" on the target media. This could create a weird bitrate if the media
is large, and the video time is small, so the default/target bitrate is limited to 10Mb/s.Batch jobs are
then built and appended to the job list. Once these batch jobs are built, if you make any changes, you
have to start over. You will see listed the batch jobs that are created to perform the rendering/tasks – 2
jobs for blu-ray, one for audio/video processing and one for the scripts. There will be 3 batch jobs
created for DVD when not using ffmpeg to include one each for audio and video and then one more for
the scripts. When you click on “start”, it fires off those jobs and you will see the rendering main
window progress bar in the bottom corner reflecting the fact that it is currently processing. Be aware
that the Cinelerra program will be totally shutdown AFTER the batch jobs finish.Screenshot below
shows BD blu-ray creation with 2 batch jobs queued up and ready to go.

Screenshot below shows a DVD creation render ready to be started. Note that because it is not ffmpeg,
the processing of video is done separately from audio. If you need to modify the video tracks, which
you can see is ghosted out, you need to highlight the first batch job listed. Be sure to highlight the first

batch job before pressing Start so it runs all of the jobs and be sure the X for job enabled is set.

When you click on “start”, it fires off those jobs and you will see the rendering main window progress
bar in the bottom corner reflecting the fact that it is currently processing. Be aware that the Cinelerra
program will be totally shutdown after the batch jobs finish and you will be at the command line
prompt.
This will produce a new directory in your target path which contains a filesystem image file.
For example: /TargetDirectory/bd_20150820-093747
Directory and file names should not be changed at this time because the scripts and programs rely on
the given names in order to proceed. You can change them later for your own purposes.
If bluray to test the filesystem you just created, use the command line interface; loopback mount the
filesystem image which was generated in the target directory. For example if blu-ray:
cd /TargetDirectory/bd_20150820-093747/
mount -o loop,ro ./bd.udfs ./udfs
(check the media using a compatible media rendering tool like ffplay)
umount ./udfs
To burn blu-ray media you will need to run from the command line interface. In the examples below, /
dev/bd represents your blu-ray writer device (for example: /dev/sr1) and /dev/dvd represents your dvd
writer device (for example: /dev/sr0).
Blu-ray Media
For rewritable blu-ray (recommended) (BD-RE):
Note - unwritten (virgin) media must be formatted first using:
dvd+rw-format /dev/bd (only done once and does not take very long)
To write or rewrite rewritable blu-ray media:
cd /TargetDirectory/bd_20150820-093747/
dd if=./bd.udfs of=/dev/bd bs=2048000 (the growisofs command below also works)
To write blu-ray write-once media: (BD-R) (no pre-formatting needed):
cd /TargetDirectory/bd_20150820-093747/
growisofs -dvd-compat -Z /dev/bd=./bd.udfs
DVD Media
For rewritable DVD (DVD+RW):
Note – unwritten (virgin) media must be formatted first using:
dvd+rw-format /dev/dvd (only done once and does not take very long)
To write a DVD, load blank media and run the following from the command line (requires dvdauthor):
cd /TargetDirector/dvd_20160404-175416
growisofs -dvd-compat -Z /dev/dvd -dvd-video ./iso
Screenshot showing the availability of 4:2 :2 for a Batch Render seen by clicking on wrench icon.

Screenshot showing the availability of 10-bit high quality 4:2 :2 for a Batch Render seen by clicking on
wrench icon. You need specially compiled cinelerra in order to use the x264 10-bit as opposed to 8 bit.

8.1 Output Terminal Messages from Creating DVDs
Below are examples of what the batch jobs generate and you will see on the terminal screen if you
started the cinelerra program in the recommended manner from a terminal window. It is just
informational but will let you know if errors. In looking at any of the output, you can safely ignore the
errors that read “Unsupported codec with id 100357 for input stream 0” - this comes from “nav-data”
(navigation data). The first 2 examples are seen from running the batch jobs; the last 2 are from the
single line execution which records the media output to the DVD hardware.
SD Example – Partial Output during Cinelerra run
...
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
running /tmp/dvd_20160407-113530/dvd.sh 1 /tmp/dvd_20160407-113530
INFO: [mplex] mplex version 2.1.0 (2.2.7 $Date: 2012/11/17 01:55:16 $)
INFO: [mplex] File /tmp/dvd_20160407-113530/dvd.m2v looks like an MPEG Video stream.
...
INFO: [mplex] MUX STATUS: no under-runs detected.
DVDAuthor::dvdauthor, version 0.7.1.
Build options: gnugetopt graphicsmagick iconv freetype fribidi fontconfig
Send bug reports to <dvdauthor-users@lists.sourceforge.net>
INFO: default video format is NTSC
INFO: dvdauthor creating VTS
STAT: Picking VTS 01
STAT: Processing /tmp/dvd_20160407-113530/dvd.mpg...
STAT: VOBU 32 at 15MB, 1 PGCs
INFO: Video pts = 0.133 .. 22.789
INFO: Audio[0] pts = 0.133 .. 22.789
STAT: VOBU 46 at 21MB, 1 PGCs
CHAPTERS: VTS[1/1] 0.000
INFO: Generating VTS with the following video attributes:
INFO: MPEG version: mpeg2
INFO: TV standard: ntsc
INFO: Aspect ratio: 16:9
INFO: Resolution: 720x480
INFO: Audio ch 0 format: ac3/6ch, 48khz drc, 'en'
STAT: fixed 46 VOBUs
INFO: dvdauthor creating table of contents
INFO: Scanning /tmp/dvd_20160407-113530/iso/VIDEO_TS/VTS_01_0.IFO
To burn dvd, load blank media and run:
growisofs -dvd-compat -Z /dev/dvd -dvd-video /tmp/dvd_20160407-113530/iso

BD Example – Partial Output during Cinelerra run
...
FFMPEG::open_decoder: some stream times estimated
Render::render_single: Session finished.
+ PATH=/usr/lib64/ccache:/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/root/bin:/mnt0/build5/
cinelerra-5.1/bin
+ mkdir -p /tmp/bd_20161224-162059/udfs
++ du -sb /tmp/bd_20161224-162059/bd.m2ts
++ sed -e 's/[ ].*//'
+ sz=19811904
+ blks=13769
+ mkudffs /tmp/bd_20161224-162059/bd.udfs 13769
start=0, blocks=16, type=RESERVED
start=16, blocks=3, type=VRS
start=19, blocks=237, type=USPACE
start=256, blocks=1, type=ANCHOR
start=257, blocks=16, type=PVDS
start=273, blocks=1, type=LVID
start=274, blocks=13238, type=PSPACE
start=13512, blocks=1, type=ANCHOR
start=13513, blocks=239, type=USPACE
start=13752, blocks=16, type=RVDS
start=13768, blocks=1, type=ANCHOR
+ mount -o loop /tmp/bd_20161224-162059/bd.udfs /tmp/bd_20161224-162059/udfs
+ bdwrite /tmp/bd_20161224-162059/udfs /tmp/bd_20161224-162059/bd.m2ts
+ umount /tmp/bd_20161224-162059/udfs
+ echo To burn bluray, load writable media and run:
To burn bluray, load writable media and run:
+ echo for WORM: growisofs -dvd-compat -Z /dev/bd=/tmp/bd_20161224-162059/bd.udfs
for WORM: growisofs -dvd-compat -Z /dev/bd=/tmp/bd_20161224-162059/bd.udfs
+ echo for RW: dd if=/tmp/bd_20161224-162059/bd.udfs of=/dev/bd bs=2048000
for RW: dd if=/tmp/bd_20161224-162059/bd.udfs of=/dev/bd bs=2048000
SD Example – Partial Output during writing disc media
# growisofs -dvd-compat -Z /dev/sr0 -dvd-video /tmp/dvd_20161224-160756/iso
WARNING: /dev/sr0 already carries isofs!
About to execute 'mkisofs -dvd-video /tmp/dvd_20161224-160756/iso | builtin_dd of=/dev/sr0
obs=32k seek=0'
I: -input-charset not specified, using utf-8 (detected in locale settings)
75.62% done, estimate finish Sat Dec 24 16:09:51 2016
Total translation table size: 0
Total rockridge attributes bytes: 0
Total directory bytes: 4096
Path table size(bytes): 42
Max brk space used 1a000

6624 extents written (12 MB)
/dev/sr0: "Current Write Speed" is 4.1x1352KBps.
builtin_dd: 6624*2KB out @ average 0.7x1352KBps
/dev/sr0: flushing cache
#
BD Example – Partial Output during writing disc media
# growisofs -dvd-compat -Z /dev/sr0=/tmp/bd_20161224-155658/bd.udfs
Executing 'builtin_dd if=/tmp/bd_20161224-155658/bd.udfs of=/dev/sr0 obs=32k seek=0'
/dev/sr0: "Current Write Speed" is 2.0x4390KBps.
1605632/24524800 ( 6.5%) @0.0x, remaining 1:39 RBU 100.0% UBU 0.0%
1605632/24524800 ( 6.5%) @0.0x, remaining 2:22 RBU 100.0% UBU 100.0%
1605632/24524800 ( 6.5%) @0.0x, remaining 3:05 RBU 100.0% UBU 100.0%
5865472/24524800 (23.9%) @0.3x, remaining 0:54 RBU 100.0% UBU 33.3%
11829248/24524800 (48.2%) @0.4x, remaining 0:21 RBU 75.8% UBU 37.5%
17858560/24524800 (72.8%) @0.4x, remaining 0:08 RBU 39.8% UBU 79.2%
23789568/24524800 (97.0%) @0.4x, remaining 0:00 RBU 4.5% UBU 4.2%
builtin_dd: 11984*2KB out @ average 0.2x4390KBps
/dev/sr0: flushing cache

8.2 Helpful Hints for Problems/Debugging DVDs Creation
This section contains helpful hints, how to initially check the results, and some information on
determining what might have gone wrong and how to address it.
1)
2)
3)
4)
5)

For first time users, taking the defaults seem to work very well when running as root.
You may want to use rewritable media to see how it goes before using permanent media.
Until you are familiar with the procedure, start with shorter input in order not to waste time.
Test the generated output with a compatible media rendering tool before burning DVDs.
Check the list of files and file sizes after the batch jobs are complete before burning DVDs.
For blu-ray creation, cd /workpath/bd_date-time directory and look for similar files:
bd.jobs
bd.m2ts
bd.sh
bd.udfs
bd.xml
udfs directory which is used as a loopback mount point
Note that the size of bd.udfs should be larger than bd.m2ts because this is the final file which is
actually going to be written to the disc media. It contains contents of bd.m2ts and all of the
required disc structure.
For DVD creation, cd /workpath/dvd_date-time directory and look for similar files:
dvd.ac3
dvd.jobs
dvd.m2v
dvd.mpg
dvd.sh
dvd.xml
iso directory with VIDEO_TS and AUDIO_TS subdirectories of non-zero size
Note that there will be no files in the actual AUDIO_TS directory.

6) The bd.sh and dvd.sh files are script files that you can carefully run manually from some start point
to determine where the failure occurred. You must BE CAREFUL and know what you are doing and
what directory you are in because dvd.sh contains an “rm” command and will delete files. The script

takes a command line parameter of the directory where the file was rendered to and which is usually
the directory where dvd.sh or bd.sh was created.
7) There is also a file in the same directory, called bd.jobs. It was the information that was used in
creating the batch jobs and may be helpful in determining what parameters were actually used if there
are any resulting problems. With enough background knowledge, you can make changes and rerun.
8) For blu-ray check to make sure you do not have any spurious loopback disks mounted that may
interfere with the correct generation. Use the df command to check this and then the umount command
to unmount these. Also, check to make sure you have used the gsettings command to disable
automount.
9) For blu-ray loopback mount the <target>/bd.udfs image, and see if it has the BDMV filesystem
written to it, and in particular a subdirectory named STREAM. Look at the results in ./udfs and check
for the stream file which should exist in ./udfs/BDMV/STREAM/00000.m2ts and should have the
same size as ./bd.m2ts.
mount -o loop <target>/bd.udfs <target>/udfs
ls -lR <target>/udfs
du -sc <target>/udfs
umount <target>/udfs

Checklist for Troubleshooting BD and DVD Render:
___ Are you logged in as root? This is required in order to loopback mount files for bluray and to
write media on /dev/hardware. See section 8.3.5 for a workaround for normal user mode.
___ Did you startup cinelerra from a terminal window so you can see informative messages?
___ Is udftools installed for BD and dvdauthor installed for SD?
___ Do you have loopback not enabled for bluray? At least temporarily, disable automount via:
gsettings set org.gnome.desktop.media-handling automount false
___ Did you have sufficient disk space for working/writing files? In the Create window, the disk
space will be displayed in green if sufficient, but in red if less than what fits on the disc media.
___ Did you use /tmp as the work device, then rebooted the computer, which deleted files on /tmp?
___ If the input media is interlaced, did you check the Deinterlace option to eliminate interlacing?
___ Did you change the output name in the Batch Render window after the batch jobs were already
created? These filenames have already been written to disk. If you want to change either the
Title or the Work_path, you have to start over.
___ Have you selected a Title in the Create window that is a directory that already exists? The
program attempts to create that directory and will give you an error message if it exists.
___ Did you replace the /dev/bd or /dev/dvd on the command line with your hardware device name?
___ If a warning was issued in the Create BD/SD window of “* non-standard format” and your
bluray reader could not play the disc, did you change to a standard format instead?
___ Did you correctly interpret the frame rate if using interlaced format to be ½ due to interlacing?

8.3 Additional Features for Blu-ray/DVD Creation
This section describes additional features of creating DVDs which can be very advantageous. It is
quite easy to learn “how to” and rather simple, until it becomes tedious to do an entire 2 hour DVD!

8.3.1 Subtitles
DVD (not blu-ray... yet) subtitles are added by using the main window pulldown File→Subtitle
which brings up a window allowing you to type the filename of a previously generated text file
containing the desired words/lines, the script. After entering the filename, click “Load” to read in your
script. By creating a script file ahead of time, it lets you easily add dialog that was already written out
and carefully edited for spelling and proper grammar.
Screenshot below shows the Subtitle window you will see.

The format of the script/text input file has specific requirements as listed below:
Lines can be any length but they will be broken up to fit according to some criteria below.

Running text used as script lines will be broken into multiple lines.
The target line length is 60 characters.
Punctuation may be flagged to create an early break.
Single carriage return ends an individual script line.
Double carriage return indicates the end of a entry and helps to keep track of where you are.
The “=” sign in column 1 indicates a comment seen in the script text to assist you in location.
An “*” at the beginning of the line is a comment and not a script line.
Whitespace at either the beginning of a script line or the end will be removed.
To put the subtitles onto your media, first add a subtitle track via the pulldown Track→Add Subttl . In
the Subtitle window, note that there are 2 major textboxes. There is the “Script Text” textbox showing
the current entry of text from your input file and there is the “Line Text” textbox showing the currently
active text. In your subtitle track, select a timeline region (in/out or drag select with hairline
cursor/highlight) to indicate the region where you want the active Line Text to be pasted. Then click
the “Paste” button in the Subtitle window to paste the line onto the subtitle track. Silence will be added
to the subtitle track in the places in the media where there are gaps.
Editing in the Line Text box can be used to change the active script line. By double clicking the
timeline over the subtitle track, you can reselect the active script line. The subtitle text will be reloaded
into the Line Text box and can be edited and re-pasted as the new active subtitle text. You can also
highlight multiple lines in the Script Text box and paste them (using the usual window paste
methodology) into the Line Text box. After pasting to the timeline, the Line Text box will be updated
with the next script line. In addition, if you triple click a line in the “Script Text” box, it will
automatically become the current line in the “Line Text” box.
When you are finished, before clicking “Save”, you must supply a legitimate filename in the “Path”
box; your current directory will be used if only a filename but no directory path is supplied. The
filename used will automatically have a “-” after it followed by the “track label” and then “udvd'
extension added; any extension in the filename will be removed.. If you click OK before saving, the
subtitle script position is saved with the session. This is convenient for continuing where you left off.
To reposition the script, use the slider or tumbler buttons:
Slider bar to move through the text entries quickly.
Prev or Next buttons to go to the previous or next script line.
Screenshot below shows what the pasted subtitle script looks like in a portion of the main window.

8.3.2 Dvd Interlaced Chroma
Cinelerra uses 4:4:4 colorspace to edit, so it is necessary to convert interlaced 4:2:0 video to 4:4:4.
But you can run into problems, referred to as the “chroma bug”, which you see in DVD media
displayed on higher resolution monitors – streaks or spiky horizontal lines are visible in the chroma
channel, especially on diagonal edges. The Chroma Bug is specific to MPEG and 4:2:0 encoding.
Now you can use the “YUV420P DVD Interlace Mode” when rendering DV directly to mpeg2 through
a yuv4mpeg stream and when using video effects on HDV video.
With this option enabled, improved chroma results will be obtained from your DV or HDV source.
Editing DV or HDV and rendering it back to the same format does not require any special handling.
In order to perform colorspace conversions correctly in Cinelerra and avoid Chroma errors for
interlaced 4:2:0 video, check the box as follows:
Settings→Performance→YUV420P DVD Interlace Mode
This option maintains the interlacing in Chroma sample addressing, which ordinarily would be deleted
because the upsampling of interlaced chroma fields is normally done using a progressive algorithm.
With this mode enabled, the MPEG decoder uses a different algorithm for interlaced frames so that the
4:2:0 format chroma interlacing is preserved.

8.3.3 MPEG utility programs
There are 2 utility programs that come in handy when dealing with DVD media for creating or reading
previously written DVDs.
1)

zmpeg3cc2txt – convert closed captioning data to subtitle data.

This program can be used to scan captured broadcast data streams and convert the closed captioning
text data into subtitle track data. The result can be used to add subtitles to DVDs created from the
captured media using the text collected from the closed captioning.
usage: ./zmpeg3cc2txt [-c cc_service ] [-s start:length, ...] [ -t track ] [-v verbose ]
[-w wdw mask ] [-x file.xml ] [-o file.udvd ] file.ts
cc_service
start:length
track
verbose
wdw mask
file.xml
file.udvd
file.ts

= closed caption service id
= start:length frames (comma separated list)
= video track number
= verbose level
= bit mask for windows (-1 = all)
= filename for edl xml format subtitle data
= filename for udvd format subtitle data
= filename for transport stream

To use this program, the input file must be a transport stream (broadcast video) which contains closed
captioning services. The service id defaults to one, and the default video track is zero. Either -o or -x

must be specified to indicate the output file format desired. If the output file name is a '-' then stdout is
selected as the output file.
For example:
zmpeg3cc2txt -o - /dvb_data/channel5.ts
2) zmpeg3ifochk – check DVD ifo file for usable features.
For some time, DVD manufacturers have been employing a variety of measures to make reading a
DVD difficult on a computer. One technique which is widely deployed is to add a bunch of extra
program data, so that correct playback is only likely if you can read the DVD virtual machine data and
decode a maze of program data to find the undamaged stream definitions. Only a few streams are
created which are machine usable, and dozens are created as decoy streams. The decoy streams fail or
introduce errors. This program scans the IFO (info file) playlists and verifies the contents of the stream
that does not contain obvious damage. The result is a list of program ids which can be entered into the
playback preferences to select a program which qualifies.

8.3.4 HDV-sourced Video Recording on a Blu-ray Disc Without Re-encoding
An MTS file is a video file saved in the high-definition (HD) MPEG Transport Stream video format,
commonly called "AVCHD". It contains HD video compatible with Blu-ray disc format and is based
on the MPEG-2 transport stream. MTS files are often used by Sony, Panasonic, Canon and other HD
camcorders. Legal input for Video – MPEG1VIDEO, MPEG2VIDEO, H264; Audio – MP1, MP2,
AC3, AC3PLUS, DTS, TRUHD.
For creating a blu-ray disc, if you have HDV MPEG-2 media that is in blu-ray format, you can save the
original quality of your work, rather than rendering it to another format. Follow the steps below
directly instead of going through cinelerra. It has been tested on 10 different MTS files.
1)
2)
3)
4)
5)
6)
7)

du -sb /yourHDVfile.MTS
! Determine the size of your file in bytes.
blocks=((size-in-bytes/2048 + 4096)) ! Convert bytes into blocks + a little more.
mkudffs /tmp/newfilename.udfs blocks ! Create a file with that # of blocks + some extra.
mount -o loop /tmp/newfilename.udfs /mntX
! Use a mount point like mntX that is not in use.
/<cinelerra_installed_path>/bin/bdwrite /mntX /tmp/yourHDVfile.MTS ! Substitute cinelerra path.
umount /mntX
! You must unmount the udfs filesystem
growisofs -Z /dev/bd=/tmp/newfilename.udfs ! Replace /dev/bd with your bluray hardware device.
OR dd if=/tmp/newfilename.udfs of=/dev/bd bs=2048000 ! if using rewritable blu-ray; replace bd.

8.3.5 User-mode Blu-ray Render Workaround for Mount/Umount
Creating BD images to be written to media requires usage of “mount” and “umount” which typically
can only be done by the root user due to security. If you want to avoid running cinelerra as root, you
can implement a workaround by adding a line in /etc/fstab (must be root to edit the file initially) and by
creating a directory in your home area, called “bluray”. You only have to do this once unless you
upgrade the Operating System and it wipes out the line in /etc/fstab. Now the cinelerra program will
automatically do the mount and umount for you each time you execute BD Render and you can run as
an ordinary user.

The line to add to /etc/fstab will look something like the following, assuming your username is “name”
and your groupid may be “users” or “name”. If you do an “ls -l” in your home directory, the 3rd and 4th
fields shown will be your uid or name and gid or groupid which you must substitute in the line below.
/home/name/image /home/name/bluray udf noauto,loop,rw,user,uid=name,gid=groupid 0 0
Also, be sure to do a “mkdir bluray” in your /home/name directory as this is a requirement (owned by
you; uid=gid=name). When the actual image to be written to disc media is created, it will first d any
current /home/name/image file. Warning – make sure you do not already have a file called “image”
that you want to save as it will be automatically deleted every time you initiate a BD Render. So you
will want to burn a bluray disc after cinelerra creates the “image” since it will written over on the next
rendition. The actual writing to your bluray burner (something like /dev/sr0) is done outside of
cinelerra at a terminal prompt and requires root privilege usually. You can either use “sudo” for 1 line
or create user wheel group to get around this.

8.3.6 How to Create Bluray Media from Multiple Cinelerra Output
Writing prepared multiple cinelerra output files, “bd.m2ts”, to a single bluray disc is relatively easy to
do but is not done automatically. You can render all of the desired files via the Create BD menu, save
each individual bd.m2ts file with a unique name, construct a Menu Title that reflects the contents of
each of these files, then manually use a few commands to create a udfs file to be written to BD.
Usage of the final preparation taken from the bdwrite program comments:
./bdwrite <tgt_dir_path> <playlist-0> <sep> <playlistp1> <sep> ... <sep> <playlist-n>
<sep> == -<pgm_pid> | --<pgm_pid> | ---<pgm_pid>
<pgm_pid> may be empty string, or a numeric pgm_pid for current title clip
<pgm_pid> defaults to first pgm probed
<playlist-x> == <clip-0.m2ts> <clip-1.m2ts> ... <clip-n.m2ts>
One title is built for each playlist; playlist-0 is used as first-play item. The separators (<sep>
represented by the dash character) have unique roles. The double “--” means stop after playing, and the
triple “---” means pause.
For example:
./bdwrite /tmp/dir /path/menu_titles.m2ts --- /path/clip0.m2ts -- /path/clip1.m2ts -- /path/clip2.m2ts
The basic idea is to use playlist-0 as a menu or directions to use the bluray player remote control to
select the desired Title and start the play, avoiding the need for a menu system. Planning in advance to
get the desired results is necessary. The following steps provide an outline to get started.
1) Create all of the bd.m2ts files that you want to put on the Bluray.
2) Using cinelerra, design your Title page using a few seconds of video and the Title plugin.

Screenshot to the right demonstrates
an example of setting up a Title menu
on a 5 second video. There is a list of
4 menu title options that can be
searched via remote control using the
Title search option for your player.

3) Use BD Create to render your short Title video.
4) Next is the most complicated part which is to run mkudffs with a sufficient amount of disk space to
hold all of the bd.m2ts files “plus a little more!” To calculate this, you can record the sizes from having
run BD Create mkudffs. This number is displayed on the terminal screen when using the command
line interface each time and add them together. Or recalculate the size of each bd.m2ts using the
formula below and adding them all together. This is the number of blocks used to make a bluray image
space for bdwrite to use. For many files, this could require a huge amount of space, so check first.
Total size = File#0 size in bytes / 2048 + 4094 “+” File#1 size in bytes / 2048 + 4094 “+” ...
Now create the image file via: mkudffs image <Total size> where image or udfs is the image name.
5) Loop mount the disk image (refer to Sections 8.3.4 and 8.3.5).
6) Then actually write your multiple bd.m2ts type files onto the “image” where <cin_path> is the
location of the cinelerra binary “bdwrite” file and <path> is your directory path. Below is a single line
that wrapped around with 4 Titles.
<cin_path>/bin/bdwrite image /<path>menu_titles.m2ts --- /<path>/bd1.m2ts -- /<path>/bd2.m2ts -/<path>/bd3.m2ts -- /<path>bd4.m2ts
Note that the 3 dashes after the “menu_titles.m2ts” lets the bluray player know to “pause” after playing
the few seconds video which contains the index to the rest of the files. The 2 dashes after each of the
bd.m2ts signify “stop”. That is when you will have to use your remote to “Search Titles” in order to
play the next one you want to see. In addition, if for some reason you just want to “play all”, you will
have to add another line to the Title menu as a choice and list all of the 4 files in a row at the end of
your bdwrite line without any dashes in between.
7) Umount the loopback disk.
8) Use your favorite dd or growisofs tool to write to a formatted bluray disc.

8.4 Complete Example of Video Source with 4:3 Aspect Ratio, Being
Transcribed to 16:9 and Creating a DVD to be Displayed on a Digital TV
Illustrated steps to take source input with 4:3 aspect ratio and convert to 16:9, with the bottom of the
image being cropped in order to preserve top of video so nobody's head gets cut off are provided here.
0) In order to write to a DVD writer hardware device, you must be “root”!!
1) Start Cinelerra-GG to bring up the 4 usual screens with main track canvas in the lower left corner.
2) Load media via the pulldown File→Load files… by choosing the directory path with the desired file.
3) Bring up the “Create DVD” window using File→DVD Render. This window is shown below.
4) Choose Format: PAL or NTSC with 16x9 aspect ratio for today's digital TV as in below screenshot.
5) Modify the “Work path:” parameter to a disk that has sufficient disk space and you will see the
amount of disk space in green letters (/tmp is default, but is often deleted so may be a bad choice).
6) Note that in the following screenshot, Scale of “Cropped” has been chosen.
7) Click the green checkmark on the bottom left side of the window to close it and proceed.

8) Now the “Batch Render” window will appear along with the Scale Ratio brown-colored line below
the video in the main track canvas as seen in the screenshot below. Note that in this screenshot the
top right most corner of the shot displays the bottom portion of the Compositor window.
9) Next, right mouse click the gold-colored magnifying glass, which is on the right hand side of the
brown-colored line. This will bring up the Scale Ratio window that you can see below. Note in the
Compositor window, the blue legs are only showing up to the knees.

With the Scale Ratio plugin you can manipulate your video so that it will look the way you want it on a
different output Display device. In this case we are going to create a DVD for playing on a Digital TV
screen.
In this screenshot, the left side shows the
Input Ratio, Width, and Height of input.
The top right half shows desired output
values. In this particular case, the input
was a YouTube video which was not
quite 4:3 aspect ratio.
Left and right sides of the bottom
portion show the Source and the
Destination X, Y, W, H values. As you
change the values on the left side, you
can see how this will affect the output as
you observe the results in the compositor
window. For example, as you change
the values for SrcY in a “cropped” Scale
scenario, you see up/down movement.
Keep in mind that the monitor you are using is NOT the intended output display device – your digital
TV is, which most likely will have different looking aspect/pixels, etc.

9) In order to “crop” the bottom of the video in order to preserve all of the image on the top, modify the
Src Y value on the bottom of the left hand side in the Scale Ratio plugin. Src Y which was 21 has
now been changed to -18. You will see in the Compositor window how the bottom dark colored
border is now gone so that none of the top portion which contains a person's head will be chopped
off. Compare the next screenshot to the previous and note the blue legs can be now seen to the waist.

10) Click the “Apply” box in the Scale Ratio window.
11) Click the “Save to EDL Path” in the “Batch Render” window for creating a DVD. If you do NOT
do this, you will get a Warning box as seen in the screenshot below, to remind you to Save because you
have changed the EDL by modifying the scaling parameters in the Scale Ratio window.

12) Next, make sure you have the Timeline set in the Main window at the beginning of where you want
to start rendering. Also, make sure the first line in the “Batches to render” section is highlighted as
you can see above by the blue highlighting. Click on the “Start” box in the Batch Render window
and you will see the video playing in the Compositor window.
13) Cinelerra program will be stopped when done rendering; you will be at the terminal prompt where
you will see it has printed out some informational messages (or errors if problems), the last 2 are:
To burn dvd, load blank media and run:
growisofs -dvd-compat -Z /dev/dvd -dvd-video /mnt0/dvd_20161027-131723/iso
14) Load a blank or rewritable DVD into your DVD writer device, which will be similar to /dev/dvd as
in the “growisofs” line above – something like /dev/sr0 on your computer.
15) Keyin the “growisofs” line, substituting your actual writer device name. Again, you must be root.
16) When back at the terminal prompt, and if there are no errors, keyin “eject /dev/dvd” substituting.
17) Play it on your DVD player connected up to your Digital TV screen.

9. Recording: Web Media / Screen Capture / Television and Playback
The recording application really only does one thing, capture media from some external source, and
write it onto a file in a specified way.
Path:
Start time:
Duration:
Source:
Mode:

output media file path
weekday / time of day
hrs:mins:secs
channel/device input
timed
untimed

to begin capture
until end of capture
selection of input subsource
use start time / duration
use transport controls

The media file will be written using the format and codec specified in the settings→preferences→
record tab. Only ffmpeg can record both audio and video simultaneously, and some ffmpeg formats
require too much cpu to do a realtime compression. A setting which is more likely to be usable
(requires less cpu/memory for realtime encoding) is ffmpeg / qt / mp4.qt with bitrates like
audio/256000 and video/6000000.

9.1 Record Web Media by real-time Audio Capture/Screen Capture
Below describes the necessary steps for recording freely available media from the internet for your own
personal use. You have to be on a system using pulseaudio, such as ubuntu, fedora, centos.
1) Start cinelerra and select Settings->Preferences->Recording
From a terminal (with a wide text window) run: pactl list.
You will see all of the audio sources and sinks on your system.
Identify the source associated with the normal output your system uses; example: Source #1.
Locate the source which monitors your normal audio output. For example: front stereo.
2) Choose a File Format and File Type (for example: FFMPEG & qt).
Check Record audio tracks.
Click Audio wrench tool:
Select mp4, for example.
Set Bitrate (256000 is a reasonable number).
Check Record video tracks.
Click Video wrench tool:
Select mp4 video, for example.
Set Bitrate 1000000 - 4000000 (bigger=better, but more cpu)
Select Audio In->Record Driver: ALSA (or whatever you have instead)
Set the Bits: 16 Bit Linear (probably, because reasonable and fast)
Select Device: the source from above pactl list search, for example Source #1)
Samples read from device: aprox dev buffer size (2k-16k probably)
Samples to write to disk: 131072 (a good size)
Sample rate for recording: 44100 (will automatically change)
Channels to record 2 (probably)
Uncheck Map 5.1->2
Gain 1.0

Select Video In->Record Driver: Screencapture
Set the Display: leave blank (probably) or use ":0.0" (default screen/display)
Frames to record to disk at a time: 30 (a good number)
Frames to buffer in device: (2-6) (probably)
Positioning: Software Timing (important)
Uncheck: Sync drives automatically
Size of captured frame: 720x480 (this is your choice, actual capture size; 600x320 youtube)
This defines a “screen capture” rectangular area on the display.
Try to make it the size you need to cover the screen playback area.
Frame rate for recording 23.97 (a good choice, not all choices work)
OK
When recording from the screen, a large green-colored boundary box appears to allow you to easily
frame the screen area to be recorded when you move it around to where you want to position it. In
addition there are “record cursor” and “big cursor” check boxes which allow for also recording the
cursor and for making the cursor bigger.
Screenshot to illustrate some appropriate settings which are described above/below the image.

3) Make sure the Compositor window is up since you will want to see the captured media later.
From the main window press (lower case r) (move windows and resize if needed)
Using the mouse pointer, mouse over the “Video In” Recording monitor display.
Press and hold the left mouse button and drag the display until the desired target screen
capture area is properly positioned inside the record monitor “Video In” display. At first
this may seem confusing, but keep in mind that what you are actually doing is positioning
the portion of your monitor display you want to capture over the “Video In” window.
4) From the “Recording window” select a Path file name for the recording.
5) Select mode untimed.
6) Make sure the “monitor audio” is unchecked else audio becomes looped and is very loud.
7) Press Transport "start recording" (red circle button).
8) Operate the playback of the media source, i.e. start playing the web video.
9) When the media ends, stop on the playback application.
10) Press Transport "stop recording" button (white square button).
11) Before clicking chk-Ok, be sure to set the Insertion Strategy.
12) Press chk-Ok to review the capture, or X to cancel / dismiss application.
Screenshot of what the “Recording” display will look like.

Two things are happening during recording, the data is being written, and it is being rendered. When
recording, if video and audio are not in sync, it will usually be video behind audio as opposed to the
other way around because video is more difficult to decode. During recording, video frame and audio
sample positions are checked and efforts to maintain synchronization are used. Below is an
explanation for some of the less obvious settings for recording as shown in the previous screenshot.
Frames dropped – more input than cpu(s) can process. This is the number of frames dropped when the
system is too slow to keep up with the video. This value serves as a warning that it is behind and is
dropping frames to keep up. You might want to consider stopping to make some parameter adjustments
and start over to reduce drops.
Frames behind – active input buffers. This is the number of frames that the video is behind and it will
drop frames to get caught up. “Frames behind" depends on the synchronization source, for example,
time as the synchronization. This means that frames are not being written as fast as they are being
captured and can occur when the system is too slow to keep up. This situation can happen with older
systems or cpus where there is more input then can be processed in a timely manner. So that when
there are “Frames behind”, frames will be dropped.
The algorithm for determining how many frames to drop is as follows:
If the number of frames behind > 3, only 3 frames will be dropped before it will then do 1 frame;
if the number of frames behind is 2, only drop 1 frame;
if only 1 frame behind, no frames will be dropped.
Drop overrun frames – checkbox when enabled, frames will be dropped. Drops occur when you
capture a frame and there is no storage space available to save it, usually because buffer space is
exhausted. This situation can occur when there are too many frames coming in too fast and the I/O
system is not keeping up in emptying the buffers.
Fill underrun frames – checkbox if enabled, duplicate last frame when no input frame ready for output.
As the tooltip states “write extra frames when behind”. This is desirable in order to keep audio and
video synched with regards to sample and frame rates. Use underrun padding to fill frames when the
input capture rate is lower than the output frame rate. Since demand is constant, you have to output
something, so the last frame is duplicated as many times as needed to keep up. You should stop and
adjust the frame/sample rates to match the input if not filling underruns, then start over. This situation
can occur if the input stops for some reason like lightning interrupts the signal or the internet
connection is too slow.
Transport controls - these control buttons mimic the functions of tape recorders from the old days.
Reverse button/left arrow – remnant from the past; does the same as the Start button really.
Red round button – this is the Start button to start recording.
White square – this is the Stop button to stop recording.
Red round button with white line through the center – start recording in single frame mode. The way
this works is to just “take a picture now, take a picture now...”. The reason to use this mode is to
get a still shot like you would with a camera. Sometimes input is continuous, for example
looking at stars with a telescope -- surveillance goes on for hours, but you just want to take a
picture now when something of significance interest comes up

Cron – The batch recording watcher, cron, is either Idle or Active. When you start or stop batch
recording at specific times, there is a cron thread watching timers to perform the timed action.
Idle/Active indicates whether the timers are running.
Position – this is a timebase which tracks frames/samples when obeying frame/sample rate. When a
recording starts, it resets to 0. Timing is against audio (when available). Audio time and video time are
based on position.
You can select synchronization time source “Positioning” in Settings→Preferences under the
“Recording” tab. Possible choices for time base are:
Presentation Timestamps – use time code which is in both the audio and video media input
stream. Uses these timestamps to sync the 2 streams.
Device Position – this is the device hardware position of where you are. It is usually only on
the audio side.
Sample Position - Sample # or frame # divided by frame rate tells you where you are.
Software Timing – usually used for things like YouTube; it just will “take a picture now”...“take
a picture now”… over and over again until you tell it to stop.
Positioning & Timing needs more detailed explanation for complete understanding and application.
The overall goal is to maintain media stream timeline synchronization. The reason for providing
different “Positioning” options is that different input media may have different timebase standards.
Additionally, the input may be damaged. Damaged data can skew the timeline during presentation.
The timebase standards make it possible to correctly resynchronize the media presentation to the
original time position. For example, the transport layer may have timestamps provided in it. These
timestamps record “audio time” and “video time” and are called “presentation timestamps”.
The kind of positioning used depends on the input device and the media format. In the transport stream
example, the media has already been coded at least once as a stream and contains position information.
In other situations, sample position or device position can provide timeline position. If the input device
provides data at a variable or asynchronous rate, then software timers can provide timeline position.
Sample position is position from the perspective of software, and device position is position from the
perspective of hardware. The difference is buffer time. Device position is usually more accurate, but
may not be available, or may contain errors.
Examples of media which usually has a particular type of positioning is:
1) mpeg has timestamps therefore Presentation Timestamps is a good recording choice;
2) raw media streams/screen capture have no timestamps, so tell it time via Software;
3) a web cam may supply data at variable rates, so again you would use “Software timing”;
4) an example of Device Position is audio (timestamps can come off the device);
5) if Software Positioning working for you, try Sample Position for really bad audio.
Other “Recording” settings are more pertinent to capturing and editing broadcast television with all of
its many commercials. Their usage will be explained in more detail in a later section.
Label – create a label. During capture, put a time marker at the designated spot. When the recording
gets pulled in later for review, you will see a green arrow marking the spot that was clicked.

ClrLbls – clears all of the previously set labels.
Check for ads - check for commercials. In real time, labels are added when a commercial that matches
a previous ad is already in the database (the TDB, Traveling Data Base).
One other noted new feature is a new choice for recording - “V4L2 MPEG”. Some digital tuners now
stream mpeg data for broadcast data streams. V4l2 has been upgraded to be able to process data from
these device streams. Screenshot below shows the available options to include v4l2 mpeg.

9.2 Digital Video Broadcasting (DVB) Capture Configuration
You can do real-time capture of a full transport stream of Broadcast TV. Record television programs
using Cinelerra by setting up ahead of time to start recording later at the specified time. Then you can
use Cinelerra to watch later and easily fast forward through the commercials or edit the program,
deleting the commercials, to watch uninterrupted. Some details may be slightly different than what it is
in the United States. There are 3 requirements you must have to take advantage of this capability.
1) You need to have a suitable DVB Adapter such as the Hauppauge WinTV-HVR 950Q usb
adapter. Make sure it is the linux version, not the new version.
2) Your DVB adapter on your PC should connect to a broadcast antenna input.
3) For now, you may have to run as the “root” user.

9.2.1 Overview
There is a lot of detailed explanation below to be thorough, but an overview is presented here.
1) Set up Record Preferences.
2) Scan the Channels.
3) Watch TV by selecting the desired channel.
4) Or set up a batch job to record a program and watch later via Ctrl-Alt-s in the main window.
5) Or record a currently running program by using the buttons in the Record window.
6) Load a previously recorded program.

9.2.2 Initial Setup for Digital Video Broadcast Capture
Listed below are the steps for the initial DVB setup. Setup will be preserved until you make changes.
1) Start cinelerra, and click Settings->Preferences->Recording
Select File Format checkbox: Realtime TOC (Table of Contents)
It is not necessary to set File Format at this point as it will automatically be set later.
Check Record Audio Tracks.
Check Record Video Tracks.
Select Audio In->Record Driver: DVB
Set the adapter path = /dev/dvb/adapter0 (probably)
Set the adapter dev = 0 (probably)
Set the Bits: 16 Bit Linear (probably)
Check: Follow audio config
Samples read from device: 2048 or approximate dev buffer size (2k-16k probably)
Samples to write to disk 131072 (a good size)
Sample rate for recording: 48000 (will automatically change, probably to 44100)
Channels to record: 2
Uncheck Map 5.1->2
Gain: 1.0
Uncheck: Record in real-time priority
Select Video In->Record Driver: DVB (note, File Format above changes to MPEG Stream)
Set the adapter path = /dev/dvb/adapter0 (probably)
Set the adapter dev = 0 (probably)
Check: Follow video config

Frames to record to disk at a time: 30 (a good number)
Frames to buffer in device: 2 (2-6 probably)
Positioning: Presentation Timestamps (this is important and may not be already set)
Uncheck: Sync drives automatically
Size of captured frame 720x480 (will automatically change)
Framerate for recording 29.97 (will automatically change)
Click OK
Screenshot below shows the Preferences window as a good example of what you should see.

Scan the channels once the devices are setup by performing the following.
2) From the main window pulldown use: File→Record (lower case r) & resize windows.
Two windows appear - the “Recording” and the “Video In”. The “Recording” window
should have “Monitor video” checked and “Monitor audio” unchecked. Remember to
check the Monitor audio later when you want to listen to a TV program.
On the “Video In” toolbar, click the antenna button (Edit channels tool tip).
When the Channels window opens, click scan - “Scan confirm” appears.
Make sure Freq table NTSC_DVB, Norm NTSC, and input0 are chosen automatically.
Click OK and then wait for scan to end which may take several minutes.
Screenshot below on the left shows the Channels window and the popup waiting for scan confirmation.
On the right side is the usual Recording window with the Video in window hidden behind.

Screenshot below shows scanning in progress. Note the “Video in” with the antenna (3rd symbol).

Any time after the channels have been scanned, you can edit them from the “Recording” window
channel selection dialog (shown on left of screenshot above, such as “Sort”). You do not have to scan
the channels every time as they are saved in a database referred to as the channel-db.
Click chk-OK when done scanning channels and making any edits you want.
After the channel-db is ready, you can watch any of the selectable channels.

9.2.3 Watching TV using Cinelerra
If you have setup for DVB capture as outlined in the section above, just start here to watch TV.
From the main window use File→Record to request the “Recording” application.
In the “Video in” window, press the down arrow on the left to see the channel pulldown.
Select the desirable channel, and watch TV. You will have to enable the audio by checking
the “Monitor audio” in the Recording window for sound.
Helpful hints: for any computer that you might choose to use that is a little slower, you can
improve the available resources for watching TV by unchecking “Audio meters”, checking
“drop overrun frames”, and checking “fill underrun frames”. Also, uncheck “Realtime TOC”
in the Preferences→Recording window.
Dismiss the “Recording” window with chk-OK, or X to cancel when finished.

9.2.4 Recording TV to Capture at some Future Time via Batch
After the initial setup and channel scan completion, with the Recording application down (so that the
/dev/dvb/adapter0 hardware is not in use) you can scan the DVB channel program data by pressing
“Ctrl-Alt-s” from the main window. It can take a minute or two to scan the channels. The resulting
display is a large array of program buttons, with tooltips which are the TV program info text.
Screenshot showing Channel Info window after the “Ctrl-Alt-s” completes scanning TV program data.

Now if you mouse over a program button, you see the TV program's info. Each of the programs is
represented by a button. If you press a button, it preloads the program recording information into the
batch record box below. In the bottom right corner box, you should set the “Directory” path of where
to write the recording before pressing a button, so that the files will be written to an area of sufficient
size to handle the recording (9.5Gb/hr). The two little spinboxes on the Duration line in the right
bottom corner are leadin/leadout times to start recording a few minutes early, and end a few minutes
late to prevent losing program endpoints. Instead of setting it to the original default of 0, you might
want to start 3 minutes (-3.00) before and stop 3 minutes after (+3.00). Also, be sure your computer
has the correct time or it will miss. Check to make sure the “Start Cron” option is checked (default).
The batch job will start monitoring the channel to be ready for capture once you chk-OK and you will
see the “Recording” window and the “Video in” window come up. The computer will power off after
completion if the “Poweroff” checkbox is selected (not default). The job line of the active capture in
the batch bay will flash continuously once the recording is started.
In the Channel Info window, lower left hand corner above, there is a Find button which brings up a
textbox so you can type in a TV program. When you double click on that program name, the cursor
moves to the center of that program name in the list of programs in the window, highlights that
program, and the characters that were white on black, turn yellow.

9.2.5 Recording Immediately to Capture a current TV program
If you have setup for DVB capture as outlined in the first section above, just start here to record a TV
program that is currently playing and stop it whenever you want. Media files can be directly captured
from the “Recording” window to include Start, Stop, and then loaded via chk-OK.
Bring up the “Recording” window via the main window File→Record (lower case r).
Set the “Path” to the write file Path; be sure there is enough disk space (9.5Gb/hr).
Set “Mode” pulldown to “Untimed” found in the upper left corner area of the window.
Press transport "start recording" button (red round button).
Path will flash and update in batch window and remain flashing while recording.
Press transport "stop recording" button (white square button).
Before clicking chk-OK, be sure to set the Insertion strategy.
Pressing chk-OK attempts to load any newly recorded media data for review..
Or press X-cancel to terminate and dismiss the “Recording” application.
Screenshot showing the recording of a currently running broadcast TV program weather report.

9.2.6 Record “on the fly” Table of Contents (TOC)
If the Settings→Preferences→Recording tab is selected, and the “video Record Driver” is changed to
DVB, the file format is switched to MPEG Stream automatically (note that the “audio Record Driver”
must also be set to DVB for broadcast recording). This kind of record stream can be captured by
simply writing the hardware capture stream directly to the record capture asset file path. But by
checking the “Realtime TOC” in the Preferences Recording window, it is possible to scan the stream
data “on the fly” on its way to being written while the asset is being captured . The scan is used to
generate a TOC – Table of Contents file in the $HOME/.bcast5 directory. This file is used by the mpeg
library to view the stream. This avoids the need to scan the file on first open since the TOC builder can
run in realtime.
Screenshot showing the red-checked “Realtime TOC” for the “Record Driver” of DVB.

9.2.7 Watching a Previously Recorded TV program
If you have setup for DVB capture as outlined in the section above, just start here to watch a previously
recorded TV program. Use the following steps.
In the main window choose File→Load files and select the desired media file to watch.
Broadcast transport streams may consist of multiple programs that all run together on one
channel (for example 9-1, 9-2, and 9-3 are all on channel 9). Therefore when you play the
recorded program back all of these programs will play simultaneously and that is a jumble.
In order to select just the one you want, press Alt-1 in the main window to select Asset
Program 1 (or Alt-1...8 to select the desired asset program number) which removes all of the
unrelated audio/video tracks except for the selected program. It also resets the session to
match the media.
Move timeline to where you would like to start watching.
Be sure the Compositor window is up and you will see the pre-recorded program there. Use
either the keyboard, a remote control that has been set up, or Android device for controls. To
toggle between fullscreen or original size, press “f” in the Compositor window.
To watch on a large TV screen or monitor which you have connected, you will have to setup for Dual
Screen Mode as explained in the next section. In addition, you can either use a Remote Control
hardware device or special key setup for manipulating the playback.

9.2.8 Dual Screen Mode
Dual screen mode is useful for displaying cinelerra video/project on a large screen digital Television set
or for watching a previously recorded broadcast TV program via Cinelerra. The physical configuration
results in one screen (an Xwindow) on one monitor and the other screen on the other monitor or TV
screen. Before the mode is usable for Cinelerra, X has to be configured in “dual screen mode” - that is,
you must first split the configuration into 2 displays to operate Dual Screen Mode. On some systems,
you may be able to get to the dual screen mode by using Xinerama allowing for use of 2 physical
displays to act as 1 virtual display.
The main menu pulldown, Settings→Preferences→Playback A and B Tabs, must be properly
configured in order to take advantage of the Dual Screen Mode capability.
In the main menu Window pulldown there are “Tile left” and “Tile right” options for the 2 monitors. If
you have only 1 monitor, you will see no change upon activating these options. Tiling is possible due
to the existence of one long horizontal screen display buffer. Tile left takes Cinelerra and moves all of
its windows to the 2nd monitor/TV and Tile right puts it back to the 1st monitor. The left and right
monitors are the left part or right part of a Playback A/B Xwindow host referenced in the Video Config
Playback A/B for separate X screens. Shortcuts for Tile left and Tile rights are the letters a and b on the
keyboard once you have set Remote Control mode. Below is a summary of the configuration letters:
a - select playback a and tile windows left (all on monitor or laptop)
b - select playback b and tile windows right (all on 2nd monitor or TV)
c - select playback c and tile windows left, but composer right (TV mode)
This option has the effect of taking the Compositor window and moving it to the 2nd
monitor/TV without the surrounding borders interfering with the video.
Since Dual Screen Mode is most widely used for either a demonstration or watching TV, you will want
to take advantage of Remote Control mode as described in a following section. In the camera shots
below, note the square red box that shows up in the upper left hand corner of the Viewer window
(arrow pointing to it but it looks more orange than red) which denotes that the Application/Menu key
was used to get into Remote Control mode.
Camera shot below shows 2 monitors (could just as well be a big-screen TV for the second monitor)
with Tile left where all of the cinelerra windows are on the left most monitor. The big red arrow points
to the little red square box (actually may look orange) indicating that Remote Control mode is in effect.

Camera shot below shows 2 monitors with Tile right (b key) where all of the cinelerra windows are on
the right monitor. The left monitor shows the Suse distro logo and a couple of xterm type windows.

Camera shot below shows 2 monitors with Compositor window on the 2nd monitor which was
obtained through use of the “c” keypress available when in Remote Control mode.

Camera shot below shows 2 monitors with Compositor window on the 2nd monitor in FULLSCREEN
mode so that no cinelerra borders are visible to distract from the picture. The big red arrow points to
the little red square box (may actually look orange) indicating that Remote Control mode is in effect.

9.2.9 Remote Control for DVB
Cinelerra DVB recording/playback can now easily be done in “couch potato” mode using a remote
control. This comes in handy when you want to playback on a big TV screen for multiple person
viewing. You can use the Application/Menu key on the keyboard to toggle between standard Cinelerra
usage or a Dispatcher methodology through use of a remote control, an Android programmed device
such as a tablet, or keyboard. The Application/Menu key on most keyboards is between the Alt and Ctrl
keys on the right hand side bottom and depicts a menu on it either with or without a pointer (see image
below). An ati-x10 Remote Control device is currently working with Cinelerra and other remote
controls may work but have never been tried. The red/orange box on the top left main screen of
Cinelerra indicates Dispatcher Method access is activated which allows for keyboard grab which
routes all key strokes until toggled off. Below are the currently defined operations.
Remote Control Keys (Application/Menu key toggle for ati-x10 remote)
up arrow -

forward 1 minute

down arrow left arrow right arrow dfabc-

backward 1 minute
back 10 seconds
forward 10 seconds
toggle channel scan menu
toggle full screen
select playback a and tile windows left (all on laptop)
select playback b and tile windows right (all on TV)
select playback c and tile windows left,
but composer right (TV mode)
select timeline by 1/10s from beginning to end
toggle audio mute
toggle audio meters
display mpeg ts stream program data
display mpeg ts stream channel schedule date
change channel, next
change channel, prev
start channel change by numeric entry
clear channel entry
toggles channel scan (always available)
terminates cinelerra (always available)

0-9 amkeypad / keypad * keypad + keypad - keypad . keypad .. book key hand key -

Plus usual Transport keys
e??
ftoggle full screen
<< fast reverse
>toggles normal playback
>> fast forward
red o slow reverse
square stop
2 lines fast reverse

Ati-x10 Remote

Application/Menu key
right bottom of keyboard

The Application/Menu key is used to get into remote control mode, even if there is no remote control
hardware device in use, allowing for use of the same defined remote control keys to work on the
keyboard. Once the Application/Menu key enables remote mode, the remote control keys don't allow
the standard Cinelerra keys to work.

9.2.10 Android Remote Control for DVB
Cinelerra 5.x has android remote interface code. Any device, such as a tablet or a phone, can be used as
long as it is running the Android operating system. Programming an Android Remote Control for DVB
is a bit complicated at first, but becomes pretty simple after a bit.
1) The Android Remote Control requires you to download and install the android CineRmt app
package (apk). To install it simply download it (any way you can) to your phone or tablet
and click it to install, if it doesn't run automatically.
2) You should be able to open Settings→Preferences→Interface tab. And see Android Remote
Control in the Operation section. Enable it using the checkbox. The default port 23432 and
default PIN cinelerra are OK.
3) After you install the new phone/tablet app in step 1, start it up from your apps menu.

Before you can use it, the Android device must have the ip address of your computer entered into the
configuration menu. The PC you are running Cinelerra on and the Android device have to be on the
same network. You can tell it is in communication by tapping the Power (menu) button. When the
remote is operated with the Power (menu) button, there is a little orange box on the upper left corner of
the display to indicate the remote state is active. If you do not see the little orange box when the menu
key is tapped, the communication is broken and must be fixed before proceeding. Follow the
directions in the paragraph below.
BIG NOTICE: the firewalls in your computer and wifi router can stop this thing dead. Re-configuring
a firewall is tricky and varies from distro to distro. If possible, during setup it is suggested that you
disable the firewall temporarily. For those with advanced skills, use tcpdump or wireshark to look for
udp messages from the IP address of the device.
SECTION NOT COMPLETE – (manualandroid)

Screenshot of an Android Tablet that can be used as a
Remote Control for Cinelerra Recording and Playback.

9.2.11 How to Setup a Remote Control Device to work with Cinelerra
SECTION NOT DONE !! This section explains how you can take your own brand of remote control
and set it up to easily work the way you want with Cinelerra.

9.3 The commercial DB... What is that? A TDB – Traveling Data Base
While watching broadcast television, it is possible to use Cinelerra to automatically mute commercials
being aired during a broadcast capture. Visual muting as well as sound muting is done! You can NOT
use ffmpeg for the format when working with the commercial DB. This database that was added is a
“novel architecture” shared memory database, a Traveling Data Base (TDB). With TDB you have
direct access to the shared database presence (instead of having to go to the server).
Basically it works as follows, but there are a few differences in just how it goes about it:
1) Identify a zone in a timeline as a commercial.
2) Characterize it concisely, in the audio and video timeline.
3) Store the characterization in a database.
Then, when capturing media or building a table of contents for an mpeg transport stream (broadcast
capture DVB):
1) Characterize each I-Frame (a few frames per sec).
2) Search the database in real-time to identify the image.
3) If a match is identified, automatically press the mute button.
4) Unmute if the pattern match fails, or the commercial ends.
It mostly works, but it takes more time to setup and maintain the database as the advertisements change
frequently or vary by a small amount. It would take a small set of personnel to keep the database
current and some finessing of the code.
Currently, to activate the commercial database (db) methods you must do the following as root:
cd <cin-path>/bin
mkdir /cinelerra
(yes, currently only in the / filesystem)
./cin_db /cinelerra/media.db (to create a new empty commercial capture database)
export BC_USE_COMMERCIALS=1 (in the command shell that is starting cinelerra)
This activates the gui tools and database access. As of yet, all of the requisite permission changes
necessary to run as non-root have not been worked out (initially just easier to run as root).
When a commercial is "cut", the following occurs:
1) transmits the capture timeline fragment to /tmp
2) scans the snip to characterize it statistically
3) creates a miniature b/w movie of the beginning and end
4) stores all of this into the media.db
There are 2 ways currently to identify a commercial:
1) Load mpeg3 transport media, highlight select the commercial in the timeline, and press "cut
commercial" on the toolbar.
2) Use the remote control interface to indicate the boundary in/out cut points in the realtime
capture timeline, and operate a cut command.

The cut command creates a popup to let you know that it is processing the captured data. This can take
several seconds depending on the size and media format. The results from the scan are stored in a new
record in the “media.db”.
The stats are somewhat disappointing. Image recognition is way past zero, it is not 100 percent.
Broadcast streams have tons of minor variances which hamper digitally perfect reproduction from
instance to instance of commercial presentation. This puzzle remains to be solved.
To review media stored in the “media.db”, and delete old expired commercial data records, press
(Shift-M) from the main window. This will create a media-db window which shows the various
captured samples stored there.
Currently, only a customized ati-x10 (kernel mod required) radio remote control works. But this can
quite readily be modified for other remote control models.

10. Themes User Interface
Akirad themes have all been added to Cinelerra-GG with major thanks to the Cinecutie project for all
of their hard work. These modifications provide alternative User Interface environments and allows
you to choose your favorite look. Be aware that when you change your theme, Cinelerra will
automatically shutdown and restart for it to take effect. The theme you choose is preserved across
sessions.
Theme choices available:
Blond
Blond-cv
Blue
Blue Dot
Bright
Hulk
Neophyte
PinkLady
S.U.V. (default)
Unflat

How To Change your Theme:
To change a “Theme” in the main window pulldown,
select Settings→Preferences then
in Preferences window, click on the “Appearance” tab.
In the Editing section in the lower left hand corner,
click on the down arrow next to Theme to see your choices.
Click on your desired choice from the list given.
Check OK, cinelerra will automatically shutdown and restart.

Screenshot showing the “Neophyte” Theme and the Preferences Window where you can change them.
Neophyte theme added August 2018 courtesy Olaf.

11. Resizable Fonts/Icons Support
You can increase the size of the characters in the fonts and icons on your Cinelerra system. This will
make it easier to read the characters if you have trouble seeing the default small letters, which have
been auto-scaled based on the window geometry. The user-friendly font/icon scaling default is 1. To
defeat default auto scaling and get any size characters/fonts, override the setting via shell environment
variables. For example:
export BC_FONT_SCALE=2.0 ! twice as big, may show letters beyond the borders
export BC_ICON_SCALE=1.5 ! 1.5x bigger

12. Vicons & Aicons – aka Video Icons / Audio Icons
Vicons are video icons. Aicons are audio icons. The Resources window will play the first 5 seconds of
video and/or audio looped in the area occupied by the media icons. This is only enabled for the "media"
folder in "icon" mode when the mouse pointer is actually inside the Resources window. There is also a
“Preview” or "playback" toggle to enable/disable the icon playback activity. This playback toggle is a
green arrow to the right of the Visibility label as seen in the screenshot below. It is active when
surrounded by a gold-colored background and inactive if no background.

When “Preview”/“draw vicons” is enabled/active, if you click on one of the video icons or an audio
waveform icon, a view pops up that increases the size to 4 times the surface area larger. This makes it
easier to see or hear if it is the media you are looking for in case you have many similar media files. To
conserve memory, the video is stored 8-bits per pixel which results in low image quality while the
audio is 16-bit. The reason for playing 5 seconds of a video for a vicon is that until the first I-frame, the
media frequently does not decode properly. In other words, a lot of media does not begin at the
“beginning” point and will not be properly rendered until enough data has been read to assemble a
picture.
A “mouse over” mode is activated by a single click on one of the vicons/aicons and deactivated with
another single click over any of the icons. Once activated, whenever you just move the mouse over an
icon, it automatically pops up the increased size preview. The first time in your session that you enable
this feature, it may take a few seconds to load all of the icon previews into memory so be patient and
just wait. This makes it quick and easy to preview without having to drag the media to the viewer. You
can still drag the media same as without preview enabled.

More information about the a-icons, audio icons, is described next. The waveform is displayed in the
Resource window as "yellow" for the 2nd audio track with "green" for the 1st track on top. There is a
colored bar on the top of each a-icon where the color is based on the Color Spectrum - the smaller the
time duration, the redder the color; then as the time duration goes up, the color goes up so that you will
go to green, then yellow, then blue, then really dark blue, then purple for the audio files 1 hour and
over. There are various other colors between these colors same as that seen in the color spectrum in the
screenshot below. Colors are utilized from the hue wheel in the counter-clockwise direction. Note that
the horizontal line in the middle of the a-icon is yellow/red representing the 2 audio tracks and is only
red for mono.
Draw Vicons |

Screenshot display various audio file lengths; red is shortest.

← Color hue wheel
for illustration only

Note that if in Settings->Preferences under the Appearance tab ,you have unchecked “Use thumbnails
in resource window” you will only have default icons and none of the above capabilities.

13. Toolset Visibility Support
Cinelerra contains many plugins, especially with the recent addition of ffmpeg, and it is somewhat
difficult to find the one you are looking for in the Resources window. In Cinelerra-GG, the plugins
have been categorized into the following subsets in the Visibility section of the Resources window to
make it easier to locate a particular one:
Audio Effects, Video Effects, Audio Transitions, Video Transitions, Labels, Clips, Proxy, Media
Assistance in further categorizing these plugins would be welcome. There may be additional categories
needed or plugins that are currently miscategorized for a more intelligent grouping. There is a text file
called “plugin_defs” located in the path where cinelerra was installed, that currently contains the
definitions for plugin groupings. Email any recommended changes. Below is an example:
plugin_dirs += colors
colors := brightness bluebanana C41 color3way colorbalance huesaturation …
Screenshot showing on the left hand side the Visibility box with Audio Effects highlighted.

Another helpful feature of the “Visibility” toolset in the Resources window gives you the ability to turn
off or on any of several sets of plugins. If you left-click the Visibility box, you will see the various
categories of plugins, such as ladspa, ffmpeg, audio,opencv, video. Highlight the set you want to turn
on and a check mark appears to show it is active. Highlight again to toggle it off. And handiest of all
is the ability to add your own personal directory of plugins which will show up here. See the attached
screenshot which illustrates that all of the plugins are turned off (not visible) except for your own

personal set, called “old_plugins”, which just contains the AgingTV plugin. All you have to do to have
these plugins become visible is to create a directory, with some name that is meaningful to you, and put
your .png files in your cinelerra_path bin/plugins/<your_directory_name>.
Screenshot showing the Visibility categories of plugins with all toggled off except old_plugins.

14. Menu Bar Shell Commands
In order to provide some configuration control, the Menu Bar Shell Commands are available for
customization purposes. In the main window on the top line containing the File, Edit, … Window
pulldown menus, all the way to the right hand side is the “shell cmds” icon. You will see a small goldcolor bordered box with the >_._ inside and if you mouse over it, the tooltip says “shell cmds”. This is
a configurable popup which gives you the ability to execute a pre-defined script to do something such
as post processing to be done on a repeating basis. One option is “Setting Shell Commands” for info.
The Shell Cmds popup menu items are configured in:
Settings->Preferences->Interface->Shell Commands
This runs a dialog that lets you Add/Del/Edit the items in the main menu popup. Possible options are:
1) Add a new menu item/script:
click Add
in the Label box, change the word "new" to the desired menu label
in the Commands box, type the command lines to be included in the script
(for example: Label => gimp; Commands => gimp)
check-OK in the Commands window
check-OK in the Shell window
click on OK or Apply in the Preferences window

2) Del to delete an existing menu item (for example manual):
select to highlight an entry in the Cinelerra: Shell listbox
click Del
check-OK in the Shell window
click on OK or Apply in the Preferences window (the entry is destroyed)
3) Edit an existing menu item:
click Edit
select to highlight an entry in the Cinelerra: Shell listbox
click edit (the edit dialog appears)
set the label and/or commands to the new desired values
check-OK in the Shell window
click on OK or Apply in the Preferences window
Next time you click on the “shell cmds” icon, you will see your new labels.

When a new script is added in cinelerra’s release, it will not be added to your Preferences file unless
you create a new one.

15. Last Play Position Memory
When you play media, the start/end playback positions are saved as if they had been made into
temporary labels. They appear on the timeline as purple/yellow hairline markers representing the last
start/end labels for the last playback. They can be addressed as if they are label markers using:
Ctrl← tab to the label before the cursor, that is “play start”
Ctrl→ tab to the label after the cursor, that is “play stop”
You can use these markers for re-selection. Additionally, the selection region can be expanded by
“pushing” the markers using single frame playback. Use frame reverse (keypad 4) to push the start
play marker backward, or use frame forward (keypad 1) to push the end play marker forward.
Another handy feature is to use the combination of Ctrl-shift-arrow (left or right) to select the media
from the cursor position (red hairline) to the start or end marker by “tabbing” to the label markers. For
example, tab to the beginning of the previous play region using Ctrl-left-arrow to move the cursor to
the beginning of last play, then press Ctrl-Shift-right-arrow to tab to the end of the playback region.
Now you can clip/play/expand or edit the previous playback selection.
Ctrl SHIFT→ tab cursor to label right of cursor position and expand selection
Ctrl SHIFT← tab cursor to label left of cursor position and expand selection

16. Audio H/W Gain Support
This feature, device level gain, corrects for hardware conditions which some devices may need to be
useful. For example, you may need to increase the gain for a weak microphone or a noisy speaker,
since it affects rendering when you crank up or down the audio via use of the patchbay. With the audio
H/W gain support, you have the ability to fine tune the audio volume by some numerical value for the
scale. You are adjusting the scaling of data into the audio driver - H/W scaling is done before it goes
into or out of the driver. This is a one time linear multiplication of the sample values, and may offer
better control than the logarithmic DB gain controls of the application. These device controls are in
Preferences:
Settings → Preferences→ Playback(A/B) → Audio Out → Gain
Settings → Preferences → Record → Audio In → Gain

17. Valgrind Support Level
Valgrind is a memory mis-management detector. It shows you memory leaks, deallocation errors,
mismanaged threads, rogue reads/writes, etc. Cinelerra-GG memory management is designed to work
with Valgrind detection methods. This assists in developing reliable code. Use of Valgrind points out
problems so that they can be fixed. For example, when this version of Cinelerra shuts down, it
deallocates memory instead of just stopping, thus making memory leak detection possible.

18. Subtitle Track and Subtitle Script Support
A subtitle track is a text only version of track data. It has time position and duration on the timeline,
the same as audio or video data. The text for the subtitle is rendered into the track timeline in the edit
interval that corresponds to the position where it appears during playback. Its content is text only, and
is entered using the interface activated by the menu bar File→Subtitle menu item. The subtitle output
data file format is microdvd, and can be used by dvdauthor to create “textsub” text based subtitles.
For details on how to utilize this feature, see the section: “Additional Features for Blu-ray/DVD
Creation”.

19. CFLAGS has -Wall
When compiling Cinelerra-GG Infinity a CFLAGS option used is “Wall” where the “W” represents
warnings and “all” means all. This causes the compile to check for simple mistakes that can be
detected automatically and issue warnings when the code is questionable. It can also detect situations
where the compiler will generate incorrect code, like type-punned pointer. By turning on this flag,
when new code is vetted for predictable mistakes, the code can be corrected before becoming
manifested in the application.

20. Multi-Viewer Window Support
You can create as many Viewer windows as you want in Cinelerra. These are handy for users who are
adept at working with a lot of different clips simultaneously. By bringing up multiple Viewer windows,
each clip can be edited in its own area, making it easy to see all of the separate pieces. After you have
loaded some media files, to start another Viewer window, right click on one of the pieces of media in
the Resources window. This brings up a menu of several options, one of which is “view in new
window”. Choose this option and that media will come up in a new Viewer window for you to work.
Screenshot showing multiple Viewer windows (3) and the popup menu with “View in new window”.

21. Overlay Modes – Alpha Blending with PorterDuff and Operators
The purpose of the Overlay Modes is to control the foreground and background stacking and use
blending to reshape image object boundaries. It normally makes use of a binary type alpha blending
system for all in or all out. To use the available operations in Cinelerra, follow these steps:
1) In the main window, look at the Patchbay on the far left.
2) Click on the small arrow that points to the right, inside the panel to see it expand.
3) A down arrow shows up with a tooltip of “overlay mode”.
4) Use the down arrow to get to the popup menu and choose the desired effect from the 30
possibilities. “Normal” is the default.
Screenshot on the left shows the pulldown in the
patchbay and the tool tip “Overlay mode” which
provides access to 4 types of overlays. Each will
expand further as shown in the screenshots
below for “PorterDuffs” and “graphic art”.

Porter-Duff is the industry standard for alpha blending operations. Only a short explanation follows
here, but there is much more information to be found on the internet with complete descriptions and
examples. Every pixel has 3 color channels (like RGB), and may have 1 alpha channel value. If there
is no alpha defined for a color model, the alpha value is assumed to be 1. Regions of the image are
created with the alpha image map. These regions are manipulated using the blending operations
described below. Alpha blending is the process of combining a foreground color with a background
color which produces a new blended color. The “alpha” channel describes how much opacity is present
in a pixel. It may be completely transparent, completely opaque, or any range of translucency.
Conceptually, when the foreground color is completely opaque, the resulting blended color will be the
foreground color. If it is transparent, the blended color will be the color of the background. When the
value of the alpha channel is 1, the image is all there, if it is 0, there is no image at all, otherwise it is
only partially there. In other words, the alpha value goes from 0 to 1, where full transparency is 0 and
opaque is represented by 1. Alpha blending models opacity.
When blending source and destination shapes, the shape boundaries can be changed with the alpha
blending effects. There are a total of 10 standard Porter-Duff operators, but there are 30 possible
overlay modes used in Cinelerra-GG Each is characterized by its value in the four regions: source,
destination and both, with the “neither” region always being blank. The source and destination regions
can either be blank or filled with the source or destination colors. A specific compositing math formula
is used to calculate effect. This is only applicable to RGB; some effort has been made to accommodate
YUV, but the effects are not as predictable, and may not be useful.
Below are the results of utilizing the 30 available operations within Cinelerra as listed on a following
page. Src is the solid green rectangle and Dst is the solid red rectangle. There are better illustrations of
what alpha blending can do, however for consistency sake, these are the results when using standards.
normal
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The implementation math forms are listed below, where D=Destination, S=Source, a=alpha, c=chroma
(color). Each line describes a pair with the left one for alpha and the right one for chroma.
NORMAL [Sa + Da * (1 - Sa), Sc * Sa + Dc * (1 – Sa)])
Arithmetic
ADDITION [(Sa + Da), (Sc + Dc)]
SUBTRACT [(Sa - Da), (Sc - Dc)]
MULTIPLY [Sa + Da - Sa*Da, Sc*(1 - Da) + Dc*(1 - Sa) + Sc * Dc]

DIVIDE
[Sa + Da - Sa*Da, Sc*(1 - Da) + Dc*(1 - Sa) + Sc / Dc]
REPLACE [Sa, Sc] (fade = 1)
PorterDuff
DST
[Da, Dc]
DST_ATOP [Sa, Sc * (1 - Da) + Dc * Sa]
DST_IN
[Da * Sa, Dc * Sa]
DST_OUT [Da * (1 - Sa), Dc * (1 - Sa)]
DST_OVER [Sa + Da - Sa*Da, Sc * (1 - Da) + Dc]
SRC
[Sa, Sc]
SRC_ATOP [Da, Sc * Da + Dc * (1 - Sa)]
SRC_IN
[Sa * Da, Sc * Da]
SRC_OUT [Sa * (1 - Da), Sc * (1 - Da)]
SRC_OVER [Sa + Da - Sa*Da, Sc + (1 - Sa) * Dc]
Logical
MIN
[min(Sa, Da), MIN(Sc, Dc)]
MAX
[max(Sa, Da), MAX(Sc, Dc)]
LIGHTEN [Sa + Da - Sa*Da, Sc*(1 - Da) + Dc*(1 - Sa) + max(Sc*Da, Dc*Sa)]
DARKEN [Sa + Da - Sa*Da, Sc*(1 - Da) + Dc*(1 - Sa) + min(Sc*Da, Dc*Sa)]
AND
[Sa * Da, Sc * Dc]
OR
[Sa + Da - Sa * Da, Sc + Dc - Sc * Dc]
XOR
[Sa + Da - 2 * Sa * Da, Sc * (1 - Da) + Dc * (1 - Sa)]
Graphic Art
OVERLAY
[Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + 2*Dc < Da ? 2*Sc*Dc : Sa*Da 2*(Da-Dc)*(Sa-Sc) ]
SCREEN [Sa + Da - Sa * Da, Sc + Dc - (Sc * Dc)] (same as OR)
BURN
[Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + Sc <= 0 || Sc*Da + Dc*Sa <= Sa*Da ?
0 : (Sc*Da + Dc*Sa – Sa*Da)*Sa/Sc]
DODGE [Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + Sa <= Sc || Sc*Da + Dc*Sa >= Sa*Da) ?
Sa*Da : Dc*Sa / (1 – Sc/Sa)]
DIFFERENCE
[Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + abs(Sc * Da - Dc * Sa)]
HARDLIGHT [Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + 2*Sc < Sa ? 2*Sc*Dc : Sa*Da 2*(Da - Dc)*(Sa – Sc)]
SOFTLIGHT [Sa + Da - Sa * Da, Sc*(1 - Da) + Dc*(1 - Sa) + Da > 0 ? (Dc*Sa + 2*Sc*(Da Dc))/Da : 0]
The previous math forms are the only truly accurate description of each blending operation, but short
descriptions are below where “Source” is the output from the next track and “Destination” is the output
from the lower track stacking. Blending starts with new Source and combines it with the previous
render stack output, which is referred to as Destination. The new output becomes the next Destination
and the next up stack level becomes the new Source. Source is above; Destination is below.
Normal – Normal mode is the default layer mode. The result color is the source color. The layer on
top covers the layers below it. If you want to see anything below the top layer when you use this mode,
the layer must have some transparent areas. It is “stacked on top”. Math formula used is different than
that used by Gimp; there is no SVG equivalent.
Arithmetic Group – standard numerical operations:
Addition – The source is added to the destination and replaces the destination. Addition mode is very
simple - the pixel values of the upper and lower layers are added to each other. The resulting image is

normally brighter. The equation can result in color values greater than 255, so some of the light colors
may be clipped to the maximum value of 255. Math formula is the same as that used by SVG but
different than Gimp.
Subtract – Subtract mode reduces the pixel values of the upper layer by the pixel values of the lower
layer. The resulting image is normally darker. You might get a lot of black or near-black in the
resulting image. The equation can result in negative color values, so some of the dark colors may be
clipped to the minimum value of 0. Math formula used originated from HV cinelerra and is different
than that used by Gimp; there is no SVG equivalent.
Multiply – The source color is multiplied by the destination color and replaces the destination. The
resulting color is always at least as dark as either the source or destination color. Multiplying any color
with black results in black. Multiplying any color with white preserves the original color. Math
formula is the same as used by SVG and Gimp.
Divide – Divides source color by destination color. If the source color is white, the result color is the
underlying color. The resulting image is often lighter. Math formula used is different than that used by
HV/CV and Gimp; there is no SGV equivalent.
Replace – Replace mode will cause any existing destination to be replaced by the source media.
Mathematical formula used is the same as used by Gimp; there is no SVG equivalent.
PorterDuff Group – industry standard compositing operators:
DST - The destination is left untouched. Only the destination will be present in the output. Math
formula is the same as that used by Porter-Duff and SVG; there is no Gimp equivalent.
DST_ATOP - The part of the destination lying inside of the source is composited over the source. The
destination outside the source is dropped. You will see the existing canvas is only kept where the
shapes overlap. Math formula is the same as that used by Porter-Duff and SVG; there is no Gimp
equivalent.
DST_IN - The part of the destination lying inside of the source is displayed. This effectively allows
for cutting out the background using the current layer/feature as a mask. You will see the new shape is
drawn only where both the source and the destination overlap. Math formula is the same as that used
by Porter-Duff and SVG; there is no Gimp equivalent.
DST_OUT - The part of the destination lying outside of the source is displayed. This is basically a
reverse mask, compared to destination-in. You will see the existing content is kept where it doesn't
overlap the source. Math formula is the same as that used by Porter-Duff and SVG; there is no Gimp
equivalent.
DST_OVER - The destination is composited over the source. Math formula is the same as that used
by Porter-Duff and SVG; there is no Gimp equivalent.
SRC - The source is copied. The destination is not used as input. Only the source will be present in
the output. Math formula is the same as that used by Porter-Duff & SVG; there is no Gimp equivalent.
SRC_ATOP - The part of the source lying inside of the destination is composited over the destination.

The source outside the destination is dropped. You will see the existing canvas is only kept where the
shapes overlap. Math formula is the same as that used by Porter-Duff and SVG; no Gimp equivalent.
SRC_IN - The part of the source lying inside of the destination is displayed. This effectively allows
the destination to act as a mask for the layer/feature being shown. You will see the new shape is drawn
only where both the source and the destination canvas overlap. Math formula is the same as that used
by Porter-Duff and SVG; there is no Gimp equivalent.
SRC_OUT - The part of the source lying outside of the destination is displayed. This is basically a
reverse mask, compared to source-in. You will see the new shape is drawn where it doesn't overlap the
destination. Math formula is the same as that used by Porter-Duff and SVG; there is no Gimp
equivalent.
SRC_OVER - The source is composited over the destination. Math formula is the same as that used
by Porter-Duff and SVG; there is no Gimp equivalent.
Logical Group – Venn diagram operations of area combinations:
Min – The output color is the component-wise minimum value of the source and destination colors.
There is no SVG or Gimp equivalent math formula.
Max – The output color is the component-wise maximum value of the source and destination colors.
There is no SVG or Gimp equivalent math formula.
Lighten – Selects the lighter of the destination and source colors. The destination is replaced with the
source when the source is lighter, otherwise it is left unchanged. Completely black layers have no
effect on the final image and completely white layers result in a white image. Math formula is the
same as used by SVG and Gimp's “lighten only”.
Darken – Selects the darker of the destination and source colors. The destination is replaced with the
source when the source is darker, otherwise it is left unchanged. Completely white layers have no
effect on the final image and completely black layers result in a black image. Math formula is the same
as used by SVG and Gimp's “darken only”.
And – This operation intersects source and destination. If either image is not white, it down factors the
other image. Usually you will end up with a lot of darker areas. There is no SVG or Gimp equivalent
math formula.
Or – This operation is the union of the source and the destination. If either image is not black, it adds
to the other image. Usually you will end up with a lot of lighter areas. Math formula is the same as
that used by “Screen” operation in SVG; there is no Gimp equivalent.
Xor – The union of the source and destination with the intersection removed. Results in black if they
are equal. Shapes are made transparent where both overlap, and drawn normal everywhere else. Math
formula used is that used by Porter-Duff; there is no Gimp equivalent and SVG formula differs.
Graphic Art – typical operations from popular "paint" packages:
Overlay – Multiplies or screens the colors, dependent on the destination color. Source color overlaythe
destination while preserving its highlights and shadows. The destination color is not replaced, but is

mixed with the source color to reflect the lightness or darkness of the destination. Dark parts on the
base layer become darker, and light parts become lighter. Math formula is same as SVG and Gimp.
Screen – The source and destination are complemented and then multiplied and then replace the
destination. The resultant color is always at least as light as either of the two constituent colors.
Screening any color with white produces white. Screening any color with black does not change the
other layer. Using the Screen mode is similar to projecting multiple photographic slides simultaneously
onto a single screen. A lighter picture is the result. Math formula is the same as used by SVG and
Gimp. This is identical to “Or”.
Burn - Darkens the destination color to reflect the source color. Burning with white produces no
change. In photography, burning is a technique used in a darkroom to increase the exposure in
particular areas of the image. This brings out details in the highlights. Math formula is the same as
used by SVG and Gimp.
Dodge - Brightens the destination color to reflect the source color. Dodging with black produces no
change. The result color is a lightening of the source color to reflect the underlying layer color by
decreasing the contrast. If the source color is pure black, the result color is the underlying color. In
photography, dodging is a technique used in a darkroom to decrease the exposure in particular areas of
the image. This brings out details in the shadows. Math formula is the same as used by SVG and
Gimp.
Difference - Subtracts the darker of the two constituent colors from the lighter. This is the same as
“Subtract” except that the absolute value is used. “Subtract” colors which would be black due to
clipping become visible instead. Differencing with white inverts the destination color. Differencing
with black produces no change. Math formula is the same as used by SVG and Gimp.
Hardlight - Multiplies or screens the colors, dependent on the source color value. If the source color is
lighter than 0.5, the destination is lightened as if it were screened. If the source color is darker than 0.5,
the destination is darkened, as if it were multiplied. The degree of lightening or darkening is
proportional to the difference between the source color and 0.5. If it is equal to 0.5 the destination is
unchanged. Using pure black or white produces black or white. The effect is similar to shining a harsh
spotlight on the destination. This mode is useful for creating the appearance of shadows on a layer.
You might use this mode to combine two photographs and obtain bright colors and sharp edges. Math
formula is the same as used by SVG and Gimp.
Softlight - Darkens or lightens the colors, dependent on the source color value. If the source color is
lighter than 0.5, the destination is lightened. If the source color is darker than 0.5, the destination is
darkened, as if it were burned in. The degree of darkening or lightening is proportional to the
difference between the source color and 0.5. If it is equal to 0.5, the destination is unchanged. Using
pure black or white produces a distinctly darker or lighter area, but does not result in pure black or
white. The effect is similar to shining a diffused spotlight on the destination. A layer with pure black
or white becomes markedly darker or lighter, but does not become pure black or white. Soft light is not
related to “Hard light” in anything but the name, but it does tend to make the edges softer and the
colors not so bright. Math formula is the same as used by Gimp; SVG formula differs.
Note: the Graphic Art group operates principally on color, and the others operate principally on alpha.

22. Titler Font Kerning
When using the Titler, kerning is applied in order to allow parts of a letter to go outside the standard
sized letter box. Kerning is the process of adjusting the space between individual letters. It is not the
same as proportional spacing. In kerning, a bounding box is allowed to overlay another bounding box.
The philosophy here is to aim at the ability to have boxes overlap in order to make the letters look more
visually appealing. Bounding box and escapement are tracked separately. In addition to adjusting
individual letter spacing, the program will also expand the render box in order to have any parts of the
letter extend outside the standard letter box. Kerning is applied to any and all fonts.

Screenshot shows how letters can be presented
without and with kerning. Note this is just an
example.

23. Edit Length
To set the length of an edit in the timeline, select the region which contains the edit to be modified.
Now select the menu bar Edit→Edit Length… menu item to activate the “edit length” popup. The
duration of the edit can be reset by entering the desired edit length in seconds. Pressing OK will
change all of the selected edits (in armed tracks) to the specified length.

24. Align Edits, Reverse Edits, and Shuffle Edits
The Align, Reverse, and Shuffle Edits functions are described below in each section with illustrative
screenshots on the following pages.

24.1 Align Edits
When loading media, a common problem is that the various audio/video tracks do not always have
exactly the same lengths. For example, you might load audio/video recordings from your camera and
be dismayed to see that the audio for each segment is a half second longer than the video. If you load a
large set of media clips by concatenation, the audio and video will be more skewed as more media is
loaded. This feature makes it possible to adjust the edits so the audio and/or video align by adjusting
the edits so that the track lengths are consistent. To use this feature, load all of the desired media and
select a region which contains all of the edits to be aligned in the timeline. Now select the menu bar
Edit→Align Edits menu item to operate the change. The topmost armed track is used as a template
reference, and the rest of the tracks are either cut or padded to align the edit boundaries. Besides
aligning audio with the video, you can also align video with the audio if the first armed track is audio.
The code performs the following algorithm:
Use the first armed track as the master track (it must contain data).
Collect the “edit project start times” on the selected master track.
Only edits that are 100% inside the selected area will be used.
Set all other tracks to match the “edit times” of the template track, either by putting in silence
or cutting the region to align the edits on the “edit times” of the master track.
The start time sequence of media and silence edits along the master track are collected as the target
alignment boundaries. All armed tracks after the master track are modified so that if the next edit edge
is too soon, it adds silence; if it is too late, edits are shortened or deleted past the point of the next target
alignment boundary time. Align Edits works best if there are an equal number of Video and Audio
sections. Also, it is better to use cuts instead of adding silence – if there are silence edits together, the
algorithm will combine the silence edits into a single edit and results may not be as desired.

24.2 Reverse Edits
The Reverse Edits can be useful to change the order of 2 edits in the case where you would like to put a
“teaser” section that occurred in the middle of a movie at the beginning instead, that is, reversed
positions. To operate, highlight completely the edit areas you would like reversed and then use the
pulldown Edit→Reverse Edits.

24.3 Shuffle Edits
The file pulldown Edit→Shuffle Edits will randomly exchange the location of the edits. This feature
can be used to change the order of the music like you would do from your MP4 player where you have
a playlist of your favorite music. Or perhaps you are creating an advertisement background, you can
randomly change it, thus the viewer sees a different order of scenes each time shown.

Screenshots below show the Before, the Highlighted Edits to be manipulated, and the After results fo
the Align Edits.

This After screenshot “adds silence” in the second section as noted in red letters.

Screenshot immediately below shows the selected/ highlighted area to which Edits will be applied.
Note the first edit is 00002, followed by 00003, 00004, and 00005 in that order.

Screenshot illustrating the results of executing “Reverse Edits”. Now you will see the reversed order of
00005, 00004, 00003, and last 00002.

Screenshot illustrating Shuffle Edits of the highlighted area of the first screenshot on the page. Note
the permutation of the fragments resulting in 00003 now being first, then 00005, 00002, and 00004 last.

25. Moving Clips or Media across Instances of Cinelerra
It is easy to copy/paste clips/media within a single instance of cinelerra or across multiple instances.
The reason this works is because there are hidden X cut butters and these are used to transmit EDL
from 1 instance to another.
Original methodology - copy from a source timeline and paste to a target timeline:
1)
2)
3)
4)

highlight a selection on the timeline in 1 instance of Cinelerra
use the Copy icon (shortcut c) on the main menu bar to copy into a buffer
move the pointer to another instance of Cinelerra and set an insertion point in its timeline
use the Paste icon (shortcut v) to paste the clip to that other instance selection target

New capabilities:
1) You can also Right Click on the Clips Resources window and use the “Paste Clip” option to paste the
Copy selection as a clip.
2) Similarly, by highlighting a clip in the Resources window and selecting its copy popup menu item
using the right mouse button, that copy buffer can now be loaded onto the timeline
New methodology – copy or paste a list of files in the Media Resources window:
1) create a highlighted selection of the desired media files in the media Resources window
2) right click on an unused portion of that window to bring up the popup menu
3) select the “Copy file list” item and a file list box will appear that contains the full path filenames
4) wipe the textbox using your standard copy/paste method to put the list of files in the copy buffer
5) in another cinelerra instance, choose the “Paste file list” of the media Resources window
6) paste the list of files, again using your standard paste method, into the new file list box; press OK
7) the status bar of the main window will be updated as the file list is loaded to the media folder (the
purpose of displaying the status is simply to show that the load is progressing normally.
Obviously this “Paste file list” feature means you can create a list of files outside of cinelerra using an
editor, wipe the names, and then use “Paste file list” to load them into the media Resources window.
It is important to note that in the steps above, the Operating System cut and paste capabilities are in use
for steps 4 and 6 as opposed to Cinelerra’s c/v shortcuts. Since the procedure varies among the distros,
you will have to adapt to your specific one. For example, a usage for ubuntu consists of:
4) Ctrl-c to copy the list of files; open gedit; Ctrl-v to paste the list of files into gedit
5) Ctrl-c or the standard way using the right click to copy this list from gedit
Ctrl-v paste the list of files into the new file list box, and press OK

In the screenshot to the right,
one instance of cinelerra has
6 items in the Media area
highlighted that were copied
to the file list. Note how it
includes the full pathname.

In this screenshot on another
instance of cinelerra, there
are only 2 items in the media
but the “Paste file list” box is
ready to have the items
inserted via the standard text
box paste method. When
that is done, the additional 6
media files will be available
on this other instance too.

26. Program Selection Support
Some kinds of media have “program” streams, like captured mpeg broadcast stream data. For example,
you may be able to “tune” to channel 9, but be able to see 9-1, 9-2, and 9-3 on your TV. If you open a
capture of this kind of media, all of the channels are present in the timeline. To select and view just one
program, you can use Alt-1 to select program 1, or Alt-2 to select program 2, etc. up to Alt-8. This will
remove all of the other unrelated tracks and reset the format. This feature can be used even if there is
only one program, by pressing Alt-1, and the effect will be to reset the session format to the parameters
from the media probe. Note that there may be several audio “programs” associated to a video stream;
for example, there may be dialog in another language or some kind of descriptive dialog. Since the
first associated audio is always selected, this may not produce the intended results.

Below are screenshots illustrating multiple program streams. The left screenshot is a partial main
Cinelerra window showing a pre-recorded broadcast TV media/audio stream with 3 programs plus
several associated audio tracks. The second screenshot of “Asset Detail” provides detailed information
on each of the streams obtained through executing the Info Details as explained in the section “Info
Asset Details”.

27. Realtime Priority Audio
Only experts might want to use this because it interferes with ordinary time-share scheduling and can
lock up the system. When this is enabled, audio gets the first shot and burns audio until audio lets go.
To explain, there are 2 kinds of scheduling, “time-sharing” which is the default, and “real time” where
the scheduled task must explicitly request scheduling to allow other tasks to execute. Time-share
interrupts when you use up your allocated time slice. Realtime priority audio will execute audio
decode until it finishes, which may may slow down other types of processing like video decoding.
Most decoders use a policy that video may be downsampled to accommodate scheduling, but will never
skip audio because it creates a much more obvious defect. This feature helps to make sure audio gets
priority over video during decode. To enable this feature, use Settings→Preferences→Playback A/B,
and check “Audio playback in real time priority (root only)”. Be sure to check apply in order for this
feature to take effect and as stated, you must be root.
Screenshot showing Playback A will be using real time priority.

28. Info Asset Details
Detailed information is now readily available on any loaded media of type mpeg or ffmpeg. This is
extremely helpful in determining what type of media it is, size, resolution, format, and type/number of
audio streams. It is especially useful for multiple program streams. You can now have the info
window popped on several of your assets simultaneously.
Screenshot below shows the “Detail” box to click on the left side and a simple, typical output in the
Asset Detail window on the right side. Also, note the highlighted media in the Resources window.

29. Multi-Pane Support
The main Cinelerra edit window holds the Track Canvas which can be divided into 4 panes of track
data: 1 or 2 vertical panes and/or 1 or 2 horizontal panes. To split the track, use the Window pulldown,
and then click on Split X or Split Y depending on how you wish to split the track. Alternatively, the
canvas pane types can be changed using keys <Ctrl-1> for toggle split horizontal or <Ctrl-2> for toggle
split vertical. Or the track can be split into panes by using the + widget in the lower right hand corner
of the track canvas. Once the track has been divided, you can use the + widget shortcut or the drag bars
to change the size of the panes.
Multi-Pane, or split screen, allows you to look at the first part of a movie at the same time as a part that
is a long ways away on the timeline which would have been off the screen. By having multiple panes,
you can see the 2 parts you want to look at simultaneously and drag/drop easily between the 2. Also,
the X pane split is extremely convenient for laptop users and computer monitors with small screens
since it can be used with horizontal scrolling with the mouse wheel + Ctrl-key. The Y-pane split makes
it easy to see 2 simultaneous drag and drop zones when you have lots of tracks.
Screenshot illustrating the 4 panes that have split the main Track Canvas.

30. Nesting
Nesting is a good way to see what media would look like without having to render it first since that is
done automatically. You can nest clips within nested clips at any level. It is IMPORTANT to note that
nesting will use certain additional resources and is meant to be used while working to test the results.

30.1 Nested Assets
A nested asset is an EDL session that embeds an existing EDL session, all tracks, all plugins, editing,
and effects into a media object that appears as one audio/video media object, no plugins, editing, or
effects. It is as if the existing EDL was rendered, and loaded in its place. This has several interesting
side effects. First, you don’t have to render the entire media file to see any portion. Second, it requires
no rendering compute time or storage. Third, it changes the precedence of the composer so that you get
more control over the projection and automation, so that the results can be sent into another rendering
step, not simply part of the current stack. It groups the plugin stack in much the same way that an
arithmetic expression is grouped by parenthesis.
The EDL session and the rendered output are visually equivalent. Nested assets allow for complex
grouping and stacking of effects, and makes media access much more flexible. This feature can be
used recursively, that is, any number of sessions may be stacked and referenced as an asset, as long as
all of the rendering resources are available. Nested assets are added to the timeline by using the
pulldown File→Load files… on the main menu and selecting the “Insertion strategy” of “Nest asset”.
The file will be pasted into the timeline over the current selection or at the insertion point.
It is somewhat important to note that nested assets and nested clips will have index files automatically
created. These index files can start to clutter up your $HOME/.bcast5 directory with files named
Nested_###.idx and you may want to periodically delete any index files which are no longer in use.

30.2 Nested Clips
It is also possible to create “clips” and convert them to “nested edl”. This is done by first creating a
clip using the standard cut, clipboard, paste, and/or edit panel buttons. Now, using the resources “clip”
folder, select a clip to be nested, and use the right mouse button to select a clip. This activates the clip
popup menu. Select the “Nest” menu item, and the clip will be converted to a “Nested: Clip”.
Conversely, you can select a “Nested: Clip”, use the “UnNest” menu item, and the clip will be reverted
to a “Clip”. This works similarly to the group / un-group editing features of many graphic design
editing programs, but in this case the groups are rendered compositions. They can not be proxied.

31. Keyframe Edit Params
Keyframes are blobs of parameters which affect the
media presentation. They are usually associated to a
point on the timeline and its parameters may vary
using different types of time dependent curves along
the timeline. Some kinds of keyframes work with
plugins. They are set using the various plugin “show
controls” (magnifying glass) icon on the plugin track.
It is possible to see all of the keyframe data in a raw
format using the Edit Params… popup menu item
which you will see when you right click the keyframe
icon on the timeline. The keyframe data is stored in
“xml” format, and the edit params feature allows you
to view and modify the xml data directly. This
normally should not be necessary since the plugin's
control gui displays the intended parameters, but in a
pinch this can let you view and specify just about
anything that can be specified in xml. There is no
validation checking of the modified data. Use this
only if you are confident you know what it does, and
be sure to backup the session before you make
changes.
Screenshot on the right shows the “Edit Params”
highlighted in bottom right corner. Once clicked, the
“Keyframe Parameters” window comes up (see top).

32. Color Coded Keyframe Curves/Different Operational Characteristics
The GG Infinity version of Cinelerra has some additional features that help to remove confusion from
multiple curves on the track canvas. They are most easily viewed from the pulldown menu of
Window→Show overlays but they will operate the same as when used from the View pulldown menu.
The most notable differences here are the “Color Coded Keyframe Curves” which have distinct colors
associated with each type for less confusion. By clicking button 1 on the “Color Ball” to the right of
any keyframe type in the “Show overlays” menu you have the ability to change the colors to whatever
works best for your video. The color ball changes made will be retained across sessions.
The more important new feature is that you can now click Button 3 on a keyframe box and a menu
pops up with the first menu item showing the keyframe type. The top menu item can be activated for
immediate access to update the automation keyframe value. Some keyframe types, which have values
that can be manipulated in another way than by dragging the color coded line, now show up with a
different colored background to make them more visible. Keep in mind that Zoombar ranges/values
must be set to appropriate values when working with specific keyframe types, such as Fade or Speed.
There is now a line separating the first 4 items, which are just non-automation type settable values as
opposed to “auto” keyframe types. There is also a line separating the last 3 items of Mode, Pan, and
Mask which display the symbols associated with each type. Their color is not changeable.
Screenshot below displays the Show overlays popup with all of its options and color coded types such
as yellow for Speed and blue for Camera Z. Upon clicking on the associated “color ball” to the right of
any keyframe type, for example “Fade” in this screenshot, the color wheel palette window pops up so
that you can manipulate the color as desired.

Screenshot below shows several color coded lines for different keyframes, as well as the popup menu
associated with the Fade keyframe obtained when the box was clicked. Note the first line of the popup
menu allowing you to bring up the Fade slider for manipulation in the next screenshot.
Screenshot below shows the slider bar for the Fade keyframe. It is in the same color as the color coded
keyframe type line which is the same color as in the “Show overlays” window.

Overlays Window Nuances:
The Overlays window is an alternative to the main track canvas View pulldown, and thus the order is
maintained to match each other. To make it easier to get a quick temporary look at a specific option,
there is a shortcut of Shift-LMB (left mouse button) that can be used as opposed to having to uncheck
everything that is currently checked and then having to recheck them on when done. Here is a list of
how they work. Keep in mind that if the Expander on the patchbay is enabled, you still see the track.
- Shift+LMB (left mouse button) in the Overlays Window on a checkbox will turn off all other
checkboxes except for the one you are on. Then this named box will have outline for a "hot" spot.
- Shift+LMB on this "hot" spot will return to "cool" of the previous settings with all of the previous
checkboxes checked again.
- Shift+LMB on a non-"hot" spot will simply check or uncheck a box and there is no previous state.
- This all works in conjunction with the View pulldown menu which, of course, has no hot spots.
- Caveat #1 - Shift+LMB on the top 4 choices of Assets, Titles, Transitions, Plugin Keyframes will turn
off all of the checkboxes below because it makes sense to do so.
- Caveat #2 - Shift+LMB on the Autos will not turn off Assets, Titles, Transitions, or Plugin Keyframes
because you need to be able to see what is going on.
- Caveat #3 - XYZ toggle on/off of Camera and Projector are not affected.
Original Settings – cool spot

Note Titles box hot spot

Cam/Proj XYZ toggle to fine tune

33. Playback 5.1→2 Driver Downmix
Driver downmix mixes 5.1 down to stereo on the output device side. This is different from the
patchbay and menubar functions which reset the pan/mix levels of the input channels. In this way, you
can render 5.1 media, and use stereo speakers to listen in the same session setup. This downmix only
occurs if the playback is 5.1 (6 channels), the device config is stereo (2 channels), and the mode is set
by checking “Map 5.1→2” in the “Audio Out” section of Settings→Preferences→Playback A/B.

34. Multi-screen / Playback Configuration
Cinelerra-GG supports 2 separate preferences for the playback configuration. Cinelerra can be
operated in a single or dual screen configuration, both by using Xinerama or dual screen configuration
of X windows. It will take some setup using Xconfig to make this work.
The Settings→Preferences menu has “Playback A and Playback B” tabs. The target display and audio
device configuration can be separate, to support up to 2 display and/or audio device stations. The
active configuration displays an asterisk (*) in its selection tab and the selected tab will be made active
when OK is pressed. For example: you may have a dual screen monitor system with the left screen
showing the cinelerra main window and the right screen showing the composer. Another setup might
use a monitor for the left screen and an HDTV as the right screen displaying the composer. When a
playback configuration is selected, the audio/video device configuration is switched to the playback
selection. The active playback setup can be changed through use of the menu pulldown of
Settings→Preferences or via the remote control menu selection (see the section “Remote Control for
DVB” for more detail).
Yes, you can watch TV on cinelerra instead of cinelerra on TV.

Screenshot showing partial window of *Playback A selected and the second tab for Playback B. Note
that on the bottom right of the window, “Default B Display:” is set to :0.1, representing the setting for
Screen 1. On the unseen “Playback A” window, the “Default A Display:” will be set to :0.0 meaning
for Screen 0. Otherwise, the default would be nothing there or just <empty>.

35. Simple Animation - Filescene using Festival
This functionality was added to cinelerra by the original author to create simple animation. The file
type for this animation is “Scene”.
To get started making a simple animated movie copy from the directory: <cin_path>/cinelerra/tests the
text2movie and text2movie.xml. You can see what this does via File→Load… text2movie.xml. The
file text2movie acts like a normal asset, except changes to it are immediately reflected on the timeline
without reloading and the length is infinite. You can just edit the text2movie file to change the
script. If the length of the movie increases, drag the right edit handle to extend the edit or use the
pulldown Edit->edit length. There is one audio channel created for every character. The frame rate,
sample rate, frame size, and camera angles are fixed. To see these values, right click on the asset and
look at the “Asset info”.
Currently the functionality that is implemented focuses on dialog between two people. The models are
defined in model files saved in Cinelerra's executable directory (for example, /opt/cinelerra/models).
The character model and voice is selected separately in the script. The model files have the same name
that appears in the script and are usually saved in the directory the script is in, but there is a defined
search path, if not. You can create new models for the script without affecting the entire system. These
models define the total size of the model along with the images used – the model images are 2D png
images because all the animations are baked. Since there is no 3D renderer, no custom movement is
supported.
There are currently 2 actions implemented:
1) Character2 can cut off character1 if character1's dialog ends in “...”.
2) Inserting “[pause]” anywhere causes the character to pause. This is useful for adjusting the
timing of dialog.
This is “simple” animation so you can expect speech synthesis not to be that good. And you will have
to adjust punctuation and spelling based on the sound. Since the dialog is rendered on-demand, there is
a delay when each character starts to speak but you can split dialog into shorter blocks to reduce the
delay.

36. “Free” Dragging Plugins
In order to explain how to use the “free drag of plugins”, a short explanation is provided here first. A
timeline region can contain a plugin stack. The plugins are normally applied by first selecting a
timeline region, and then dragging a plugin from the resources window and dropping it into the
selected timeline region. A plugin title bar will appear below the track, which has two buttons. The
first title bar button will “show controls” (magnifying glass) and the second is on/off. The plugin
position can be changed by using the “drag and drop editing mode” (the arrow icon that is positioned
approximately under the video pulldown on the main menu bar) and then selecting a plugin title bar
with the cursor for a drag and drop operation. The plugin outline will be drawn over a targetable
timeline region, and the plugin can be re-positioned into any plugin track – this is “free drag”!
Screenshot showing 2 plugins, one have already been dragged, and the other Deinterlace in the process
of being dragged. Note the gold-colored arrow which enables “allow drag and drop editing mode”.

37. Some Information about Plugins, Icons, and Usage
(credit to Sam for the Cinfinity plugins icon set Creative Common By https://creativecommons.org/licenses/by/3.0/ )
There is a choice of plugin icons which can be displayed. In Settings→Preferences→Appearance tab,
there is a pulldown for “Plugin icons” where the user can choose between the original default icons or
smoother, or the modernized set as credited above, cinfinity. Note that when you change the plugin
icons, your session will automatically save the backup, stop, restart, and reload that backup.

Choices: ^

Cinfinity icons ^

37.0.1 How to see Info on a Plugin
(credit to Wpfilmmaker for all of the Ffmpeg info description lines taken from his contributed pdf).
To get a short one or a few lines description of a plugin, right click on that plugin in the Resources
window and when the popup menu appears, select Info. Some of the plugins may not have any
description included. An example screenshot is next.

37.0.2 Delete Plugins to save Resources Window Space or whatever
Maybe you just don't ever use certain plugins or would prefer to only find the ones that are useful to
you. To save space in the Resources Window so you don't have to scroll to find the plugins you want,
a feature to delete others is available. The plugins will be PERMANENTLY deleted, but only until you
rebuild or download a new set of Cinelerra binaries. To do this, highlight the plugin you no longer
want in the Resources window then keypress Ctrl-Shift-delete. A small window will come up allowing
you to change your mind and red-X out or chk-OK to “remove plugin”. This feature may come in
handy if you have personnel working on media for you and you only want them to exercise certain
functions. Or maybe you can't remember which is the “good” deinterlace plugin out of the available 5
or so and want to delete the extras so as not to be confused. If you have a System install, you will have
to be root for this function to be enabled. The ffmpeg and ladspa plugins can not be deleted in this
manner but, of course, you can always turn them off from view by clicking on Visibility and
unchecking them.

Screencast demonstrating the use of removing an unwanted plugin.

37.0.3 Updatable Icon Image Support
When running cinelerra, builtin icons are loaded before the program starts. Png files in the path
<cin_plugin>/plugins/picon/picon_set_name are searched before the images loaded into memory.
Override icon.png files must be put into the <cin_plugin>/plugins/picon/picon_set_name directory.
There are currently 3 sets of icons and their directory names are cinfinity (the default), original (the
long-time original set), and smoother (generally was in use by some of the themes). For example, to
replace the cinfinity icon of “blue banana” with a “red apple” instead, create your .png file as desired,
and replace the file in <target_directory>/bin/plugins/picon/cinfinity/bluebanana.png.
For most User installs, the <plugin_name>.png file will be located at:
<cinlib_path>/bin/plugins/picon/cinfinity (or original or smoother)
For some System installs, the files will be located at:
/usr/lib/cin/plugins/picon/cinfinity (or original or smoother) (ubuntu distros)
/usr/lib64/cin/plugins/picon/cinfinity (or original or smoother) (Leap distro)

37.0.4 Details on where to put Plugin Icons
In order to make the icons available to all themes, which would thus be the default when no themespecific icon is available, put the png file in the <cinlib_path>/bin/plugins/picon/cinfinity directory (or
original or smoother).
The Cinelerra program looks for a plugin icon in 2 places:
1.) First, it tries to find a png file in <cinlib>/plugins/picon/cinfinity or original or smoother directory.
2.) If there is no corresponding .png file for a plugin, the program uses a built-in default:
- ordinary plugins use 3 vertical color bars as a default;

- ffmpeg plugins use the words ffmpeg on blue-colored background as a default icon;
- ladspa plugins use a green-colored audio wave for a default.
Keep in mind these points for newly created plugin icons:
- All included icon images become part of open source, in the public domain, and not proprietary.
- The preferred format is 52 x 52, 8-bit/color RGB or RGBA, non-interlaced.
- Since plugin icons are used by different themes, it is recommended that a transparent background be
used. Otherwise some color background that looks good for one theme may not for another.
- In order to test a new icon, you have to have write permission in the <cinlib_path>/plugins directory
so you may have to become the root user to copy the .png file to the correct location.
- If there is currently no theme-specific .png files present, it may be necessary to first create the theme
directory in <cinlib_path>plugins as <theme_name> in order to put the .png files in that subdirectory.
- Make sure that the ownership and file permissions match the existing directory and files.
- All ffmpeg icons must begin with ff_<plugin_name>.png (Resources window title will still be F_…)
- For ladspa, check in the <cin_config> directory ($HOME/.bcast5 normally) and look for the text file
$HOME/.bcast5/ladspa_plugins... for the names of the ladspa libraries which correspond to plugin
names where the needed name is the basename of the .so file. For example phasers_1217.so would
need to have a phasers_1217.png file. There may be multiple plugins in a single “so” file which
means that you can only have 1 icon to represent all of the plugins in that file; again as in phasers.
- Once you have placed the .png file in the correct spot, you will have to restart Cinelerra to test it.
- To submit your .png file for inclusion into a cinelerra branch/version for all to enjoy, it is best to
upload it to any datafilehost and notify the community via email with any informative documentation.

37.0.5 Example of new Plugin Icon Testing
For a simple test just copy an existing <plugin_name>.png file into the cinfinity directory with the
name bluebanana.png to write over the existing file. This icon will now show up in cinelerra and still
execute the Blue Banana function.
For an ffmpeg plugin, create ff_loop.png and copy it to <cinlib_path>/plugins/picon/original. This icon
will show up in cinelerra if original is selected and execute the F_loop function.
For a ladspa plugin, the text line in $HOME/.bcast5/ladspa_plugins… as seen below:
2 "am_pitchshift_1433.so" "AM pitchshifter" 1504922321 0 1 0 0 1 0 1 0 1 0 0
indicates that you would create the icon <cinlib_path>/plugins/picon/cinfinity/am_pitchshift_1433.png
For your own personal plugins, you can create a directory on your system and put any plugin png files
you like into that directory. For example, if you want a specialized picon for F_aeval, create a picon
named ff_aeval.png in <cinlib_path>/plugins/picon/yournamehere.
cd <cinlib>/plugins
mkdir -p picon/yournamehere
ls -l picon/*
cp yourpicon.png ff_aeval.png

! go to the correct directory
! create subdirectory if does not exist
! list the picon directories
! check for existence (and permissions)
! Copy your example .png file

Restart cin by changing Settings→Preferences→Appearance & in Plugins icons choose a directory.

37.0.6 Saved Plugin Presets
Presets and Factory Presets for Plugin settings are now combined with the Preset Keyframe Parameters
allowing you to choose, apply, delete, and edit your own Presets which can then be easily saved in the
file $HOME/.bcast5/Cinelerra_presets. In addition to your own saved presets, there are automatically
available Factory presets for some plugins; for example the Lens video plugin. The Factory presets are
preceded by an asterisk (*) and can not be modified permanently.
Note: this is directly changing a keyframe object, with almost no validation. If you enter bad data, it
could produce errors and/or program failure. Most of the data is obvious and safe to change if you are
familiar with the plugin interface.
A Presets button on the plugin bar to the left of the Controls and On/Off button
allows for quick access to this feature.

Screencast to the right
shows 4 Factory presets as
preceded by an *.
A user preset named Green.

Textbox to type in the title
for the chosen preset or
name for a new preset.
Use the Delete, Save or
Apply button for operation.

37.0.7 Explanation of Color in Audio Waveform Icons
In the Resources Media window, any recognizable audio files will be displayed with an audio icon
(a-icon) with the following distinguishing characteristics:
1) The waveform is displayed in the Resource window as "yellow" for the 2nd audio track with "green"
for the 1st audio track which is drawn over the yellow waveform.
2) There is a colored bar on the top of each a-icon where the color is based on the Color Spectrum; the
smaller the time duration, the redder the color (left side of the spectrum). Then as the time duration
goes up, the color goes up so that you will go to green, then yellow, then blue, then really dark blue,
and then purple for very long audio files (the right side of the color spectrum).
3) Note that the horizontal line in the middle of the a-icon is yellow/red representing the 2 audio tracks
and will only show as red for mono single audio track.
The waveform is only the first second and not the entire audio as it would all be indistinguishable when
a long duration waveform had to be squished into a little, bitty box.
Resources creencast below shows color variations based on duration. Red shortest; purple longest.

37.0.8 Expanders for Plugin Subtrees in the Resources Window
To accentuate a set of common plugins, there are expander arrows on the left side of the Resources
window. You will see these expanders only when in “Display text” mode not icon mode. Cinelerra’s
default setup is in the file $CIN_DAT/expanders.txt but if the user wants their own specific setup and if
the file in $HOME/.bcast5/expanders.txt exists, it will take precedence. If there are recommendations
for other relevant categories, they can be added. The subtree structure is applicable to any of the Video
Effects/Transitions or Audio Effects/Transitions. You can not sort once an expansion is in effect.
Screencast of the expander arrows showing pertinent subtrees.

Expanded→

7 Options->

Expanded→
Coloring→
Motion →
Blur Options

The expanders.txt file has very specific requirements. The most specific is that there are no blanks –
you must use tabs only. A # (pound sign) can be used in column 1 to indicate a comment. Here is a
short example:
Video Effects
- Color_Correction
Blue Banana
#
Color 3 Way
Color Balance
Audio Effects
- Calf
- Instruments / Generators
L2_Calf Organ
L2_Calf Monosynth
L2_Calf Fluidsynth

37.1 FFmpeg Video and Audio Plugins (credit to WPfilmmaker)
Cinelerra-GG currently comes with 102 of the video plugins and 45 of the audio plugins developed by
the FFmpeg project (ffmpeg.org). As of May 2017, these plugins do not have a GUI with buttons like
the rest of plugins, therefore to change settings it is necessary to change the variables by hand.
The screenshot below is what an FFmpeg video plugin looks like; example is F_chromakey.

The screenshot below is what an FFmpeg audio plugin looks like; example below is F_adelay):

FFmpeg Icons and How to Replace
Currently FFmpeg video and audio plugins all use one of the default icons as shown below depending
on which picons set is in effect for your Settings→Preferences Appearance tab.
Video

Audio

If you want to replace the icon with a more descriptive picture, see a previous section on “Updatable
Icon Image Support” and “Details on where to put Plugin Icons”.

How to Use FFmpeg Video/Audio Plugins
Simply drag and drop the plugin on the timeline. To enter the settings option, once you have added the
plugin to the timeline, right click on the reddish-brownish-colored bar that appears below the timeline
track of the plugin and highlight the “show” option. Alternatively, you can left click the magnifying
glass icon that appears on the right side of the colored bar. For the audio plugins, if the plugin is not
working at all, you will hear a trouble tone waveform to indicate that.
If the value is unspecified, it uses default. If you specify the default, the value becomes unspecified
which means that nothing gewts sent into the program.

Description of FFmpeg Video Plugins
F_atadenoise: Apply an Adaptive Temporal Averaging Denoiser.
F_avgblur: Apply average blur filter.
F_bbox: Compute bounding box for each frame.
F_bench: Benchmarks part of a filtergraph.
F_bitplaneoise: Measure bit plane noise.
F_blackdetect: Detect video intervals that are (almost) black.
F_blackframe: Detect frames that are (almost) black.
F_boxblur: Blurs the input video. Through the settings you are able to change the power and the
radius of the boxblur applied to luma, chroma and alpha.
F_bwdif: Deinterlaces the input image.
F_chromakey: Turns a certain color into transparency. Operates on YUV colors.
F_ciescope: Video CIE scope.
F_color: Provide an uniformly colored input.
F_colorbalance: Adjusts the color balance.
F_colorchannelmixer: Adjusts colors by mixing color channels.
F_colorkey: Turns a certain color into transparency. Operates on RGB colors.
F_colorlevels: Adjusts the color levels.
F_colormatrix: Converts color matrix.
F_cover_rect: Find and cover a user specified object.
F_crop: Crops the input video.
F_cropdetect: Auto-detect crop size
F_curves: Adjust components curves.
F_datascope: Video data analysis.
F_dctdnoiz: Denoise frames using 2D DCT.
F_deband: Debands video.

F_deflate: Applies deflate effect.
F_dejudder: Removes judder produced by pullup.
F_delogo: Removes logo from input video. When using this plugin a green box will appear on the
screen, once the logo is inside the box the plugin will hide it. Through the settings you can specify
the position of the logo to hide (on a X-Y axis) and the size of the box (so you can adjust it to the
size of the logo).
F_deshake: Stabilizes shaky video.
F_dilation: Applies dilation effect.
F_drawbox: Draws a colored box on the input video. Through the settings you are able to choose the
position of the box on X/Y coordinates, the size of the box, the color and the thickness of the lines.
F_drawgraph: Draw a graph using input video metadata.
F_drawgrid: Draws a colored grid on the input video. Through the settings you can select the
horizontal and the vertical offset, set the width and height of the grid cell, and the color and
thickness of the lines. When using the Presets button on the plugin bar on the timeline, you can
choose a preset of “rule_of_thirds”. The Rule of Thirds is a 3×3 grid on top of an image which is
commonly used in filmmaking. The concept is that you align the key elements in the image using
this grid at the intersection of the lines or along and within the vertical/horizontal lines.
F_edgedetect: Detects and draws edge.
F_elbg: Apply posterize effect, using the ELBG algorithm.
F_entropy: Measure video frames entropy.
F_eq: Adjusts brightness, contrast, gamma and saturation.
F_erosion: Applies erosion effect.
F_fade: Fade in/out input video.
F_fftfilt: Apply arbitrary expressions to pixels in frequency domain.
F_field: Extract a field from the input video.
F_fieldorder: Set the field order.
F_fillborders: Fill borders of the input video.
F_format: Convert the input video to one of the specified pixel formats.
F_framerate: Upsamples or downsamples progressive source between specified frame rates.
F_fspp: Applies Fast Simple Post-processing filter.
F_gblur: Apply Gaussian Blur filter.
F_gradfun: Debands video quickly using gradients.
F_hflip: Horizontally flips the input video.
F_histeq: Applies global color histogram equalization.
F_histogram: Computes and draws a histogram.
F_hqdn3d: Applies a High Quality 3D Denoiser.
F_hqx: Scales the input by 2, 3 or 4 using the hq*x magnification algorithm.
F_hue: Adjust the hue and saturation of the input video.
F_idet: Interlace detect Filter.
F_il: Deinterleaves or interleaves fields.
F_inflate: Applies inflate effect.
F_interlace: Convert progressive video into interlaced.
F_kerndeint: Applies kernel deinterlacing to the input.
F_lenscorrection: Rectifies the image by correcting for lens distortion.
F_life: Generate a life pattern.
F_loop: Loops video frames.
F_lut: Compute and apply a lookup table to the RGB/YUV input video.
F_lut3d: Apply a 3D LUT (lookup table) to an input video. LUTs are used to map one color space to

another and are frequently supplied with high-end cameras as a .cube file to use as input.
F_lutrgb: Compute and apply a lookup table to the RGB input video.
F_lutyuv: Combine and apply a lookup table to the YUV input video.
F_mandelbrot: Render a Mandelbrot fractal.
F_mcdeint: Applies motion compensating deinterlacing.
F_mestimate: Generate motion vectors.
F_mpdecimate: Remove near-duplicate frames.
F_mptestsrc: Generate various test pattern.
F_negate: Negates input video.
F_nlmeans: Non-local means denoiser. Example usage is for recovery of VHS tapes which look bad.
F_noise: Adds noise to the video. Through the settings you can select the variables of the noise
(strength, flag and seed).
F_normalize: Normalize RGB video.
F_owdenoise: Denoises using wavelets.
F_pad: Add paddings to the input image, and place the original input at the provided x, y coordinates.
F_perms: Set permissions for the output video frame.
F_perspective: Corrects the perspective of video.
F_phase: Phases shift fields.
F_pp: Filters video using libpostproc.
F_pp7: Applies Postprocessing 7 filter.
F_prewitt: Apply prewitt operator.
F_readeia608: Read EIA-608 Closed Caption codes from input video & write to frame metadata.
F_readvitc: Reads vertical interval timecode and writes it to frame metadata.
F_realtime: Slows down filtering to match realtime.
F_removegrain: Removes grain.
F_repeatfields: Hard repeat fields based on MPEG repeat field flag.
F_rgbtestsrc: Generate RGB test pattern.
F_rotate: Rotates the input image.
F_sab: Applies shape adaptive blur.
F_scale: Scale the input video size and/or convert the image format.
F_separatefields: Split input video frames into fields.
F_setrange: Force color range for the output video frame.
F_showinfo: Show textual information for each video frame.
F_showpalette: Display frame palette.
F_shuffleframes: Shuffles video frames.
F_shuffleplanes: Shuffles video planes.
F_signalstats: Separates statistics from video analysis.
F_smartblur: Blurs the input video without impacting the outlines. Through the settings you can
select the radius, the strength and the threshold of luma and chroma.
F_sobel: Applies sobel operator.
F_spp: Applies a simple post processing filter.
F_stereo3d: Converts video stereoscopic 3D view.
F_super2xsai: Scales the input by 2x using the Super2xSal pixel art algorithm.
F_swaprect: Swaps 2 rectangular objects in video.
F_swapuv: Swaps U and V components.
F_tblend: Blend successive frames.
F_testsrc: Generate test pattern.
F_testsrc2: Generate another test pattern.
F_tile: Tile several successive frames together.

F_tinterlace: Performs temporal field interlacing.
F_transpose: Transposes input video.
F_unsharp: Sharpen or blur the input videlo.
F_uspp: Applies Ultra Simple/Slow Post-processing filter.
F_vaguedenoiser: Applies a Wavelet based Denoiser.
F_vectorscope: Video vectorscope.
F_vflip: Flips the input video vertically.
F_vfrdet: Variable frame rate detect filter.
F_vignette: Makes or reverses a vignette effect. Through the settings you can set the circle center
position on a X-Y axis,choose the angle, the aspect and set the dithering of the vignette.
F_w3dif: Applies Martin Weston three field deinterlace.
F_waveform: Video waveform monitor.
F_weave: Weaves input video fields into frames.
F_xbr: Scales the input using xBR algorithm.
F_yadif: Deinterlaces the input image.
F_yuvtestsrc: Generate YUV test pattern.
F_zoompan: Applies Zoom & Pan effect.

Description of FFmpeg Audio Plugins
F_abench: Benchmark part of a filtergraph.
F_acompressor: Audio compressor.
F_acontrast: Simple audio dynamic range compression/expansion filter.
F_acrusher: Reduces audio bit resolution.
F_adelay: Delays one or more audio channels.
F_aecho: Adds echoing to the audio.
F_aemphasis: Audio emphasis.
F_aeval: Filters audio signal according to a specific expression.
F_afade: Fades in/out input audio.
F_format: Convert the input audio to one of he specified formats.
F_agate: Audio gate.
F_aiir: Apply infinite Impulse Response filter with supplied coefficients.
F_allpass: Applies a two-pole all-pass filter.
F_aloop: Loops audio samples.
F_anoisesrc: Generates a noise audio signal.
F_aperms: Set permissions for the output audio frame.
F_aphaser: Adds a phasing effect to the audio.
F_arealtime: Slows down filtering to match realtime.
F_aresample: Resamples audio data.
F_asetrate: Change the sample rate without altering the data.
F_astats: Shows time domain statistics about audio frames
F_atempo: Adjusts audio tempo.
F_atrim: Pick one continuous section from the input, drop the rest.
F_bandpass: Applies a two-pole Butterworth band-pass filter.
F_bandreject: Applies a two-pole Butterworth band-reject filter.
F_bass: Boosts or cuts lower frequencies.
F_biquad: Applies a biquad IIR filter with the given coefficents.

F_chorus: Adds a chorus effect to the audio.
F_compand: Compresses or expands audio dynamic range.
F_compensationdelay: audio compensation delay line.
F_crystalizer: Simple Expand Audio Dynamic Range filter.
F_dcshift: Applies a DC shift to the audio.
F_drmeter: Measure audio dynamic range where setting window length in seconds is used to split
audio into segments of equal length.
F_dyaudnorm: Dynamic Audio Normalizer. When using this plugin, be sure to “attach effect” to all
audio tracks by dragging the plugin to the 1st audio track and then right mouse clicking all subsequent
audio tracks which brings up an menu. Highlight the effect shown in the middle section and click OK.
F_earwax: Widens the stereo image. When using this plugin, be sure to “attach effect” to all audio
tracks by dragging the plugin to the 1st audio track and then right mouse clicking all subsequent audio
tracks which brings up an menu. Highlight the effect shown in the middle section and click OK.
F_equalizer: Applies two-pole peaking equalization (EQ) filter.
F_extrastereo: Increases difference between stereo audio channels. When using this plugin, be sure
to “attach effect” to all audio tracks by dragging the plugin to the 1st audio track and then right mouse
clicking all subsequent audio tracks which brings up an menu. Highlight the effect shown in the
middle section and click OK.
F_flanger: Applies a flanging effect to the audio.
F_hilbert: Generate a Hilbert transform FIR coefficients.
F_highpass: Applies a high-pass filter with 3dB point frequency.
F_loudnorm: EBU R128 loudness normalization.
F_lowpass: Applies a low-pass filter with 3dB point frequency.
F_mcompand: Multiband Compress or expand audiodynamic range. The input audio is divided into
bands which is like the crossover of a loudspeaker, resulting in flat frequency response when absent
compander action.
F_silenceremove: Removes silence.
F_sine: Generate sine wave audio signal.
F_stereotools: Applies various stereo tools. When using this plugin, be sure to “attach effect” to all
audio tracks by dragging the plugin to the 1st audio track and then right mouse clicking all subsequent
audio tracks which brings up an menu. Highlight the effect shown in the middle section and click OK.
F_stereowiden: Applies stereo widening effect. When using this plugin, be sure to “attach effect” to
all audio tracks by dragging the plugin to the 1st audio track and then right mouse clicking all
subsequent audio tracks which brings up an menu. Highlight the effect shown in the middle section
and click OK.
F_treble: Boosts or cuts upper frequencies.
F_tremolo: Applies tremolo effect.
F_vibrato: Applies vibrato effect.
F_volume: Change input volume.
F_volumedetect: Detect audio volume.

37.2 Motion51 Stabilization
Motion51 Plugin

- compensates for unwanted motion and stabilizes the picture.

The Motion51 Plugin simplifies motion stabilization so that without a lot of tweaking you can easily
achieve reasonable results, either by using the defaults or varying a single parameter. Since the motion
in every clip is specific, there are some additional parameters useful to adjust the settings accordingly.

Alternatively, the MotionCV and MotionHV plugins can still be used as the originals, if more control
over specific parameters is needed. The Motion51 plugin uses different methods for tracking than the
other motion plugins. Motion Stabilization is very useful if you have jittery video, for example when
taken from a car window, or while walking.
The better results require more samples. Setting the sample set size is probably the most important
setup change. Also, when computing motion compensation, the entire history of the image motion is
important, and so it is desirable to enable the playback setting “play every frame” in order to get good
results. When every frame has to be processed, it can be time-consuming. Reasonable results are
possible with small sample sets. After setup, the sample size can be increased to produce a high quality
rendered result.
Description of what the program is doing :
The motion is detected by “sampling” the video image in a circular field. This size and placement of
the sample region defaults to most of the image area. When the “draw vectors” feature is enabled, the
outer line trace encloses the searched region. The dotted circles define the target pixel set as the
reference sample. The image is sampled using the circle pattern in a grid search. The best match is

used to find the center and amount of rotation to transform the current image so that the reference area
motion is canceled.
The amount of sampling does not significantly change for smaller or larger search areas. This means
that a wide area can be searched just as easily as smaller areas. The main parameter which determines
how “hard” it looks at the image is the “samples” parameter. It represents the number of possible
rotations, as well as the search precision. More samples mean more precision, and less jitter, but the
program will run more slowly.

Figure 1 Note the faint
circles shown in
in the center, the
oval outside area
boundary, and the
line that is part of
a box in the color
orange.

Figure 2 –
Display of the
Motion51 plugin
window with its
default options set.
The Samples box
at the top is most
often the only
parameter that you
may want to vary.

Program Parameters Description follows:
X11-OpenGL setting can speed up the computation significantly in some cases when hardware
OpenGL is available.
Samples is the number of pixels which the software will examine to stabilize the picture. The sample
set is arranged in 4 equal concentric circular sets. Each sample “dot” represents content and position
for a pattern matching test. Setting the samples to larger values improves the match by adding lots of
placement possibilities. The samples/pixels that will be utilized are distributed throughout the selected
area – this is seen within the circles drawn when “Draw Vectors” is enabled. See Figure 1.
Draw vectors demonstrates the search operation of motion stabilization. When enabled, the outer
search boundary (oval), the search grid area (rectangle), and the reference sample (circles) are visible.
4 concentric circles show the reference sample set (target). You will also see an arrow in the center of
the circle which shows each image displacement from frame to frame.
When you render the video using the motion plugin, these dots/lines/circles are drawn into the rendered
output. Draw vectors helps to visualize the meaning of the parameters to aid in setup. You should
disable “Draw Vectors” before the final rendering.
Sample Radius is the radius of a circle that denotes the area of the sample locations. It is expressed as
a percentage of the smallest image edge. For example, if it is set to 50%, then the circle will overlap
about ½ of the image. This does not change the number of samples. It does change the area from
where the samples are gathered. If you have “Draw vectors” on, you can see the faint outline of a
circle used for the radius.
Center X/Y is the center position of the sample circle, as a percentage of image width and height.
This is useful to reset the reference focal point in cases where the important feature target is off-center.
When both X and Y are set to 50%, the samples will be used from around the center of the video.
Search W/H determines the width and height of the rectangular area used for the grid pattern search.
Samples are taken by moving the center of the circles in a grid pattern.
Shaking refers to image translation.
Horiz/Vert shake limit determines translation constraints. If the motion determined by the search
exceeds the limit, it is clipped to a value that is at the limit boundary. For example, if the match
indicates that the motion is 60% off the reference target, but the limit is 50%, then the actual translation
used will be limited to only 50%.
Shake fade determines how fast the translation cancellation fades away, and the image resettles to its
actual appearance. Every frame that is processed accumulates the motion of the past. The amount of
the past motion which is applied is reduced by the fading factor. The current match is then added to the
fading past motion history. Fading works fast. It is applied every frame. So if fade is 10%, and no
new motion occurs in the input, the history will be 90%, 81%, 73%, 66%,… and in 30 frames only
4.2% of the past motion will be present in the effect. Fading insures that the image will eventually
settle re-centered when the image motion ends.

Twisting refers to image rotation.
Twist limit determines the rotation constraints. If the rotation determined by the search exceeds the
limit, it is clipped to the limit boundary. Its operation is similar to the shake limits.
Twist fade determines how fast the rotation cancellation fades away, and the image resettles to its
actual appearance. Its operation is similar to the shake fade.
Enable Tracking caches the search results in a file so that subsequent playback does not have to be
recalculated. When tracking is enabled, before a frame is processed the frame number is used to look
for cached results. If cache data is available, it is used. If no data is available, the frame is processed
by the motion tracking search, and the results are added to the cache file. If tracking is not enabled, the
data is always sourced from the motion tracking search and the tracking file is not updated.
Tracking file is the name of the file which will contain the calculated values to be saved. Note that the
default is /tmp/motion51 which can be hazardous, since a system crash or a reboot can delete /tmp files.
Reset Defaults button is used to revert to the initial defaults built into the program.
Reset Tracking will delete the current Tracking file and disables tracking so that any previously
calculated values are no longer available. However, because motion stabilization can often be cpu
intensive, if the default file already exists, it will create a file name from the loaded asset.
Play Every Frame status shows if you are “Currently using: Play every frame” or “For best results, set
play every frame”. This can be set in Settings→Preferences, the Playback Tab in the “Video out”
section.

37.3 Echo and Echo Cancel
Echo is reflection of sound. This plugin could be used to add echoing to video of your canyon hike.
The 3 dials shown here are used to vary these attributes.
Level represents the volume adjustment.
Atten is attenuation which is a general term that refers to any
reduction in the echo reflection. Sometimes called loss,
attenuation is a natural consequence of signal transmission
over long distances.
Offset is the lag in the attenuated echo signal. Offset means adding a DC level to a signal. It offsets the
signal up or down in a DC sense without changing the size of the AC part of the signal. When you add
an audio clip to the Timeline, the clip plays back from the beginning of the source audio file. The point
in the audio file where the clip starts playing is called the offset. By default, a clip’s offset is zero, the
beginning of the source audio file. You can change the offset so that the clip starts playing from a later
point in the source audio file.

EchoCancel is the process of removing echos from audio in order to improve the quality. Echo
cancel may be needed because an audio recording was done in a room that led to echo generation or
there was some kind of unwanted feedback. There are many controls for the EchoCancel plugin which

are defined here. However, the first thing you will see when you bring up the plugin, is the top portion
that is black which will show a + in the middle when you mouse over it. Once you start playing audio,
you will see the cepstrum spectral data inside the window. A cepstrum results from taking the inverse
Fourier transform (IFT) of the logarithm of the estimated spectrum of a signal. It is used to identify the
period of the echo in the audio. It is recommended to just set the “Mode” to “On” but the below
defined parameters can be utilized by professionals.
On/Off Boxes
Normalize: audio normalization adds variable amounts of gain to an audio recording to bring the
average or peak amplitude to a target level (the normal amount), on an ongoing buffer by buffer basis.
This is to make the cepstrum graphical data appear between 0 and 1. Checkmark appears if On.
Dial Parameters
Level: scale factor used to draw the cepstrum output when “normalize” is not in effect.
History: number of previous cepstrum outputs redrawn as fading graphical data.
X Zoom: X axis scale factor to magnify low frequency cepstrum graphical output.
Damp: echo envelope decay factor used to smooth the cepstrum/correlation data.
Peaks: number of maximal envelope values used in the echo gain calculation.
Cutoff Hz: low frequency cutoff value to prevent beat frequency (heterodyne) echo canceling.
Down Arrow Boxes
Mode: MAN, Off, or On. When Off is selected, the plugin is not active. When MAN is used, the only
one peak is used for the echo gain envelope. It is set by pressing mouse button 1 in the ceptstrum
graphical output. The Gain and Offset are updated as the pointer drag operation resets the indicated
gain and offset values. When On is selected, the echo gain envelope is automatically calculated by
cepstrum and auto-correlation of the input audio in the last “window” size audio samples.
Window size: parameter can be set to Default, 1024, 2048, … doubled values... up to 262144.
Values:
Amplitude: the cepstrum value at the drag point during manual envelope selection.
Gain: echo gain setting determined by manual selection.
Offset: echo period setting determined by manual selection. The Hz (frequency), ms (millisecond
duration), and sample offset (audio samples) as determined by manual selection.
EchoCancel screenshot showing the crosshairs (+) with the offset/gain values in the middle.

Screenshot with Mode set to “On” for the usual situation for most users. This is highly recommended.

37.4 Scale Ratio
With the Scale Ratio plugin you can manipulate your video to maintain the pixel aspect ratio
(proportional geometry), possibly for a different output Display device.
On the first 2 lines, there is “In R” and
“Out R” representing the current input
and output aspect ratios. Use the arrows
to change to your desired values. Next
you have the “In W/H” and the “Out
W/H” for Width and Height.
Left and right sides of the bottom
portion show the Source and the
Destination X, Y, W, H values. As you
change the values on the left side, you
can see how this will affect the output as
you observe the results in the
compositor window. For example, as
you change the values for SrcY in a
“cropped” Scale scenario, you see
up/down movement.
In the middle of the plugin on the right-hand side, you can set the Scale type of None, Scaled, Cropped,
Filled, Horiz edge, and Vert edge. The top part (aspect ratio data) is used to compute the bottom part
when the “Apply” button is pressed. The bottom part allows you to reposition the image input or
output to customize the results. When the in/out aspect ratios are different, the output must be cropped
or filled to fit the output and maintain pixel square appearance.

37.5 RGBShift and YUVShift
RGBShift - most cameras take the light coming into the lens, and convert that into 3 sets of numbers,
one for Red (R), one for Green (G), and one for Blue (B). Some of the older cameras were composed
of sensors and originally the RGB sensors were on 3 separate planes and had to be aligned. If they
were misaligned in the video, you can use RGBShift to get them realigned. To move a specific color
up/down, modify the dy value using the slider bar in the RGBShift window. To move a color left/right,
modify the corresponding dx value. Note that the current values of the RGBShift are maintained in
the .bcast defaults file and will be retained across sessions.
←- Normal color aligned.
Misaligned color →

←- RGB shift in a good
video should be 0's.
You move the R, G, B
sliders to align the
colors correctly.
→

YUVShift is used for YUV input video from older cameras using sensors, it is possible to have
misalignment of the 3 sets of numbers: Y, which represents the luminance or brightness component,
and for U and V representing the chrominance (color) components (a Blue channel and a Red channel
that don’t contain any brightness). If they were misaligned in the video, you can use YUVShift to
realign. To move a specific component up/down, modify the dy value using the slider bar in the
RGBShift window. To move a component left/right, modify the corresponding dx value.
Screenshot below shows the blue U component aligned too far to the left. And the red Vcomponent is
misaligned too far to the right. Note the U_dx current slider bar set to 0 as shown by the yellow box
value in the YUVShift plugin window. All components are currently at zero.

A corrected video image is shown in the screenshot below. Now the red and blue colors are correctly
aligned. Note how U_dx is now at +20 and V_dx is now negative to realign the image.abc

37.6 SVG via Inkscape
This plugin allows the user to manipulate an SVG (scalable vector graphics) image with Inkscape
without having to leave the program. The associated cinelerra window provides the ability to change
the DPI, the Out x/y coordinates, and the Out w/h values.
DPI is "Dots per inch" and it represents the resolution of the SVG image. Since the image is scaled
with interpolation mode linear, the edges will look blurry when the input resolution is lower than the
output resolution. You can either set the desired DPI value in the window or use the tumbler on the
integer text box, then use the “update dpi” button to have the change take effect. Changing DPI causes
the entire image to be re-exported via inkscape. DPI changes cause adjustments in the resolution,
speed of re-import, and storage needed for the image data.
Out_x/Out_y parameters allow for changing the location of the SVG via the x or y coordinates.
Scaling is controlled by the Out_w/Out_h parameters for width and height as they are normal
parameters to "overlay".
Screenshot below shows the menu options plugin window and the SVG image in the Inkscape window.

37.7 Title Plugin New Features
For base usage of the Title plugin refer to section 14.4.56 of the CV Cincelerra manual at:
https://cinelerra-cv.org/docs/cinelerra_cv_manual_en.pdf

Drag checkbox – initial default checkbox is “off” so that the Title plugin will work as it always has.
Anchors - When you turn on the Drag feature, 9 different anchors/handles will appear. The middle
anchor allows you to drag your title wherever you want in the compositor window. The other 8
handles, drawn as arrows in each corner and in the middle of each side, let you change the size of the
drag area box so that your title is within that area if it fits and as it is directed.
W/H – the values in these 2 boxes specify the size of the drag area box measured in pixels as shown in
the compositor window. You can set these manually and if you can't see the location of your box or

find your handles, set them to zero because 0 sets it to the same as the width/height of the media.
The Drag effect ignores all boundaries, including the “Title Safe Region” of the Compositor so that if
you drag your titles off the screen, it will look like they disappeared completely. Reset X and Y to
reasonable values to have it reappear. The Title text, background, and pngs are applied on a single
layer so that they will drag together as an entity. All of the Title capabilities work in conjunction with
dragging so if you want to “justify” the title, you can still use the Left/Center/Right/Top/Mid/Bottom
within the drag area. Be sure to turn off Drag when rendering or the box will show in the video; keep
in mind that drag bars do not appear until there is some text in the text box and you can not actually
“drag” until the Title window controls are available.

Attributes – in the Text box where you type your Title information, you can now change several
attributes to give you plenty of flexibility. Each of these special attributes begin with an open angle
bracket “<” and ends with a closing angle bracket “>”. Until the closing angle bracket is keyed in, the
actual characters you type, will be seen in the compositor window. In addition, if you do not use the
exact syntax or you keyin a filename that is not available, all of the characters will continue to show up.
This helps to see what needs to be fixed or is missing. The attributes usage is described in the table
below. The format for each attribute is as follows:
Format: <Attribute_name Attribute_value>
</Attribute>
<Attribute>
Attribute name
1) color
2) font
3) alpha
4) size
–-------5) png
–-------6) bold
7) italic
8) blink
9) ul
10) caps
11) sup
–-------12) fixed
13) nudge
14) smooth

Attribute value
color name such as RED from
<cin_path>/guicast/colors.h
exact name from “Font” pulldown

Sets the attribute to value.
Resets the attribute to previous value.
Reverts to value set in controls config –
applies to color, alpha, size and font.

Notes
Or use the hex value like #a000a0;
color-hex.com shows examples.
When you set font, bold/size and
italic will be as currently set up.
floating-point number between 0 and 1
0 is transparent; 1 is opaque.
+ increases the size by 5/4, - decreases 4/5 Examples: <size +++>, or <size -->,
or use a number > 0 but less than 2048
or <size 14.5> (floating-point ok).
filename of a .png file
Example, add a logo. Full pathname
needed if not in current directory.
1 for “on” (default) or use 0 for “off”
Font used must have bold available.
1 for “on” (default) or use 0 for “off”
Font must have italic already set up.
a number in seconds to flash on and off;
Can be a floating-point number;
a negative number for fade in and out.
<blink> with no value is like 1.
underline 1 for “on” (default), 0 for “off”
1 for “on”, 0 for “off”, -1 for lower case
If no value set, treated same as 1.
1 for superscript; 0 ends; -1 for subscript; Size of text will be 1/3 of font size;
positive bumps up by 1/2 of font size;
example: 12<sup 1>10<sup 0>;
negative sinks by 1/2 of current size.
<sup> with no values, acts like 1.
number of pixels between characters;
A fixed font is very useful for tables;
fixed with no value uses ¾ current size; /fixed reverts to previous fixed size.
x,y to move the text by that amount;
Example: <nudge 8,8>abc</nudge>;
displacement is in number of pixels.
can be negative or positive.
add anti-aliasing to smooth jagged edges Turn off smooth for chroma key.

These attributes stay in effect until you change them or reset them. Additional cpu time is needed for
the blink attribute because it requires redrawing every frame and for the background option described
below. Note that some Title window controls can not be set, such as Justify and Outline color. The
lines below are examples for testing purposes. The accompanying screenshot displays the
corresponding cinelerra output.
Examples of Title line keyins:
<size 15>Buddy, the <color red><bold 1>bad dog</bold><color white> ate my homework !
<png /tmp/buddy.png>
<ul 1><size +>There are <ul 0><size +>2<sup 1>10<sup 0>cats <font Action man (misc)>to chase?

Special Characters – < > / \ #
Besides the previously described <, >, and / characters, there are 2 special characters: backslash “\”,
and the pound sign “#”. The backslash character is used for 2 things. With the advent of the attribute
name and value, your line may become quite long so you can use “\” followed by the carriage return to
continue on the next line as if it is just a single line. It also can be used to designate that the following
character does not represent the beginning of an attribute. For example, if you want to use the opening
angle character “<“ as a title character, precede it with the backslash character. The pound sign, “#”,
designates the whole line as a comment or if in the middle of the line, then the rest of the line is a
comment (this includes the carriage return).

Background – in this box you can keyin the name of a file of the type that cinelerra accepts and use
that file as a background for your Title characters. This will be seen in the compositor window on top
of the video that is loaded in the main track canvas. Besides typing in the filename, you must also
check the checkbox. This makes it easy to turn it on and off to see what it looks like. Next to the
background box is a “Loop” checkbox. If the background file takes less time than the main track
canvas video to run, you can turn on the loop checkbox so that it runs over and over again to match the
time size of your video.

Stroker – to add “pen strokes” to the text letters, adjust the stroke width numerically. This looks
particularly nice on certain fonts and with a negative adjustment of the “Drop shadow”.

Unicode Insertion – if you want to enter a special character like the mathematical summation
symbol, you can use the unicode equivalent to do so. Ctrl-Shift-U followed by 2022 and a carriage
return is an example of the bullet. Refer to section 40.11 for details.

Popup Helper – put your cursor where you want to add an attribute, then right mouse will bring up a
list of the available attributes for you to choose, along with a submenu to choose from. The program
will insert that attribute for you and all you have to add is a value when required!
Screenshots showing the PopupHelper and submenu for the size attribute and color picker.

Color Picker Usage:
The “Text Color” window has several enhanced features as listed here and seen in the next screenshot.
1) The hex value of the color you choose shows in the textbox and you can also keyin a value there.
2) A small square next to the hex text box, is a green eyedropper color picker. Use the left mouse
button to click on the square to enable picking and you will see it turn red to designate that it is
enabled. Your cursor will switch to a two-colored reticle. You can now move the mouse around to
choose a color anywhere on the screen and then click there to have it picked. If you hold down the

right or left mouse button while moving, you can see the color changing in the vertical bar in the
color palette area as you move to give you a bigger view of the actual color. The eyedropper square
is seen in the middle of the next screenshot.
3) A history of 16 of your last chosen colors is available to easily use again. Any time you choose a
new color in any methodology, it will become the latest choice in the history either immediately or
after checking OK/and leaving. History shows latest color starting left to right..
4) Besides HSV, RGB, there is also a YUV color model to choose from.
5) Several of these items may have associated Tool Tips. You can see a tool tip in the next screenshot.

Font Choice:
In order to choose a font faster, you can keyin the first few characters of the font name, being sure to
use capital characters if used since it is case-sensitive. The steps to follow are:
1) next to the font box, click on the down arrow pulldown;
2) keyin the first character(s) of the desired font and you will see the first match become highlighted;
3) you can see the characters you keyed in the upper right corner of the fonts.
Font Addition / Font Subtraction:
Some of the system fonts are automatically included in the set of fonts being used by cinelerra. The
easiest way to add additional fonts for the Title plugin's set, is to use ones available in specific
directories on your computer as long as they have a fonts.scale file already set up. You can run
mkfontscale to create this file within that directory. In order to include a specific directory you set an
environment variable before starting cinelerra which stays in effect until it is unset or until the next
reboot. Below is the method and an example.
export BC_FONT_PATH=<colon-separated-search-path-for-fonts>
export BC_FONT_PATH=/usr/share/fonts
The current set of fonts in cinelerra's directory will be automatically included and will be the default set
if this environment variable is not set. Keep in mind that if you add a lot of fonts, it will considerably
slow down the startup every time you bring up the Title plugin.

If you want to only have a limited number of fonts set up, you can manipulate the cinelerra directory
directly at <cinelerra_install_path>/bin/plugins/fonts. Here you will find the default set of fonts that
come with the install. Copy any other fonts you would like to include here with read permission, delete
any fonts you do not want to have, then execute mkfontscale which creates the file fonts.scale that
cinelerra will read. However, the next time you install a new version of cinelerra, your changes will be
written over so you will have to make sure to save them elsewhere and then re-establish.
If you have problems with a specific font or set of fonts, there is a debug option available to determine
which font is an issue. When starting cinelerra, you should set up the variable:
export BC_FONT_DEBUG=1
unset BC_FONT_DEBUG

(default is 0 for no debug)
(to remove debug messages)

Then start cinelerra from a terminal window to see the fonts being loaded and previewed in the Titler.
This should point out any issues. Another debug methodology is to remove all fonts from being used
and subsequently add in the ones that you want. For example:
export BC_FONT_PATH=: (the : “colon” removes all automatic system and cinelerra fonts)
export BC_FONT_PATH=:/usr/share/fonts
(remove all fonts and then add /usr/shar/fonts)
One last item of information about fonts that may lead to some confusion. The checkbox for Bold and
Italic will occasionally be ghosted out if no bold or italic version of the selected font is available. This
is no guarantee, but currently as good as it can get due to inconsistency in the creation of fonts. It is
mostly just a hint. If boxes are checkmarked, but ghosted, you can not uncheck until you change to a
font that does not ghost out the boxes. If you use the popup helper with the boxes checked, and attempt
to keyin a font that does not have the bold/italic attribute as checked, the font will be considered illegal.
Text: chars is output and updated to indicate the number of characters already used. The only limit to
the number of characters based on a count of single 8-bit characters is the available resources on the
user computer available for cinelerra use. Keep in mind that unicode or other special characters may
consist of 2 to 4 8-bit bytes. Also, newlines are a character and any of the attributes you use count in
the total. There is now a horizontal scroll bar as well as the vertical one in the textbox and they only
appear when there are more lines or characters that can fit in the original sized textbox.

37.8 BlueBanana (credit to Monty Montgomery programmer)
The BlueBanana plugin has a couple of useful purposes. It can be used for color transformation or
remapping – by isolating a specific color and then performing color change/correction on only that
color. Another useful purpose is for chroma-key filtering, using multiple BlueBanana plugins on the
same track. Also, it can be used in conjunction with the “mask” operation of the Compositor. Usage of
BlueBanana may seem complicated at first, but it is necessarily so in order to get enough control to
produce the desired effect simply and quickly. Just changing a single color is actually quite easy.
The basic strategy for BlueBanana is to:
- Select a specific target color.
- Create a selection region by expanding color ranges around that color.
- Optionally reduce or expand the alpha plane as a regional selection mask.
- Optionally apply a color remapping or transformation to the selection.
- Optionally reset the output alpha to opaque, or pass the alpha to another BlueBanana plugin.
Screencast showing the BlueBanana plugin control window in Cinelerra is shown below.

Just a Warning Note:
- May use a lot of CPU and Memory because it is doing a lot of work. If you turn “off” the plugin on
the plugin bar below the video track in the main track canvas it will stop using cpu when not in use.
Or once you uncheck "Mark Selected Area", it will no longer be using the cpu to mark the selected
color area in realtime while drawing the diagonal animated pattern in the compositor window.

Example Usage (from original message by Rebecca). If you just want to try this, follow these steps.
First – Choose your color.
1) Load your video, add the BlueBanana plugin to the track, bring up its control window, and uncheck
any checked boxes (mostly just to avoid unexpected results).
2) In the Compositor window, choose the eyedropper color picker tool on the left-hand side and click
on the area of the image that shows the color you want to change/correct.
3) In the BlueBanana plugin window, to the right of "hue", click "Pick". And if you want to modify
saturation and value, also click on the Pick button for them. To see what it does, Pick them also.
4) Next, check the “Mark Selected Areas” box at the top right of the BlueBanana plugin window to see
the selected color-matching areas which will become marked in a diagonally striped pattern.
5) You can now manually modify your selection in the Color Selection area in the obvious ways for
hue, saturation, value and fill. The arrows to each side of the small circle widen the selected area.
Move the dot and you move the range. The slider on top of the horizontal color strip shifts like the
amount of the strip is dedicated to that part of the color spectrum. Fill will fill more area or less area
in your selected region.
Second – Adjust your color choice.
6) There are color strips under color Adjustment which will show color changes as you modify values.
7) Uncheck “Mark Selected Areas” and check the "Filter Active" box to the right of Color Adjustment.
8) As needed, you can individually check and uncheck all the various parameters using the boxes to the
left of each line. Again, these are intuitive and broadly similar to the above. The arrows at the
bottom widen the range, the circle at the bottom moves the range, and the top slider, which is an
arrow this time, affects distribution. It provides a little histogram effect to give you an idea of what
you're changing. The “fade” adjusts the level of color blending. The “alpha” is basically the opacity
of your changes.
Definition of Wording/Checkboxes/Buttons/Operators are being described next. Some of the
commentary was adopted from information provided by Monty Montgomery and from questions and
answers from email by Igor Ubuntu, who did extensive testing.
Operational characteristics for the color-related adjusters:
- left arrow slider operates the range minimum; the numerical value shows in the left-most textbox.
- right arrow slider operates the range maximum; resulting numerical value is in the middle textbox.
- middle circle slider below, can move the current range up or down and the numerical results will
show in the left and middle textbox. Move the dot and you move the range.
- top pad slider operates the edge slopes (selection attack/decay) and the value will be displayed in the
rightmost textbox. Sharp edges are represented by 0; 100 represents smooth edges.
- or top arrow affects the distribution skew.
Operational characteristics for Fill:
- left arrow slider operates mask erosion filling. First textbox value.
- center up arrow slider operates the fill skew midpoint. Second textbox value.
- right arrow slider operates mask expansion filling. Third textbox value.
- top pad slider operates the edge slopes. Right textbox value.
The textboxes are available so that you can directly type in numbers from the color wheel. This could
be helpful if duplicating previous work as it would be an instantaneous exact numerical match without
having to continuously fine-tune the movement of a slider.

There are 2 panes separated by long horizontal lines (through the middle of the screen) in the control
window of the BlueBanana plugin, clearly visible in the previous screencast. The top pane is first used
to create/modify a selection, and the bottom pane is used to operate a change.
Pane 1 – this section is used to select the target color domain.
Combine Selection – allows for 2 selection modification modes –
1) intersection, referring to “inclusion” (unchecked), and
2) union referring to “combine” (checked).
First, a short explanation about alpha. The alpha channel used in BlueBanana is not transparency; it is
used as the Selection mask. Alpha plane is the alpha channel of the current image. So that:
RGBA = red/green/blue color planes, alpha data plane.
YUVA = luma/Cb/Cr color values, alpha data plane.
The alpha data normally is input to the blending operations in the patchbay overlay mode. The alpha
data usually creates the appearance of stacking order, and determines which color planes are visible in
the rendered result. When BlueBanana is used, the meaning of the alpha data is changed to the
"selection". It is useful to think of the alpha data as more "solid" when it is transparency in blending,
and more "selected" when it is used in BlueBanana. In both cases, the greater the alpha value, the more
the effect is expressed.
Usually, alpha is "normalized" to a range from 0 to 1, zero = no effect, 1 = total effect, .5 = partial
effect. In both cases, alpha is what math people call an "auxiliary" variable. It is needed, but is not part
of the answer. In this case, the answer is the visible rendered result. Alpha is like meta-data.
Now back to “Combine Selection”. The selection is the intersection or union of two pixel masks.
Mathematically, A and B are normalized, (scaled to between 0 and 1) and used as selection mask
weights.
Intersection = A*B and Union = A+B-A*B where:
A) is the input alpha plane as a mask, 1=selected, 0.4=partially selected, and 0=not selected.
B) is the color selection of trims and feathers made by varying the sliders.
The result is a new alpha plane, which will be output (if "End Mask" is not set). The 0..1 selection
values are used to weight the color transformation filters if/when they are active and operate a change.
The color adjustment filters available in Pane #2 can change "red", "green", "blue", and remap "hue",
"saturation", "value" in the pane. There is also “fade" which applies to the color channels and "alpha"
which applies to the resulting alpha plane.
The basic plan is to either:
reduce a selection area by intersection (Combine selection “off”) – A*B or
increase a selection area by union (Combine selection “on”) – A+B-A*B
Mask Selection - applies the current mask to the selection, such that the mask clips/expands the
selection. When mask selection is enabled, the result of the and/or will be stored to the alpha result,
but when mask selection is unchecked the mask is ignored and the selection is not modified. The

selection is used to weight the effect of the filtering, or to control the output alpha.
End mask – only visible when “Mask Selection” is checked. End Mask causes the entire alpha plane to
be set to 1. The image becomes opaque. This is usually only set in the last plugin of a stack (the
stack may be just one plugin doing only color modification). In the event that a color selection mask
is used with multiple, layered BlueBanana filters on the same track, the grouped BlueBanana filters
may share a single mask by all enabling 'Mask Selection', but with only the last BlueBanana enabling
“End Mask”. This usage pattern gives the “End Mask” control its name.
“End Mask” as used in Color Transformation/Remapping:
In many use cases where you are just remapping color, you are still interested in seeing all of the
picture. If this is the case, then checking "End Mask" on the last BlueBanana plugin will show you the
entire picture. The alpha plane may be in use as a selection mask, but it may not be wanted as part of
the result.
“End Mask” as used in Chroma-key Filtering:
In cases where the selection is for a chroma-key, you are interested in the alpha channel for blending,
like "Normal" or "SrcOver". So for this usage of the BlueBanana, don't check the "End Mask".
Invert Selection - reverse target color domain, which is 1 minus selection.
Mark Selected Areas – when this box is checked, the chosen colors are presented in an animated
diagonally striped pattern.
Hue – select a hue domain; click on the Pick button to select or check the box to the left of “hue” or
uncheck to ignore.
Saturation – select a saturation domain; click on the Pick button to select or check the box to the left.
Value – select a value domain; click on the Pick button to select or check the box to the left.
Fill - will fill more area or less area of your selected region. This describes how it works. Fill control
is an automated way of doing grow and shrink on the selected area, to fill in small holes, or get rid of
scattered speckles. If none of the Hue, Saturation, or Value sliders are active - meaning that the
whole frame is selected - the Fill slider will have no effect even when enabled. The word “fill” will
appear ghosted to indicate this.
The three lower handles in the fill slider correspond to 'Shrink' (the left hand slider), 'Final' (the middle
slider), and 'Grow' (the right hand slider). These are used in combination to alter the selection by first
growing it by the amount specified by the right hand Grow slider, shrinking it to the amount specified
by the left hand Shrink slider, and then growing it again to the final size specified by the middle 'Final'
slider. The top slider then feathers the resulting selection.
Growing the selection and then shrinking it has the effect of filling small holes in the selected area.
Similarly, shrinking and then growing tends to remove small flecks of unwanted selection. The Final
slider specifies the overall desired shrinkage or growth of the selection when finished. To specify a
pure Grow or Shrink operation, set the Final slider and the Grow/Shrink slider to the same value and
leave the other slider at zero.
Pre-erode - this control reverses the order of operation to Shrink, then Grow, then Final. The change is

subtle on most images, but overall removes more small features because it first removes flecks before
filling in holes.
Pane 2 – this section is used to modify the color of your selection.
Color Adjustment – descriptive commentary for this pane. For Color Adjustment, RGB can be used as
“color weights” while the HSV can transform color.
Filter Active – checkbox to indicate that the modifications will be shown.
For the following items there are three sections. The center section represents the nominal 0%-100%
range; the left section represents negative values, and the right section represents values greater than
100%. Values can be out-of-range within BlueBanana without clipping, but they will clip once they
leave the plugin.
The following RGB filters affect the color channels individually.
Red – modification color; click the Reset button to revert to default. Values are reflected in numerical
textboxes on the right-hand side.
Green - modification color; click the Reset button to revert to default. Values are reflected in numerical
textboxes on the right-hand side.
Blue – modification color; click the Reset button to revert to default. Values are reflected in numerical
textboxes on the right-hand side.
The following HSV reorient the color spectrum, and affect all of the color channels simultaneously.
Hue – a single numerical value will appear in the right-side box. Click the Reset button for default.
Saturation – for modifying the saturation; click the Reset button to revert to default. Values are
reflected in numerical textboxes on the right-hand side.
Value – for modifying the value; click the Reset button to revert to default. Result is reflected in the
numerical textboxes on the right-hand side.
Fade – controls the entire color re-mapping, and does nothing if no color adjustment is active.
Alpha - controls the output alpha (this is not available when “End Mask” is set); click the Reset button
to revert to default. Result is reflected in the numerical textboxes on the right-hand side.
---------------------------------------------------------------------BlueBanana Use Case #1 - Color Transform/Remapping
1) Load a video track, and add the BlueBanana plugin to your video.
The alpha channel is usually all opaque. This serves as an initial full screen selection mask.
2) Open the controls, and start with all boxes unchecked.
Now reduce the selection using the top pane in intersection mode (that is “Combine Selection” is
unchecked) to begin the effect.
3) Use the eyedropper on the compositor window to choose a particular color.
4) Click on the 3 plugin “Pick” boxes on the right side of each line of HSV to get the color selection.
5) Check “Mark Selected Area”. The affected zones will be identified on the composer.
6) Adjust the selection using the HSV and Fill sliders of the top pane.

The selection mark will be updated as you operate the controls.
The composer mask striping will be strongest as the mask is nearer full selection.
6) Now uncheck “Mask selected area” & check “Filter Active” to begin Color Adjustment.
7) Enable any needed colorspace modifiers, RGB / HSV sliders, and setup the color changes by moving
the sliders. The current output may be the desired output.
8) Enable “Mask Section” and the alpha output will pass the selection mask to the image alpha channel.
This can be used as a very flexible chroma-key filter. It also allows more plugins to be stacked and
more selection information to be added, either by intersections or unions with other selections.
9) “End Mask” simply sets the output image alpha to opaque. This is normally used to end a stack of
BlueBanana plugins, and render the entire image with a complex selection.
BlueBanana Use Case #2 – this case uses stacked BlueBanana plugins working like chroma-key filters.
It assumes you have already learned how to operate the plugin.
1) Bring up 2 tracks of video media – one for foreground and one for background.
2) Add 2 BlueBanana plugins on the first track. Turn off all checkboxes in both plugins.
3) On the top plugin, use the top pane to create a selection mask, using Mark Selected Areas.
4) Turn off top plugin Mark Selected Areas, and disable the top plugin via the plugin title bar on/off.
5) Create another selection using the second plugin's mask, using Mark Selected Areas.
6) Turn on the top plugin. Make sure both plugins Mark Selected Areas is off.
7) Check “Mask Selection” and “Filter Active” in both.
8) Check “Combine Selection” on second BlueBanana to see the final results.
You will see that there is intersection of the full plane with the first chosen regions, so the alpha = 0
everywhere but the area you picked and you see through. And alpha = 1, where the intersection
selection was 1. The "Normal" blend shows you the track on top in these regions (the foreground track
where alpha = 1).
If you are building an alpha selection mask by first intersection and then union, the top BlueBanana
should not change the colors or the bottom plugin will need to target the remapped colors since that is
the input to the lower BlueBanana.

37.9 Perspective
The perspective plugin allows you to change the perspective of an object and is used to make objects
appear as if they are fading into the distance. Basically, you can get a different view. A transformation
is used which preserves points, lines, and planes as well as ratios of distances between points lying on a
straight line.

In the screenshot to the right, you can
see that there are 4 options for the
endpoints used for the edges.
Default – if OpenGL is being used with
your graphics card, this will be the
option in effect. If no OpenGL, then it
will be Cubic.
Nearest – using software, nearest
neighbor can look step-py.
Linear – software implementation of a
linear algorithm.
Cubic – smoothest looking on the
edges and considered the best.

Key Presses for using the Perspective plugin:
Left mouse button – drags the corner that is closest to current location
Alt key + left mouse – translates the perspective; drags the whole image
Shift key + left mouse – zooms the perspective
Alt+Shift + left mouse – translates view but does not change output
Note that the red color lines in the box show the composer boundary.

In order to see endpoints that go off the screen, you can use the zoom slider which changes only the
zoom view and does nothing else. The slider uses a logarithmic scale ranging from 1/100 to 100.
The screenshots below show results of the 4 different smoothing options.
Cubic
Linear

Nearest Neighbor
Default OpenGL with Graphics card

37.10 CriKey
The Chroma Interpolation Key plugin, CriKey, is a regionally based chroma key with interpolation.
This is useful when you only want 1 or some specific zones to be defined by the chroma key as
opposed to the entire image. Its most significant feature is that you can select several regions of
interests and of different colors as opposed to only 1.
To start, if not already checked, turn on “drag”. In the composer window select an area of a certain
color by clicking on that point with the right mouse button and check to see that it is enabled with an *
in the E field. The color of the area is used to define the region of interest and then you can use the
threshold slider to designate the tolerance variation. This creates a region that is the chroma key
selection and a fill will be performed in that area, but only within that region. So, say for example, a
red colored area was chosen, only the red color inside the region is selected – not that color red in the
entire image. The drag capability makes it easy to check a point before right clicking it
to see the effect. You will want to turn off drag when you are finished with CriKey so
that it does not interfere with other compositor functions.

← Alpha, Edge, and Mask draw modes
← New to create a new point, Up/Dn to
move highlighted point up or down
← Del to delete the highlighted point
← Threshold slider varies from 0 to 1
← Drag for ease of use / Reset for defaults
← E for Enabled with * marking that
X is the point’s x coordinate
Y is the point’s y coordinate
T is the threshold value of X,Y point
Tag represents the # of the selected
point
← Hints for usage shortcuts

Draw mode - options let you use “Alpha” for see-thru, “Edge” to just outline the edges of the region, or
“Mask” to block. The pixels which match the selected color are replaced by black if Mask is chosen or
see-thru/transparent if Alpha.
Del – delete the highlighted point in the listbox

Threshold - slider goes from 0 to 1. Increasing the threshold, increases the area to be filled or masked.
You can also use the mouse wheel to scroll the slider.
Reset - button to revert to only the default middle point with all others being deleted.
Some notable caveats:
1) When choosing an area that has variations of the same color within a region, for less work and for
the best results, choose an average color in that region instead of an extreme end of that color.
2) If the threshold is set appropriately you can see the edges which is helpful.
3) The mask is computed and shows the fill region.
4) Use the Gradient plugin to substitute a different color for the selected area.
The screenshot below shows the compositor with some default settings in the controls window.

Now this same screen shot shows how moving the Threshold slider with the Point selected “blacks” out
the single region which has the darker brown hills in it. Because the edge was located, any of the same
color in the rest of the video would not be blacked out.

Usage Steps:
1) Click Reset (there will be a single X,Y coordinate point that is in the middle and not enabled)
2) Check to make sure Drag is on.
3) In the Compositor, right click on area of interest and an X,Y coordinate will appear in the listbox.
4) Click on the E Enabled field next to this latest point and an * asterisk will show.
5) Now you will see an area turn black so use the Threshold slider to only black out the area of interest.
6) Repeat steps 3-5 until you have selected all of the desired areas.
7) Finally, turn off drag so as not to interfere with other compositor functions

37.11 DeScratch
The descratch video plugin can be used to remove vertical scratches from film. It can also be used,
after image rotation, to remove horizontal noise lines that may appear on analog VHS captures. For
best results YUV should be the video format; however if your format is RGB, it will first be converted
to YUV. There are many tuneable parameters necessary to get good results for your specific film.
Screencast of DeScratch with a list of the parameter descriptions below.

threshold – instantaneous slope value; chroma difference in numerical pixels.
asymmetry - maximum asymmetry of surrounding
pixels.
Mode - None; Low=black; High=white; All=both
y - processing mode for luma plane
u- processing mode for chroma u plane
v - processing mode for chroma v plane
width min - minimal scratch width in pixels.
max - maximum scratch width in pixels.
len min – percent minimal scratch length.
max – percent maximum scratch length.
blur – scaled radius of vertical blur for frame
analysis.
gap - number of pixels for maximum vertical gap
to be closed.
max angle - maximal angle to vertical in degrees.
fade – percent of how much it fades to and how
much it
uses between before image and blurry image.
border - pixel thickness of border near scratch for partial
restoration.
Mark - shows the potential scratch lines for ease of viewing and for debugging. It shows chosen pixels

in the color green, close but still rejected in yellow, and extreme pixels in the color red. This
makes it easy to vary some parameters to choose more or fewer scratch lines.
Reset - activating this button returns all of the parameters to their default values.
Screencast below shows a before and after DeScratch scenario.

This is also an after
image but with Mark
set, you can see the
black lines which
indicate what the
program was looking
at to determine the
scratches to remove.

37.12 C41 (credit Florent Delannoy, original program code author, and Edouard Chalaron)
The C41 plugin takes a 16-bit C41 digital intermediate negative film as input and outputs a positive
image. It became necessary because C-41 negatives can fade or color-shift over time which was a
problem early on. It is still important today because there is a large amount of documentaries, video
clips, and other media out there that was shot on super 16 film. This works for RGB-float, RGB, and
also YUV variations.
There are 2 sets of data - the scanned input values and your corrected values. Simple functionality of
the plugin is to compute the data, transform to get corrected values, then apply that.
Basic usage strategy:
1) first time the controls come up, nothing is checked and everything is set to 0
2) check the box “Compute negfix values” to see the current media input values
3) check “Activate processing” and you see a 1-colored screen in the Compositor due to zero values
4) check the “Apply values” box to see the input values on the left side propagate to the right side
5) check “Apply default box” if you want to make sure that the borders of the image are not used
6) correct the output values as desired on the applied right side
It is important to note as you play or change the frame, the plugin re-computes the data as you move
along, but it is not propagated to the applied side.
Checkboxes:
Activate processing – when checked, the c41 operation is used to render the image.
Compute negfix values – computes the current negative values of the image (inside the box).
Show active area – draws horizontal and vertical grid lines displaying the boxed area.
Postprocess – when checked, applies contrast/brightness values as defined in coef1/2.
Values - Scanned negfix values (left side) AND Applied negfix values (right side):
Min/Max R/G/B – minimum and maximum values for Red, Green, and Blue.
Light – value of light; a smaller number is lighter.
Gamma G/B – values for gamma Green and Blue.
Contrast – simple color contrast.
Brightness – white brightness.
Buttons:
Apply values – copies computed RGB/Light/Gamma/Contrast/Bright from negfix to applied values.
Apply default box – copies default computed Box column/row from negfix to applied values.
Shaving box:
The boxing option allows for calculating the inversion of the digital negatives in a given area of the
frame as opposed to the entire frame. The program will automatically calculate the columns and rows
to shave from the frame when “compute negfix values” is checked. A default box area is initially
calculated, called the “shaving box”, based on where the min/max difference in a row/column is less
than the program defined tolerance. This row/column minimum and maximum difference must be

greater than 0.05. The effect is to cut away the border areas with constant color. If you check the
“Show active area”, you can see the box in the compositor window. The boundary search is
constrained to a range of 0.1 to 0.9 times the frame dimensions, to create a 10 percent shaved margin to
avoid over-scan and negative edge bleeding. Manual adjustment of the shaving box is controlled via
the four sliders on the bottom right which move each of the left, right, top and bottom shaving margins.
The slider bar new values automatically take effect as you move the box and you will see the righthand side applied values change. When you have either the rows or the columns where the minimum
slider is greater than or equal to the maximum slider, the default box will be in effect instead.
Optional postprocessing:
Contrast is the difference in brightness between objects or regions. Brightness refers to the overall
lightness or darkness of the image. In order to have the values of Contrast and Brightness take effect,
you must check the Postprocess checkbox.
Screenshot below shows the C41 controls on the left and part of the Compositor window with grid lines
showing the default shading box since the Show active area box is checked. Changes have been made
to the left-hand side original computed values as seen in the right-hand side such as Gamma G which
contains the hairline cursor and has a partial red outline
value box.
Negative film
Before Image ->

37.13 Rumbler
The Rumbler plugin can be used to create dream-like or earthquake-like “noise” in the video. The
algorithm used is: Rumbler(value) = (value at time) + amplitude * (random generator). The random
generator varies from -.5 to .5. The rumble perturbs the normal values at time points which occur rate
times a second. The values used between the rumble points are interpolated, so that the value “jiggles”
rate times a second, by as much as the rumble amplitude. The time unit is frames per second. The
corners are in units of percent width/height.
Plugin variables:
Rumble
gain applied to random rumbler.
Rate
number of times per second.
Time
number of frames per rate times a second; if 0 has no effect on results.
Space
corners jiggling in percentage per rate times a second; if 0 has no effect on results.
Seq
is a random seed number; any reasonable positive or negative number you choose.

Screencast shows:
Time jittering 20 fps 1 time a second.
Corners jittering - 25 percent 5 times a second.
Using random seed 0 for a rumble sequence.

37.14 Find Object and other OpenCV – Stylize,Puzzle,Flow,Gabor,Move
The Find Object plugin searches a Scene for an Object, and the Object can be overlayed with a
Replacement object. It requires the thirdparty OpenCV (Open Computer Vision) library and you will
have to do your own build.
There are some potential pitfalls with using this to include:
1) openCV code is constantly changing, making it difficult to keep the plugin up to date
2) there is some confusion about licensing/patents for specific algorithms
3) some parts don’t work all that well and it can be slow
4) internally the colormodel is converted to greyscale, which means the color information is not used
Because of the build size of opencv, it is not normally included in the thirdparty directory. Building
opencv adds a lot of storage demand (4GB) to the cinelerra build tree, and the opencv compile time is
significant. For these reasons, findobject is not normally built. You can however invoke a build which
adds findobject to the cinelerra plugin library. Building findobject will configure and build opencv into
the thirdparty library build area if needed (it does not rebuild if already done). System builds are
possible, but the system compatibility of the newer opencv interfaces can vary between distros. The
opencv interface is rapidly changing; we recommend the static library build and link to avoid problems.

37.14.1 How to Build OpenCV Plugins
To build findobject and the other plugins using opencv, access the src using git:
git clone –depth 1 "git://git.cinelerra-gg.org/goodguy/cinelerra.git" cinelerra5
then configure the build, but add the - -with-opencv configure parameter.

cd <path>/cinelerra-5.1
./autogen.sh
./configure <add std params, eg: --with-single-user> --with-findobect=sta
--with-opencv may be set to [<bld>][,<src>]
bld=typ sta,dyn,sys: sta=static, dyn=shared, sys=system libraries
src=typ git,tar,git=url,tar=url: git (default git_url), tar (default: tar_url)
For example, like:
--with-opencv=sta
--with-opencv=dyn
--with-opencv=sta,tar=https://cinelerra-gg.org/download/opencv/opencv-20180401.tgz
Once thirdparty/opencv is built, it will be reused. Use target "mrclean" to remove thirdparty/opencv*.
Network access is required to obtain the OpenCV source, at least once. You will need a minimum of
4 GB in the thirdparty build directory and more time to compile.
To get opencv built in the easiest way possible (need internet access because builds directly from the
opencv github but this changes wildly):
./configure <params> --with-opencv=sta,git

37.14.2 Using OpenCV Plugins from the Automatic Builds
The OpenCV plugins are built only in the 64-bit tarball builds, both static and dynamic. However, due
to size these plugins are not included with pkgs. But it is relatively easy to add the current 6 plugins for
your distro via a simple procedure of copying the plugins from the tarball to the cin5 install plugin
path. They are:
cin/plugins/opencv/findobj.plugin
cin/plugins/opencv/flowobj.plugin
cin/plugins/opencv/gaborobj.plugin
cin/plugins/opencv/moveobj.plugin
cin/plugins/opencv/puzzleobj.plugin
cin/plugins/opencv/stylizeobj.plugin
1) do your package install of the current build for your distro as usual;
2) look in https://cinelerra-gg.org/download/tars to see your distro name's static tar;
3) download the corresponding distro static tarball;
for example for arch: https://cinelerra-gg.org/download/tars
cinelerra-5.1-arch-20161201-x86_64-20170930-static.txz
4) create a temporary directory on your computer
5) cd that-directory
6) tar -xf location-of-the-tarball-you-downloaded
7) cp plugins/*obj.plugin <see below for your location>/. (note the period on the end!)
location for most User installs, this is: <cinlib_path>/plugins/
location for some System installs, this is:
/usr/lib/cin/plugins/ (most ubuntu distros)
/usr/lib64/cin/plugins/ (Leap distro)

Start cinelerra and look for the 6 plugins in Video Effects.
To reverse this, simply delete the 4 plugin files (eg. rm /usr/lib*/cin*/*obj.plugin).

37.14.3 Description of Find Object Plugin
As in the standard OpenCV FindObj program, there are 5 detector methods and 2 matcher methods
which can be selected. They detect features and match them as a rectangular projection. The matched
region will be overlayed with a replacement image if “replace object” is enabled. This is done using a
variety of feature detectors and region matches. The match works by creating sets of Feature points.
These points are generated for both the source and reference object frames. Then the two sets are
matched for "Homography" (a regional similarity).
Matchers:
FLANN – Fast Library for Approximate Nearest Neighbors
BF – (flann not selected) Brute Force
Detectors Algorithm:
SIFT –
Scale-Invariant Feature Transform
SURF –
Speeded-Up Robust Features
ORB –
Oriented fast and Rotated Brief
AKAZE - Accelerated Keypoint detector And descriptor Extractor
BRISK Binary Robust Invariant Scalable Keypoints
Don’t Calculate
The cinelerra plugin has several additional features for ease of use and more flexibility. A description
of parameters is outlined below.
Mode:
Square
Rhombus
Rectangle
Parallelogram
Quadrilateral – default
Reset – to get back to the default values.
Algorithm – detector selections as described above.
Replace object – checked if replacing the object is the desired outcome.
Use FLANN – use the Matcher, or if unchecked just use brute force.
Draw match – will display a blue line around the matching object only for the purpose of verifying the
placement. The starting point for the box is designated by a white outlined circle in corner #1.
Scene/object/replace layer – number designating the attachment track of each findobject plugin
element.
After matching, the resulting projection corners are used to do reshaping. The general procedure is:
- Calculate centroid, translate center to 0,0, check for bowties and rotation direction.
- Calculate replacement object corners using mode, central angles, scale, and aspect of the projection.
- Using the replacement, apply the inverse aspect, rotation, scaling, and translation as specified.

Selectable specifications:
Aspect – when set, the matching aspect ratio is applied, otherwise the original object aspect is applied.
Scale – when set, the match surface area is used for scaling, otherwise the original surface area is used.
Rotate – when set, the match orientation is used in the projection, otherwise the original orientation is
used (orthonormal).
Translate – when set, the match replacement is centered to the projection center, otherwise the original
object center is used.
Once the replacement corners are calculated, the replacement object is overlayed to the scene frame.
Scene/Object/Replace Drag – only 1 can be checked on at a time (and that includes counting the Title
plugin drag box). The Drag boxes are faster alternatives to using the column dials.
Scene/Object/Replace columns of X/Y/W/H – x and y positions along with width and height; 0–100%
+ Replace DX and DY deltas for the Replace column.
Draw keypoints - when enabled shows the detection points created by the feature detection and used in
the matcher Algorithm calculation.
Draw scene/object/replace border – displays each of the borders which helps to determine correctness.
Object blend amount - can dampen (smooth) the corner motion from frame to frame to reduce jitters.

An example of how to use Find Object
The following steps were used to set up the example screencast shown next.
1) For best results, set “Play every frame” in Settings→Preferences→Playback A.
2) Load 3 tracks of png/jpg files – this is one of the more useful working cases:
2.1) 1st track should be the scene; that is the output
2.2) 2nd track is the object to find
2.3) 3rd track is the replacement object
3) Drag the Find Object plugin onto track #1.
4) On each of other 2 tracks, click the right mouse button; choose “attach effect”, highlight Find Object
in the shared effect column, and click OK. All three tracks should now have a findobj plugin effect
bar. One, (probably the first one) is the master plugin and the others are attached input tracks.
5) Check the plugin show icon on the master track to bring up the controls for the FindObj plugin. You
will see that “Use FLANN” is checked for using nearest neighbors.
6) Set Output, Object, and Replacement object layers’ track number accordingly (numbered from zero).
7) Check “Draw scene border” and you will see a white border in the compositor window surrounding
the whole image of the scene. This assumes default settings for Scene center X,Y(at 50%), and area
W,H (100%). Adjust these however you need to via the dials or more simply by checking “Drag”
and dragging any of the 9 drag points. As shown above this in the controls, units are in 0-100%.
8) Turn off “Play track” in the patchbay on the first track so you can see track #2 in the compositor and
then use the Object X,Y,W,H dials. You will see a blue-dotted line which should then be adjusted to
surround the desired object. Since it can be a little tedious to use the dials, you will want to turn off
the previous Drag box and check this instead to do your dragging placement from drag points.
9) Turn off “Play track” in the patchbay on this track #2 so that track #3 is visible and if necessary,
adjust the dials/drag box in the same manner. The border will have a pink-dotted line around it.
10) Turn back on all of the desired “Play track”s in the patchbays.
11) Set the detector choice (should have “Don’t calculate” set initially), for example use SIFT.

12) Turn off all of the “Draw borders” and whichever Drag box that may still be checked.
13) Check “Replace object” to see the replacement overlay. At this time you may still want to change
the checkboxes of Aspect, Rotate, Scale, and Translate and adjust DX/DY in the Replace column.
Screencast showing 1st the 3 tracks with Scene, Object, and Replacement + Find Object controls below.

Screencast to the left shows the results in the
compositor of “finding” the object on track 2 in the
track 1 scene and then “replacing” it with the object
in track 3 on the main track canvas.

37.14.4 Additional – MoveObj, FlowObj, GaborObj, StylizeObj, PuzzleObj
MoveObj plugin moves an object and stabilizes it.
FlowObj plugin retards
image motion as shown
with optical flow. You
can turn on/off draw
vectors.
--------->

GaborObj creates an
interesting fractalius-like
image effect using the
Gabor filter.
|

GaborObj
Plugin
<--Before
image
After-->
image

PuzzleObj makes a puzzle out of an image.
You can make the puzzle pieces smaller or
larger with the Pixels slider bar. The
Iterations slider bar allows for varying
morphing distance.

The StylizeObj plugin can be used to create some interesting edge effects using various options.
Edge Smooth / Edge Recursive
There are 2 edge preserving methods available – one to smooth the image edges, and the other to not
smooth the edges/color boundaries, but instead replace the color values at a pixel by the average of the
pixels around the area which have color similar to that pixel.
Detail Enhance
This option enhances the details of an image to make it look sharper.
Pencil Sketch / Color Sketch
Pencil like line drawings – either applied to a grayscale version of the images, which can give you thin
pencil to charcoal like results, or applied to the color input image, which will look like a colored pencil
drawing. For best results you can vary the Smooth-ing (the size of the surrounding area), the Edges
(how dissimilar colors in the surroundings will be averaged; a larger value results in large regions of
constant color) and the shading (simple scaling of the output image intensity with the higher the value,
the brighter the result).
Stylization
Produces output that looks like the images were painted using water colors, which often gives the
impression of cartoon-like pictures. It abstracts regions of low contrast while either preserving or
enhancing features of high contrast.

Screencast shows the
original image and the
StylizeObj plugin
options as previously
described.

The screencasts below show the images after adding the 6 various styles.
Edge Smooth
Edge Recursive

Detail Enhance

Pencil Sketch
Color Sketch
Stylization

37.14.5 License Agreement for OpenCV
License Agreement
For Open Source Computer Vision Library
(3-clause BSD License)
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
• Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
• Neither the names of the copyright holders nor the names of the contributors may be used to endorse or promote products derived from this
software without specific prior written permission.
•
This software is provided by the copyright holders and contributors “as is” and any express or implied warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose are disclaimed. In no event shall copyright holders or contributors be liable for any direct,
indirect, incidental, special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use,
data, or profits; or business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or
otherwise) arising in any way out of the use of this software, even if advised of the possibility of such damage.

37.15 Audio LV2 / Calf Plugins (Optional Feature - OS dependent)
LV2 is an open standard for audio plugins using a simple interface with extensions which add
functionality to support audio software. These plugins were written by external developers and provide
additional audio effects to Cinelerra audio without having to change Cinelerra every time. Because the
LV2 plugins are separate from cinelerra, if one fails or does not perform as expected, cinelerra should
stay running and you will have to contact the programmers responsible for that plugin for a fix.
Typically, a user OS has specialized package groups installed. It is difficult to create one build of
cinelerra to accommodate all potential LV2 plugins. Specifically for the Calf-Studio LV2 plugins, you
should install the Calf Plugins package. The user’s computer must have gtk-2-runtime installed, which
seems to be automatically done already for most distros. For users doing their own builds, you can
build cinelerra without LV2 support by including “without-lv2” in the configure step. The default build
is --with-lv2=yes and requires that GTK-2-devel must be installed or the build will fail and notify you.
LV2 plugins have their own category in the Audio Plugins Visibility as lv2. There is a simple text
interface which is available via the usual “Show controls” button when the plugin is attached to the
audio track. This window has a Reset button to get back to the default settings. To change a value of
one of the parameters, highlight that parameter and either type in the new value in the topmost text box
and then hit apply to take effect - the reason for requiring hitting apply is so that the audio is not
moving all over the place while you are still typing a value. More easily, you can just move the pot dial
or the slider bar which take effect automatically.
Cinelerra’s buffer size setting may cause a delay in activation of the changes you make taking effect, so
you can lessen the time by using a small buffer. Notice that 1024 samples at 48000 samples per sec is
only 1/50th a second. This is not a lot of time to shuffle a bunch of stuff. Short buffers produce low
latency, but no time for complex programs or lots of stacked effects. Bigger buffers allow for more
complex setups.
To set the buffer size:
Settings→Preferences, tab Playback A, section Audio Out, variable Playback buffer samples
However, be forewarned that due to variability in the lv2 plugin programming code, some of the
plugins only work with the minimum buffer size of 1024. In these cases, what you will see is the main
track canvas cursor just bounces back and forth over a very area in the timeline. This does not crash
cinelerra but you will have to remove the plugin to continue working.
You can specify a certain set of LV2 plugins to use by setting LV2_PATH as shown below before
starting cinelerra - include a colon (:) separator for multiple paths. The default path for most operating
systems is /usr/lib64/lv2. To list the system installed lv2 plugins key in: lv2ls .
export LV2_PATH=/tmp/j/balance.lv2/usr/local/lib/lv2/:/usr/local/lv2
If there is no default LV2_PATH set automatically, the value will be $CIN_DAT/lv2, which is a
placeholder only so that no lv2 plugins will be loaded. When there is no system LV2_PATH set it is
important to note, that if you do want lv2 plugins loaded, you must set the correct path in Settings →
Preferences, Interface tab, Default LV2_PATH directory path name. When you change this field, cin

will automatically restart and load the newly specified lv2 plugins. If when switching LV2_PATH or if
the lv2 audio plugins are not displayed/usable in the Resources window, you can execute a reload via
Settings→Preferences, Interface tab “Reload plugin index” or else before you bring up cinelerra, delete
$HOME/.bcast5/Cinelerra_plugins so that the plugins get properly reloaded.
There are some lv2 plugins that display a “glitzy” UI (User Interface); for example the Calf plugins.
For these LV2 plugins, if you want that to automatically come up without having to click on the UI
button on the simplified ui interface, there is a flag to enable that. It is at:
Settings→Preferences, Operations tab, then check the “Auto start lv2 gui” Flag
Below is a screencast showing the auto start gui flag and the LV2_PATH default directory path on the
bottom line. Note the highlighted “Reload plugin index” which will be executed if OKed.

There is also a blacklist that prevents known problematic-for-cinelerra lv2 plugins from loading to
avoid crashes. If others are found to have problems, once informed about them, they will be added to
this blacklist. In order to determine which lv2 plugin causes a SEGV on cinelerra startup, you can start
from a terminal window and you will see each plugin that is being loaded and the last one shown
before the crash is a bad plugin. However, many of the plugins causing a crash are due to not having
been compiled on your current system with the current compiler so may actually work correctly on
other user systems and so will not be added to the cinelerra-wide blacklist. You can either recompile
the problematic plugin, or modify your own blacklist which you will have to maintain and save so as
not to be written over when loading a new build.

Screencast of simple text interface in the middle of the screen for a Calf LV2 plugin.

Note the UI button on the above screencast in the upper right hand corner above the Reset button. If
you click this button, a glitzy interface window comes up (if available) for changing variable values. It
is possible that a bug in the LV2 plugin causes the glitzy window to appear as blank and then die, but in
that case the original simple text window might still work - in either case, if the timeline movement
hangs, just detach the plugin to continue your current session. There is an environment variable that
you can set, BC_TRAP_LV2_SEGV, to get a dump of the failure which may be helpful for debugging.
When the glitzy ui is up, the simple text window remains up also since it is the cinelerra side and keeps
track of the value changes so they remain in effect for further usage of the plugin. Changes to one or
the other will occur in both with the exception of certain features in the glitzy window which are not
communicated correctly back to cinelerra; for example a reset button - the simple interface Reset
button must be used instead. To change values in the glitzy window you use the mouse and move up or
down unlike a knob that turns!
Screencast with a Calf plugin glitzy window that appears when clicking the simple interface UI button.

In order to test a particular plugin without bringing up cinelerra, especially for ones that do not operate,
it is possible to manually display an lv2ui gui with: /cin-path/lv2ui <lv2-uri> . For example:
/tmp/cinelerra-5.1/bin/lv2ui http://calf.sourceforge.net/plugins/Flanger

37.16 Sketcher
Now you can “sketch” lines, curves or points, on your video in different colors using various pen
widths and pen types with the “sketcher” plugin. You can even fill them. Getting started is fairly easy
- simply hold down the shift key while using the left mouse button to create a bunch of points in the
compositor window. However, to do more than that you will need to understand the buttons and
options or you may end up with unexpected results.
Screencast below shows the Sketcher gui and the sketch lines/curves created in the Compositor.

In the above screencast, note the Sketcher window gui Curve top section and the Point bottom section.
The white circle sketch is id #1 in the curve section. Since id #1 is highlighted in the Curve section, the
X/Y coordinates in the Point section below show the points used to create the loop. The red point on
the image is id #2 point that is highlighted.

Some basic rules:
Uncheck “Drag” before rendering; if you do not uncheck, the drag points will show in your output.
Drag must be checked on to edit the data. Drag must be checked off to use “Click to play”.
If the drag button flickers when clicked then another window has drag focus. Un-focus it first.
Turn drag off to see what the sketcher figure will look like when rendered.
Curves can be any number of points or just a single point.
You must create a new curve if you want a new string of points not connected to the current curve.
Highlight the curve id # for a specific curve to modify its values.
Left mouse click or right mouse click on an existing point on the highlighted line/curve id # will
automatically highlight the selected point in the Point section of the gui and turn red in the image.
There will always be 1 empty curve automatically defined when you start or even reset.
You can not delete the empty default curve but you can use it for a curve.
Left mouse button click almost anywhere on the compositor screen will automatically show, in the
currently highlighted curve, the closest point by turning it red.
There is no undo recorded between gui updates. Recommend using the option ‘b” to save a backup if
you get to a place where you want to make sure you do not lose your sketch.
In the Compositor, mouse motions for usage:
shift+left mouse button
create a new line point
shift+right mouse button
create a new arc (curve) point
left mouse button
select a single line point
right mouse button
select a single arc (curve) point
ctrl+left mouse button
drag point
ctrl+right mouse button
drag curve
alt+left mouse button
drag all of the curves together
alt+right mouse button
create a new curve
ctrl+shift+left mouse button
create a new fill point
ctrl+shift+right mouse button
create a new off point
delete key
deletes highlighted points
delete key+shift
deletes highlighted curves

Window Gui:
New button in Point (line)
New button in Point (curve)
Click point listbox item
Click curve listbox item

New button in Curve section
New button in Point (fill)
New button in Point (off)
Del button in Point section
Del button in Curve section

Other Button and Label Descriptions:
Color – refers to the current curve pen color. Click on the Color rectangle to bring up the Color
window to change any of the color values, including alpha.
Drag – check to create curves and to be able to see any Off type curves. Uncheck for render/viewing.
Reset – in the Curve section, all of the curve lines will be deleted except for an empty default curve.
– in the Point section, all points for the highlighted curve in the Curve section will be deleted.
Width – integer width of line; width of 1 is the default; width of 0 is the smallest size of 1 pixel.
ID
– is the label number of the curve or point.
Pen – value can be set with the pulldown to box (a square), +, /, x or off. The default is x.
Alpha – alpha value as set in the Color window. Default is 1 which is totally opaque.
Arc Type – value can be set with this pulldown, which is to the right of the Drag checkbox, to either
off, line, curve, or fill. Off is the default. If the line type is “off” when you uncheck drag, you
will no longer see the line/curve. Fill specifies a point be inside the region to be filled with
the chosen color. Multiple fill points can be used within a single curve.
Up
– moves the highlighted Curve or Point Up in the stacking order. Multiple points, but not
multiple curves, can be highlighted and moved.
Dn
– moves the highlighted Curve or Point(s) Down in the stacking order.

X
Y

– X is the point’s X coordinate.
– Y is the point’s Y coordinate.

ID number detailed information:
Points and curves are identified by numeric ids, and not the table position. This is so that deleting and
inserting points/curves does not shift the interpretation of which points are associated for interpolation.
For purposes of this discussion, “prev” refers to “previous”. The prev keyframe constitutes the draw
list of curves and points. The prev ids are used to access the next keyframe interpolation input data.
When “next” exists for prev.id the interpolation functions apply. When “next” does not exist, “prev” is
returned for the interpolation value. The keyframes may be any id sequence; both the prev and next
keyframe id sequences are arbitrary non-unique sets. This means that if an id is specified redundantly,
it causes a redundant draw when it is the prev keyframe, and only the last item with the id in the next
keyframe is used for interpolation.
Fill detailed information:
The "fill" point is a marker point, and not really part of the curve. That point identifies the "inside" of
the loop. It can also be used to identify the “outside” of the loop in order to fill that. The loop is
created by drawing a line draw from the last point to the first point in the curve. The line type of this
last segment is from the last point of the curve. If there are isolated loops in the curve (it is self
intersecting) then you will be able to use multiple fill points to fill these regions.

38. Cinx and a “Bit” of Confusion
Cinx is the exact same program as Cin. The X (x) represents the roman numeral 10 for 10 bit as
opposed to 8-bit standard. The third-party library used for x265 must be specially compiled with –bitdepth=10 in order to produce 10 bit rendered output. This build will not be able to output 8-bit depth
which means you have to retain the Cin version also. Whatever build ffmpeg is linked to will
determine what bit depth it can output. This is why there has to be separate builds. The same is true
for x264 but no special build has been created for that; however the user can do their own build. If you
install both packages, Cin and CinX, you may get “file conflicts of same file name” - just continue.
Keep in mind that the regular 8-bit version works on 8-bit bytes – the standard word size for
computers, but the 10-bit version has to use 2 words to contain all 10 bits so you can expect rendering
to be as much as twice as slow. There is also a 12-bit version for consideration but currently the results
are simply the same as 10-bit with padding to make 12-bit so it is of no value.

39. Lossless Rendering
Lossless means that in the compression of a file, all of the original data, every single bit, can be
recovered when the file is uncompressed. This is different than “lossy compression” where some data
is permanently deleted so that when uncompressed, all of the original data can not be exactly
recovered. Lossless is generally used for video and sound, where a certain amount of information loss
will not be detected by most users or the playback hardware does not reproduce it anyway – it is a
trade-off between file size and image/sound quality. The files created will be more than 10 times larger
than usual. Most players will not be able to decode lossless as the bitrate will overwhelm the device.
For x264 lossless compression to work, the only color model allowed here is yuv420p. Any other
specification will be converted to yuv420p and the data will be modified. Also, keep in mind that the
YUV color model has to be converted to RGB, which also modifies the data.
To use x264 lossless rendering - choose File format of “ffmpeg”, “m2ts” in the Render window. Click
on the Video wrench, which brings up the Video Preset window and scroll down in the Compression
filebox and choose “lossless.m2ts”. Preset=medium is the default, but can be varied from ultrafast
(least amount of compression, but biggest file size) to veryslow (most amount of compression, but still
HUGE) in the parameter box where you see “qp=0”. This option is also available for bluray creation.

40. Other note-worthy minor Enhancements
40.1 Replace-type Insertion Strategies
For ffmpeg and mpeg files, when the Insertion strategy methodology in the File→Load files pulldown
is chosen to be either “Replace current project” or “Replace current project and concatenate tracks”, the
basic session format parameters are reinitialized to match new media. This selects the default asset and
determines its width, height, and video length, frame rate, calculates the colormodel, and assumes
square pixels to make an intelligent guess about aspect ratio for video. For audio, the sample rate,
audio length, and channel count (mono, stereo, or 5.1) are reinitialized. In addition the “Track Size”
will be computed and is reinitialized to match the new loaded media. When using “replace” type
insertion strategy, the new asset list is the only media in use so that this update saves the user from
immediately needing to change the session format to match the only possibility.

40.2 Sort within Sort in File Load Window
When you use the File pulldown to load files, you can do a sort within a sort when you click on the
labeled header box. This is useful, for example, when you want to find the smallest file for a specific
extension. In the screenshots below, the first illustrates the default “File” sorted alphabetically; the
second shows the “Size” is now sorted; the third shows how after sorting on Size, you sort on Ext. The
size sort is maintained within the extension sort so that c.d comes before a.d in the File header box
because the size is smaller.

40.3 Playback Speed Automation Support
The speed automation causes the playback sampling rate to increase or decrease to a period controlled
by the speed automation curve. This can make playback speed-up or slow-down according to the
scaled sampling rate, as “time is multiplied by speed” (speed X unit_rate).

40.4 Keyframe Reticle
In the “Editing” section of Settings→Preferences→Interface there is “Keyframe reticle” with options
of Newer, Dragging, or Always. This is used to help in checking edit alignment across tracks. A reticle

is a sighting line used to line up visual items, like cross hairs in a eyepiece. The appearance and
function of sighting lines can be changed when dragging auto keyframes. To see the effect, create
some fader autos and drag a few to see the reticles drawn. "Always" renders a line over all plugins, and
"dragging" only over the drag icon. "Never" draws nothing.

40.5 A few Environment Variables that can be Customized
The following exported variables can be set to customize your environment. The CIN_CONFIG
variable could be extremely useful for testing purposes or for multiple users sharing the same home
directory who would like different default preference settings.
CIN_BROWSER
CIN_CONFIG
CIN_DAT
CIN_LADSPA
CIN_LIB
CIN_LOCALE
CIN_PLUGIN
CIN_RENDER
CIN_XSYNCH

name of browser to use by Shell Cmds options
configuration data; defaults to $HOME/.bcast5
location of data files, such as documentation, models, tip of the day
LADSPA directory path
location of library programs, such as bdwrite
locale text domain path to use for translating text
plugin directory path
complete filename with path for use in Shell Scripts
(for Developers only) set to 1 helps debugging for windows primitives to
execute immediately and not be buffered up so you can tell what is happening

For example: export CIN_BROWSER=chrome would override default firefox for Shell Cmds.
For example: export CIN_CONFIG=/tmp/.bcast5 use a temporary setup for testing purposes

40.6 Masking in Composer Window Key Difference
Usage for Composer masking was changed to create a more consistent user interface and make the
meaning obvious. It is easier to remember Control key for control point and Shift for endpoint.
It now works the same way that the fader control
point handles are edited in the main window, like
using the control key down to qualify the drag
selection.
This partial screenshot shows the legend in the
Mask info window of the composer outlining
usage.
→

40.7 Batch Render - Save/Use EDL and Save/Load Jobs
The File->Batch Render pulldown brings up the Batch Render window to be used for batch rendering
as well as DVD/BD creation. This version of cinelerra has some additional buttons that can save some
time and mistakes. These are described next.
The “Save to EDL Path” and “Use Current EDL” can be valuable tools for advanced usage or for
developers doing testing. Description of how you can expect them to work will help to illustrate how
to take advantage of their capabilities.
1) Save to EDL Path – if you have made a change to the EDL, use this button to save the changes so
that they will be used in the render operation. Although you can get the same results by using
File→Save…, this capability was initially added to assist developers in testing the batch jobs needed
to create dvd/bluray media as it keeps the work focused in a single window and retains the original
job name. An example -- you have everything all set up with a new job in the Batch Render window
using generic.xml for the EDL path and with a job name of original_name.xml. Then you realize
that you forgot to cut out a section in the media that is not wanted in the final product. You can cut
that out and then “Save to EDL Path” so your change will be in effect for the rendering. Without this
button, you would be using the EDL you started with and the cut would be ignored. Alternatively, if
the cut changes are saved via File→Save as… with a filename of new.xml and then you use “Save to
EDL Path”, the current highlighted job displayed in the window as “original_name.xml” will be
replaced with new.xml. However, it is important to note that the result will be saved with the name
original_name – that is, the new content from new.xml but with the old name of original_name.xml.
2) Use Current EDL – if you are working on media and still testing out the results, you can take
advantage of this click-box to quickly get results. Basically, you change the media, save that change
with another name (in order to preserve the original name in case you don't like the changes), and
press “Use Current EDL”. As an example, a user creates a new job in the Batch Render window
using the current media, previously defined in generic.xml, with the EDL path of generic.xml. The
user then changes the media on the timeline, saves the changes via File→Save as… with a new
name, such as new_name.xml, and then clicks on “Use Current EDL”. In this case, the EDL path
listbox will be automatically updated to the new_name.xml and the current existing highlighted job
will be replaced with the new_name.xml in the EDL column.
3) Save Jobs – when you have set up the batch jobs the way you want and you think you may have to
run them more than once, it is beneficial to save the jobs for later use so you easily run them again.
4) Load Jobs – reload a previous set of saved jobs. This can come in handy if you did not have the
time to render them when you originally set them up, if you need to rerun, or if you got interrupted.
5) Checkbox “warn if jobs/session mismatched”. After you set up your render and press Start, the
program checks to see if the current EDL session matches your Batch Render job. If the EDL has
been changed since the batch job was created, it warns you so that you have the opportunity to
“Save to EDL path” to record those changes. Otherwise, you can dismiss that warning box, disable
the warning message by unchecking the box and use the original values. If you never want to be
warned about the mismatches, leave the box unchecked.

Screenshot below shows the 4 buttons on the right hand side of the Batch Render window. In addition
the Warning message popup is shown towards the bottom, overlaying the Batch Render window.

40.8 Hide Keyframe Type
The “Hide keyframe type” in the Popup Menu of a keyframe associated box works in the same manner
as disabling the keyframe type in the pulldown View menu. Its usefulness is for convenience. For
example, in View you enabled Fade, Mute, and Speed; you do a some work on one of them, and want
to work on another one. You can just get the one you are finished with out of sight without having to
"think" about which one it is and leaving the area to go to the pulldown menu. Also, right clicking
anywhere on the associated keyframe line, brings up the Hide Keyframe Type option.

40.9 Piping Video to a Command Line
You can pipe a video to any command line on the computer, such as ffmpeg. This can be especially
useful with raw video files. Next is an example usage.
1) on a terminal window create a named pipe file, for example:
mknod /tmp/piper.yuv p
2) load your video and do your editing
3) set up your Render (Shift-R), you can choose a raw format such as “yuv” or “rgb”
4) for the filename “Select a file to render to”, use the named pipe as created in step 1 (/tmp/piper.yuv)
5) for “Insertion Strategy”, you will want to make sure to select “insert nothing”
6) click for OK on the green checkmark

The cinelerra gui will look like it is hanging while waiting for a command line to use the pipe.
7) on the terminal window, keyin your command, for example:
/mnt0/build5/cinelerra-5.1/thirdparty/ffmpeg-3.4.1/ffmpeg -f rawvideo -pixel_format yuv420p \ video_size 1280x720 -framerate 30000/1001 -i /tmp/piper.yuv /tmp/pys.mov
A slightly different option can be used instead that may be more familiar to some. In the render menu
after choosing the File Format of “ffmpeg”, use the pulldown to choose “y4m” as the file type. This
choice results in putting a header on the rendered output with some pertinent information that can be
used for ffmpeg processing thus alleviating the requirement for pixel_format, video_size, and framerate
on the ffmpeg command line. In this case the format is yuv4mpegpipe instead of rawvideo. An
example command line would look as follows (assuming the created pipe is called piper.y4m):
ffmpeg -f yuv4mpegpipe -i /tmp/piper.y4m -vcodec libx264 /tmp/test.mp4

40.10 Raw Input Opts File for Video/Audio
Raw video is not affected by decoding on read in. This makes it very attractive to provide raw image
data for editing and rendering media. A wide variety of raw formats are available via the ffmpeg file
interface. To load media in a raw format, select “try ffmpeg first” and create an accompanying “opts”
file. The opts files must be in the same directory as your media, with the same base name, and the .opts
extension. The opts file contents should reflect your video setup. An example follows:
Video file name = /tmp/buddy.mov
Opts file name = /tmp/buddy.opts
Contents of opts file =
format=rawvideo
codec=rawvideo
video_size=352x240
pixel_format=yuv420p
duration=90.25

40.11 Button Operation Preferences
To accommodate 2 methods of favorite popups, there is a flag “Popups activate on button up” (the
default) in Settings→Preferences→Appearance. When unchecked, “Popups activate on button down”.
In addition, for certain O/S distros which may not have focus policies, you can “Click to activate text
focus” or “Click to deactivate text focus” or even both! By default they are both unchecked.
Screenshot which shows a red checkmark under Flags for “Popups activate on button up” and “Click to
deactivate text focus”.

40.12 Project SMP cpus Count
On large cpu systems, it can come in handy to downgrade the number of cpus used for some plugins;
otherwise it uses all of the processors and splits up the program into too many pieces which may add
considerable overhead in high cpu count systems. To restrict the number of processors utilized, change
the count number in Settings→Preferences→Performance . That number will be used for the plugin
per load balance operation cpu limit, which uses smp-cpus to stripe your data. It does not affect the
number of cpus used in any other cinelerra operation besides the plugins.

40.13 Textbox Non-standard Character / Unicode Insertion
If you want to enter a special character - like a bullet, an accent grave character, or a mathematical
summation symbol – you can use the unicode equivalent in a textbox to do so. In the textbox, keyin
Ctrl-Shift-U which puts you into single character unicode mode, then keyin the numerical value for the
intended single character followed by the carriage return. For a voluminous list of possible special

characters, you can go to unicode-table.com on the internet to choose by highlighting a character to get
its numerical equivalence. For example, U+2022 is a bullet. If you make a mistake, you can use the
backspace key or if you want to exit unicode-insert-mode, use the ESC key. This feature is especially
useful with the Title plugin and for naming Tracks in the main window.
However, it is worth mentioning that some special characters are available via the "compose" key in the
current distribution. https://en.wikipedia.org/wiki/Compose_key .

40.14 Load files... Sub-list Usage
When you use the “Load files...” option of the File pulldown, you can get a sub-list of potential files to
choose from. For example, you know that the file you are looking for begins with the capital letter
“C”. If you keyin “C” into the selection box immediately below the list of files, and then click the left
mouse button, a sub-list of files beginning with the “C” show up under the selection box. Clicking the
right mouse button cancels this sub-list.

40.15 Faststart Option for MOV type files
If you have mov video and want to be able to start playing without having to first load the entire video,
-movflags=+faststart is needed for ffmpeg to put the meta-data, known as the “moov atom”, at the
beginning of the file. Otherwise, ffmpeg puts this atom at the end of the video file which means you
have to wait to play until the whole video is loaded. Or worse yet, if the file becomes damaged in the
middle and you can not get to the end, you won’t be able to play anything.
Now you can have the “moov atom” put on the front of the file (automatically via a second pass). To
do this, when rendering using ffmpeg & either the mp4 or qt format/container, click on the video/audio
wrenches and choose faststart_h264. With the “qt” format, settings will just be the default whereas the
“mp4” format uses the highest quality and lowest file size as possible, but you can easily modify these
options in the associated Video Preset textbox.

40.16 Probe Order
Some of the codec file drivers can open a variety of media, and some of the more common methods
may have more than one file driver which could be useful to decode your media file, for example Tiff.
For specialized usage, you may want to guarantee that a certain method is used to open media, so you
can change the “probe order”. Use the pulldown Settings→Preferences to get to the Interface tab
where you will see a box in the Operation section on the left side called “Probe Order”. Click on the
box and use the up/down/enabled boxes to change the order of the item you have highlighted.
Up – move the item up 1 (if the item is currently on the top, it will be moved to the bottom)
Down – move the item down 1 (similarly, if on the bottom, it will be moved to the top)
Enabled – there will be a check mark if the item is currently enabled. If you disable it, it will
not be used to probe the media to determine what it is. Double left mouse click will toggle
the enabled/disabled state of the highlighted item. If both FFMPEG Early/Late are enabled,
the FFMPEG code could be run twice if the 1st FFMPEG run failed (but so will the 2nd!).
The default setup is set to duplicate the past expected behavior with the exception that CR2 for Raw
Camera mode is disabled. Changes made in the settings will be retained in the .bcast5 file.

Screencast showing the first few probe items. Note that the up arrow on the left, signifies “enabled”.

Scrolling down
shows the next 2
pages of possible
drivers for a total
of 18.

The order change will not take effect until you click on the checkmark in both the Probes window and
the Preferences window. When you click on the FF button, which is in the upper right-hand corner of
the main page to change “Try FFMpeg first/last”, enabling of FFMPEG_Late or FFMPEG_Early will
be toggled automatically in Probes to match that choice but does NOT change its position in the table.
Be sure to only click on the FF button without the Preference/Probes window up to avoid unexpected
results. It is also recommended to leave FFMPEG_Early/FFMPEG_Late close to the top/bottom
positions. There is one case where you may want to disable all of the probes if you want to force PCM
– Pulse Code Modulator. This code is always run when all other probes fail.

40.17 Raw Image Format of Some Digital Cameras & Probe Order
Dcraw, as used by Cinelerra, is Dave Coffin’s open-source computer program which reads many rawimage formats typically produced by high-end digital cameras. Currently almost 700 of the types of
cameras it recognizes are listed at:
https://www.cybercom.net/~dcoffin/dcraw/
For example, included is the Canon Powershot SX60 (newly available in August, 2014). Because
ffmpeg tries to load "any and every" file, if “Try Ffmpeg first” is enabled it will make an attempt to
load Raw Camera files first before any other file driver gets the chance. In addition, there is the
possibility that dcraw could conflict with the standard TIFF format, since it might be seen as format
type “tiff-pipe”. Therefore it is necessary to specifically enable CR2 and either move it to the top or
disable “FFMPEG_Early” and enable “FFMPEG_late” in the “Probe Order” as described in a previous
section. These changed settings will be retained across cinelerra sessions in .bcast5. Raw Camera
mode is most likely going to be used by expert camera users.
Screenshot below showing CR2 for Raw Camera highlighed/enabled in the Preferences Probes’ screen.

Screenshot showing the Resources
Asset Info displaying the File format
as Raw Camera.

^
This screenshot ^ as in Settings→Preferences, Playback A Tab, shows the default checked settings
of “Interpolate CR2 images” and “White balance CR2 images” which display the raw images in a way
that you expect. However, you may want to uncheck them to ensure that no program manipulation has
modified your images so that you can add plugins or make your own modifications. Unchecked
indicates that the images are as closest as possible to unadulterated raw.

40.18 Zoom Slider for Fine-Viewing in Compositor
A “zoom slider” will pop-up towards the bottom on the left-hand side of the Compositor when you
enable “Zoom view” via the magnifying glass or when you click on the icons for “Adjust camera
automation” or “Adjust projector automation”. This will allow for adjusting the amount of zoom at any
level between .01 and 100 based on a logarithmic scale. When using the zoom slider, the number by
which the view is zoomed can be seen in the textbox where the original-also-working % zoom is
located. The zoom slider size is in the form of “times”, such as x 0.82 which indicates that the picture
is zoomed to 82/100th of the original size as seen in Settings→Format. Once you have set the zoom to
the desired size, use the vertical and horizontal scroll bars to position the view as needed.
Screencast shows below at \/ a zoom slider bar with the diamond shaped slider in the middle. Note
that the magnifying glass is \/ enabled which automatically pops-up the slider.

The Format shows a large 5204x3468 video and the box at the arrow shows x 0.82 size. /\

40.19 Improvements to the Render Window
The Render window has been improved to automatically update the Render Audio Tracks or Render
Video Tracks enables as allowed by the chosen file format. For example, if the PNG file format is
selected, only the "Render Video Tracks" will be checked. Or if an ffmpeg format is chosen and the
file format does not render audio, the "Render Audio Tracks" will be unchecked. The invalid choices
will be ghosted out.
A new feature is a 4th choice for “Render range” for single images like TIFF. The Render range will
have "One Frame" automatically checked and all of them ghosted since nothing else makes sense.
This makes it easy to set the insertion point where you want the 1 frame to be rendered rather than
having to precisely zoom in to set the in/out pointers. Note that whichever Render range is checked,
remains checked so that if “One Frame” gets automatically checked, the next time you render it will
still be checked and you will have to select a different one if desired.

Screenshot showing both
Render audio and video
tracks checked for pro file
type of ffmpeg.

Screenshot showing the
Fill Format of PNG which
can only do 1 frame and is
onlyfor video. Note that
Render audio tracks is
ghosted out as are all of
the Render range
selections as there is only
1 choice of One Frame
which was automatically
chosen.

40.20 Alternative to using Numeric Keypad
For the keyboards without a numeric keypad or if you prefer to use keys closer to where you normally
type, there are alternative keys for the play/transport functions. These are listed below.
Alt +m = stop playback
Alt + j = forward single frame
Alt + k = forward slow playback
Alt + l = forward normal playback
Alt + ; = forward fast playback
Alt + u = reverse single frame
Alt + i = reverse slow playback
Alt + o = reverse normal playback
Alt + p = reverse fast playback
+ Shift key with the above, results in the reverse of whether audio is included or not.
+ Ctrl with the above, results in the transport function operating only between the in/out pointers.

40.21 Window Input Focus
On some operating system distros, when you move your mouse to a different window, nothing happens
and you are left wondering why you can not enter information. A new Settings→Preferences→
Appearance preferences is available to “Set Input Focus when window entered”. This is checked by
default. This causes the input focus to shift to any cinelerra window when the cursor enters an exposed
region of the window which eliminates the need to switch input focus by tabbing.

40.22 Selection Highlight Color
When you make a selection, that area becomes an inverse image which by default becomes a whitish
color. You can set it to a different color in Settings→Preferences→Appearance by modifying the hex
value in the box next to "Highlight inversion color". The default value is ffffff. Keep in mind that if
you set the value to a low value, you will not be able to see the outlined selected area (for example the
hex value “f” is not readily visible and leads to confusion). A leading 0 or blank is not allowed and will
be automatically changed to ffffff.

40.23 Snapshot / Grabshot
To take a snapshot, perform the following steps:
1) set your timeline insert marker where you want the snapshot - this frame shows in the compositor
2) right click in an empty spot in the media folder and the popup shows snapshot as the 5th item down
3) highlight that and the submenu comes up allowing you to choose png, jpg, or tif
The snapshot shows up in the Media folder. It is saved by default in /tmp as snap_date-time.ext BUT
you can change the default directory path in Settings->Preferences-> Interface tab in the right hand side
of the Editing section.
Grabshot is the 6th menu item. A red circle can be moved to area to grab; use left mouse drag to
surround an area; and right click to grab.

40.24 Search/Filter Option for Plugins and Assets
The search option is available for any of the folders in the Resources window and when using “Attach
effect” on the main track canvas for the Plugins. As you type in characters a match is made with that
substring. Names that do not match are
filtered out making it a lot easier to find the
item you are looking for. The characters can
be any where within the phrase and it does not
matter if upper or lower case. The screencast
to the right, has the letters “color” in the
Search box and the plugins that match are
displayed.
The screencasts below show the before and the
after of a Search in the Resources window for
the character “2”.

40.25 Blade Cut and Hard Edges
You can cut the tracks into 2 pieces on the timeline by putting the hairline cursor on the place you want
to do a cut and then using the character “x” or the scissors tool. A “cut” uses a non-empty selection
region, where the “blade cut” or “split” has no duration in the selection, just a hairline. As usual the
use of cut when a selection is set, deletes/cuts the highlighted area. In the case where an In point or an
Out point exists on the timeline, the clip is split at the location of the in/out point since it has priority
over the cursor location. A blade cut simply splits the edit into two edits. In order to have the video
and audio aligned, it works best to have Settings→Align cursor on frames. When a blade cut occurs,
the edges are created as “hard edges”. These are edges that cannot be deleted by
track optimizations.
When you do a blade cut/split, all armed tracks will be included in the cut and
green-colored triangles will show on the bottom of the track on both the left and
the right side of the cut. This is a “hard edge” marker toggle, as opposed to the
soft edge designation for an ordinary edit. The “hard edge” marker can be
toggled off/on if so desired. In order to not interfere with the usual drag handles,
only a few pixels are used for the toggle so you have to be sure you have the
cursor right over the hard edge triangle – when in position, it will be obvious
because you can see an arrow pointing to the corner. Use Shift-button1 to toggle
off/on the hard edge marker on all tracks simultaneously.

40.26 Size Numeric Format Displayed in File Load
There are 4 numerical representation variations for reporting the file size in the File→Load pulldown.
You can see the options in the Load window to the right of the top line that read “Select files to loads:”
0 - this is the default and current behavior and shows bytes the same as the ls -l command.
b - 3 significant digits suffixed by lower case k,m,g,t,b for representing magnitudes in 10^3 (1000)
B - 3 significant digits followed by upper case characters for representing magnitudes in 2^10 (1024)
; - like the exact default byte representation but with comma separators for easy reading. Periods can
not be used as separators due to locale conflict with ffmpeg coding.
<--0

b
|

40.27 Timeline New RMB Popups
There are 3 new popups in the main track canvas when you click on the right mouse button (RMB).
Find in Resources, User title, and Show edit. These are described below.
“Find in Resources”
shown in the popup
below will cause a
highlight in the
media folder. This
indicates the media
on that track in the
Resources window.

Right mouse button
popup on track. →

“User title” →
is used to change
the title name.
This is really
handy for files
that have very
long and similar
names that would
get cut off during
edits. You can
use short names
to differentiate
better the media.

“Show edit” will point
out the exact start and
stop points along with
the length of the
current edit on that
track. And the media
name.

40.28 Export Project – for Moving Project to another Computer
A new File pulldown called “Export Project...” is now available. Although, it can be used in the same
manner as the other “save” options, it is very useful when it is necessary to move a project to another
computer that may have a different top level directory structure or if you want to include subdirectories
to better organize your files.
Originally, the easiest way to maintain a project for moving to another computer, was to put all of the
files in a single directory with no subdirectories along with the EDL saved .xml file. This is
commonly called a “flat” file structure. So if the media was in the same directory as the XML file, a
relative path was saved. If it was in a different directory, an absolute path was saved.

Screencast of “Export Project...” option popup.
Screencast that |
displays the 3 |
available options.

Definition of Fields:
Project Directory – name of the directory where you want the xml file to be saved. It will only create
a subdirectory in 1 level of the defined directory.
Available option types for saving a project:
1) Copy – all files are copied to the project directory and the xml is saved; same as original “flat”.
Option is very useful to ensure all files needed to illustrate a problem are available for analysis.
2) SymLink – symbolic links are created for absolute paths of media in their current location.
3) RelLink – symbolic links are created for relative paths of media in their current location. This
option allows for using relative paths without the requirement to maintain a “flat” file structure
and makes it easy to move to another computer.
Overwrite files – when checked, if any files with the same name currently exist in the directory, they
will be overwritten. In any case, the named XML file will always be overwritten.
Reload project – when checked, after the save option the new saved project will be loaded.
Default is not to do so.
Keep in mind that to maintain the integrity of your project xml file for easy moving to another
computer, do not delete the symbolic links. You will want to use “cp -a” to maintain the links for
moving to a USB key or another computer.

41. How Some Stuff Works
41.1 Copy/Paste and Highlight Usage with Cinelerra
There are 3 types of copy/cut and paste methods which exist in X windows, and most modern programs
use 2 of them. The 3 cases are:
cut_buffers 0-7
highlighting
copy and paste

- these are obsolete but they still work and are the simplest to use.
- called primary selection; almost all clipboard programs only use this.
- called secondary (or clipboard) selection. Some more modern program use
ctrl-C/ctrl-X and ctrl-V for this (some use other keys or qualifiers, like shift).

How it works:
All of the methods use window "properties" to attach data, called a selection, to a source window. The
program advertises the selection by using the X server. The window property used determines which
selection type is set/advertised by the new selection.
When a paste is used in a target window, the target program requests the advertised selection data. This
may access one of two buffers depending on which type of load/paste action is used. The user loads a
cut buffer via drag select or ctrl-C/ctrl-X, and pastes a cut buffer via middle mouse press or ctrl-V.
Cinelerra cut and paste:
1) Text cut and paste operations:
To use a text selection, create a drag selection in textboxes by pressing and holding mouse button1 with
the pointer over the beginning of the text selection, then move the pointer over the desired selection to
the selection end, then release the mouse button. This continuously reloads the "primary" clipboard
buffer and highlights the text selection. It can then be pasted to most programs by pressing the middle
mouse button with the pointer over the text insertion point. Some examples of these programs are
xterm, gnome-terminal, cinelerra, and browser input text boxes. After you create a text selection, if
you then press ctrl-C the selection will also be copied to the secondary (or clipboard) selection buffer.
This second paste buffer can be used for a more lasting save effect, since it will not be lost until you
again press ctrl-C (copy). Using ctrl-X (cut) will also copy the selection to the secondary clipboard
buffer, and then delete the selection from the textbox. If you press ctrl-V (or paste) in a target window,
the secondary selection will be inserted at the target window cursor. If a text selection exists in the
target window, it is replaced by the pasted text.
2) Media cut and paste operations:
To create a media selection, highlight a region on the cinelerra media timeline, then use the main
menubar or compositor/viewer edit panel to operate the clip cut, copy, or copy-keyframe menu buttons.
This selection can then be pasted to a target selection on the timeline using the main menubar or
compositor/viewer edit panel to operate the clip paste or paste-keyframe operation. Also, by using the
resource window you can select the "Clips" folder and right mouse the resources list box, then use the
"Paste Clip" menu item to paste the selection to a named clip. Additionally, these methods work

between running instances of cinelerra, which means you can move media clips between the cinelerra
program instances. The clip data is also copied to the secondary clipboard buffer. This makes it
possible to examine the clip content directly if so desired.
3) Finally, the older cut_buffer method is used:
3.1) For text, if there is an active selection when a window closes, it uses cut_buffer0. Normally when
a paste is performed, the target window "notifies" the selection owner to "send it now" when you do a
paste, but if the window has closed there is no source window, so no pasting. Some programs, like
cinelerra, use cut_buffer0 as a fallback. This makes it possible to paste data from a closed window.
3.2) To move media clip, data cut_buffer2 is used because it does not require the selection owner
interface, and works simply and reliably. This buffer is not normally in use by other programs.
One final note, when a text selection is set, the selected text is redrawn using selected-highlight color
when the textbox loses focus. This convenience feature shows the active text selection as you move the
pointer to the new target window. When a new selection is set anywhere else on your screen, the
current text selection will be redrawn using the inactive-highlight color as the textbox loses selection
ownership. In most cinelerra themes, the drag selection text-highlight color is BLUE (#0000FF), the
selected-highlight color is SLBLUE (#6040C0) - really sort of purple, and the inactive-highlight color
is MEGREY (#AFAFAF).

41.2 Playing is Different than Seeking/Positioning!
Seeking targets and displays the next frame. The next frame is targeted because frame zero has no
previous. When you seek, you reposition to just before the target frame, and since the play direction
has not been established (there is no direction when seeking) it shows you the next frame. This
produces the expected behavior when you seek to frame zero; you see the first frame. Seeking displays
in the compositor what you are getting ready to work with/edit/etc.; always showing the next frame in
relation to the cursor. Technically, since seeking just resets the position, it would be correct not to
update the compositor, but it is best to seek and show the next frame to confirm that it is the frame you
expected to see.
Playing shows you what has just been played in the compositor window. It is not the same as seeking.
When you use keypad 1 to play frame forward, then the 1st frame that is played and shown in the
compositor window is frame zero (which was already displayed). The position is incremented to 1.
Press keypad 1 yet again, and the next frame displayed is 1, and the new position is 2, and so on.
According to the implemented strategy, the insertion point moves to track playback. When playback
stops, the insertion point stays where playback stopped. Thus, with playback you change the position
of the insertion point.
Simple explanation of what you will be seeing in the compositor when playing:
Play forward - the frame to the right of the cursor in the timeline gets displayed.
Play backward - the frame to the left of the cursor in the timeline gets displayed.
The reason behind this “play” methodology is that you want to know what you just played so that you
know what matches what you just saw/heard in case that is the desired stuff. You don't want the
compositor to show you what you have not yet played - you need to see this frame to analyze/check to
see if it is what you want. This behavior applies to any playing operation, such as the keypad or Frame

forward/Frame reverse buttons. You can still easily see the actual insertion point in the zoombar at the
bottom of the timeline - sixth button over or 3rd button from the right side. Also note the following:
Blinking insertion point on the timeline
Solid non-blinking insertion point on timeline

- seeking/positioning was the last operation.
- playing was the last operation.

Example and explanation based on the code:
1) open a small example of 10 numbered frames (or use the Title plugin to add a timestamp)
2) press f to "fit" the timeline
3) make sure settings->align_cursor_on_frames is set
4) seek to frame 4 by clicking on the timeline at position 4, compositor shows the 5th frame, since the
media counts from 1 and the timeline counts from 0. This is correct behavior.
5) press KP1 to play next frame. According to playback strategy:
When play is forwards, the next unit is displayed,
and the position is advanced one unit.
So the next frame is 4, (shows the 5th frame) it is displayed.
The position is advanced from 4 to 5. This is correct behavior.
6) press KP4 to play the previous frame. According to playback strategy:
When play is in reverse, the previous unit is displayed,
and the position is reduced one unit.
So the previous frame is 4, (shows the 5th frame) it is displayed.
The position is reduced from 5 to 4. This is correct behavior.
If you watch the zoombar (bottom of main window) position, it shows the current position is just before
the next frame to be displayed when going forwards, and just after the frame to be displayed when
going backward.
To recap, position is usually set in the program as a location that is between a previous and next
frame/sample unit such that the next unit equals the seek target. After position is reset using a "seek"
operation, the next unit is displayed, which is the seek target. When “play is forward”, the next unit is
shown, and the position is advanced one unit. When “play is in reverse”, the previous unit is shown,
and the position is reduced one unit. At the beginning, there is no previous, and at the end, there is no
next, but silence is rendered at the end.

41.2.1 Always Show Next Frame
Since some users prefer the insertion pointer to reflect the same as the Compositor a choice is available.
For playing forward, there is a preference option which results in what looks like 1 was added to the
frame displayed in the Compositor window. To enable this mode, check the box “Always show next
frame”, and this will be saved to .bcast5. The option checkbox is in the Settings→Preferences->
Appearance tab and when checked, any forward "plays" in the Compositor window show the same
frame as you would with a seek. Reverse plays and plays using a selection or In/Out pointers (with
Ctrl) work the same as without this preference set. But you will no longer see the odd behavior where
if you frame advance forward and then frame advance backward, the displayed frame does not change
– instead it will change and look more natural.

A color indicator that shows in the main track canvas timeline and the compositor timeline reminds the
user which mode is currently active. The cursor in the compositor turns red for default mode and white
for “Always show next frame” mode. The top portion of the insertion cursor in the track canvas
mirrors this, with red for default and white otherwise.
Screencast below using the default “playing” method where the frame in the compositor is the one that
was just played; in this case play was in the forward direction. Note that the insertion pointer in the
main track canvas shows 01:20 but the compositor show 01:19 so you know what you last saw. Also,
the cursor/cursor tops in both windows is red.

Red cursor in
compositor >>
Red cursor on
main timeline>

Screencast below using the “Always show next frame” method where the frame in the compositor is
the same one that would have shown with a seek; in this case play was in the forward direction. Note
that the insertion pointer in the main track canvas shows 01:20 and the compositor shows 01:20. Also,
the cursor/cursor tops in both windows is white.

White cursor
compositor >
White cursor
main track>>

41.2.2 Examples
(some examples go here)

41.2.3 Seeking Issues
If you have an issue playing a video and not seeing it in the Compositor (just see a black screen), it is
most likely due to the media not being designed to be “editable”. It is most likely not damaged.
Generally it just does not have keyframes which are needed for seeking which is what is done when
you move around the media and start playing in the middle. The media plays just fine in the
compositor if you always play from the beginning because then you don’t need keyframes to seek. You
can get around this problem if you proxy the media. A good choice to use for the proxy would be “use
scalar”, ffmpeg/mp4 and size of ½. The proxied media can then seek and you will see it play in the
compositor because keyframes exist.

41.3 Proxy Settings
Working with videos that have large image geometry can greatly impede editing. Instead you can
substitute “proxies” which will create smaller video image files from the original file, which can then
be edited more quickly. When you are done working on this smaller scale, you will need to bring up
the Proxy settings menu again, and change the Scale factor back up to Original size so that all of your
edits/work take affect on that original higher quality video on the timeline. You can not nest clips while
in a proxied state; you will get the error “Nesting not allowed when proxy scale != 1”.
To use this feature, select Settings→Proxy settings… (shortcut of Alt-r) and change the Scale factor
from Original size to your downsized choice. This will cause the video tracks to be rendered. This may
take some time, but previous proxy renders will be reused. The proxy videos will be added to your
assets in a separate Proxy folder, and the video track edits will use the “proxies”. Proxy downsizing
renders all loaded tracks, but only work on the 1st video layer of multi-layer media. Rendered proxy
media is saved in the same directory as the original media. As usual, you can delete proxy files from
the project or disk in the Resources window if you no longer want to retain them.
There are two ways that the proxy files can be used, with or without input scaling. When the proxy is
done without rescaling, the Mask, Camera and Projector automations are re-scaled accordingly. In this
case, the entire project will be re-sized so that the session is in the resized geometry. Not all plugins are
useful when the project is rescaled, because the keyframe data must be in the original geometry. In this
case, you can use the rescaler, by enabling “Use scaler (FFMPEG only)”. It has the advantage that the
project size does not change, the proxy media is down-scaled as usual and up-scaled on read-in, which
means the project editing is done in full scale. Since decoding is done on smaller video, there is a time
savings, but all rendering is done full scale. The main reason for using “scaler” is that it does not
change the image coordinate data, so that automation and plugin parameters will be in the original
project geometry. This is not as fast as the first option, but is a performance gain, and may be needed
if you are using plugins that need coordinate data such as the Titler. As noted, it only works on ffmpeg
video formats.
Screencast here shows the Use scaler
checked so you can still use plugins and
the original project size is kept. The
Scale factor pull-down gives you
available size options. Note the new
media dimensions shown (partially
covered). If the size is an odd number,
1 is added to make the dimensions both
even #’s.
A convenient “Beep on done” checkbox
is included so that you can work on
other tasks until there is an audible
notify of completion.

Checking the “Auto proxy/scale media loads” results in any additional media loads to be automatically
proxy scaled. However, single frame media, such as PNG or JPEG “stills”, can not be scaled to
“stream” media. If this type of media exists, you should “use scaler”.
More specific information on which plugins need to use scaler follows. If the keyframe data uses
coordinate data that is absolute, then the scalar should be used. If the data is normalized (like always 0100%) then the proxy can be done without the scaler. The session geometry format, shown in
Settings→Format as width x height, is changed if the scaler is not used to cause all of the data to be in
the reduced format. If this affects the plugin operation, then the scalar should be used. Examples of
plugins that need the scaler are: Title, AutoScale, Scale, ScaleRatio, and Translate. Most others are safe
to use without scaling.

41.4 Snapping while Cutting and Dragging
Cutting/Snapping edits - cuts from an edit handle to the insert point.
There are Edit Panel buttons which normally are used to move to the previous or next
edit handle/label. They look like tags and the letter E on the menu bar and are
oriented forward/backward. These same buttons can be used to “cut” from the insert
pointer to the previous or next edit/label when the ctrl+alt keys are both pressed when
the buttons are used. They “snap” off the media instead of doing the standard repositioning. This is useful to minimize the number of operations necessary to cut
between edits/labels.
Instead of using the edit panel buttons, you can more easily use the following keyboard shortcuts to
perform the same functions:
snap_right_edit
snap_left_edit
snap_right_label
snap_left_label

ctrl+alt+ '.'
ctrl+alt+ ','
ctrl+alt +shift '.' (shift+period is the > sign on US keyboards)
ctrl+alt +shift',' (shift+comma is the < sign on US keyboards)

Drag Snapping - if you hold down the Ctrl + Alt keys while dragging using the mouse, once the clip
gets near to an edit, a label, an in/out pointer or the start/end of the timeline, the dragged clip will snap
next to that marker. The 2 will now be exactly aligned with no gap and no overlap. As you drag the
clip close to one of the markers, when they are within a short distance they start to stick and stay that
way until you move further away from that distance. Also, the line will turn color from green to yellow
while in the sticky phase.

41.5 2-pass Encoding with Ffmpeg
In Cinelerra for two-pass, you need to run ffmpeg twice, with the same settings, except for designating
the options of pass 1 for the first pass and then pass 2. In pass 1, a logfile that ffmpeg needs for the
second pass is created. In pass 1 the audio codec should be specified that will be used in pass 2. For
more information on ffmpeg 2-pass, check this url: https://trac.ffmpeg.org/wiki/Encode/H.264 .
Different libraries may have different requirements and you will probably have to determine this by
looking online at ffmpeg or looking directly at that code.

This 2 line ffmpeg 2-pass operation can be functionally duplicated in Cinelerra in the steps below them:
ffmpeg -y -i input -c:v libx264 -b:v 2600k -pass 1 -c:a aac -b:a 128k -f mp4 /dev/null && \
ffmpeg -i input -c:v libx264 -b:v 2600k -pass 2 -c:a aac -b:a 128k output.mp4
1) After you have completed your editing, do a Save Session with File→Save as…
Before starting, be sure your session is ready for batch render.
That is, positioned at the beginning and nothing selected.
2) Bring up File→Batch Render… where you will do the setup.
3) Click on the “Delete” box to remove old jobs highlighted in the bottom listbox.
For the “File Format” choose ffmpeg and mp4 for the type.
Set “Output path” to the path and filename for the render output file.
Click on “Use Current EDL” to use the designated EDL Path file.
Click on “New” and you will see a new highlighted job show up in the listbox at the bottom.
Use the Audio wrench to set bitrate to 128000 (128k as in ffmpeg example above).
Click checkmark OK. Open the video tools with the video wrench.
Set the Video Compression to h264.mp4 (as seen in the example).
Set the bitrate to 2600000 (2600k as in ffmpeg example above).
Add the following 2 lines after the first line:
flags +pass1
passlogfile /tmp/{temporary log file name}.log
Click checkmark OK.
4) Click on “New” to create the second pass job. You will see this second job in the listbox below.
Use the Video wrench and change pass1 to pass2 as follows.
flags +pass2
5) Click checkmark OK.
6) Click on the “Start” box and watch it go!
7) You can now check the output file for results. At the time this was documented, “rc=2pass” will be
in the output.
If you need to re-render this, the Batch Render will still be set up but you have to click on the
“Enabled” column in the listbox to re-enable the jobs to run which puts an X there. Click Start again.
You can reuse batch job using the “save jobs” and “load jobs” buttons in the batch render dialog.
Render shortcuts for webm, h264, h265 are available by using the option files that are already set up
for this purpose. Use the render menu as usual, with ffmpeg/mp4, choose h264 or h265 pass1of2_h26x
for the video and passes1and2_h26x for the audio; with ffmpeg/webm, choose pass1of2_vp9. When
that is finished, you will have to use the render menu again and this time for video, choose
pass2of2_h26x or pass2of2_vp9. The logfile is hard coded in the options file so will write over any
currently existing logfile if you do not change it before you start the render.
Requirements for some other libraries are below (used instead of “flags +pass1 & passlogfile”):
x265:
add this line: x265-params=pass=1:stats=/tmp/{temporary log file name}.log
at the time this document was written, you should see in the output: stats-read=2
libvpx-vp9, xvid, and huffyuv: NOTE for vp9, the best Pixels is gbrp.

cin_stats_filename /tmp/{temporary log file name}.log
flags +pass1 (or flags +pass2 for the second pass)

41.6 Color Space and Color Range Affecting Playback
Playback “single step” and “plugins” cause the render to be in the session color model, while
continuous playback with no plugins tries to use the file’s best color model for the display (for speed).
This can create a visible effect of a switch in color in the Compositor, usually shown as grayish versus
over-bright.
The cause of the issue is that X11 is RGB only and it is used to draw the "refresh" frame. So single
step is always drawn in RGB. To make a YUV frame into RGB, a color model transfer function is
used. The math equations are based on color_space and color_range. In this case, color_range is the
cause of the "gray" offset. The YUV mpeg color range is 16..235 for Y, 16..240 for UV, and the color
range used by YUV jpeg is 0..255 for YUV.
The mpeg YUV color range (16..235) looks sort of like an old TV if it is viewed on a display with jpeg
range (0..255). A common expression for the short "mpeg" color range is "compressed" color range. If
you are using color compressed data with no display decompression, or using uncompressed data and
the display is configured to use compression, the color range will appear "squished" or "stretched", as
too gray or too much contrast.
The "use X11 direct when possible" preference with X11 as your video driver, generally means that you
value speed over color range. When you use this feature and the color range preference is mismatched,
the color switch offsets will still appear. This is a personal choice solely for improved speed.
There is now program code to look for RGB versus YUV color model mismatches. You can override
the default setup, which mirrors the original code, via the following.
Settings→Preferences Appearance tab in the lower left hand corner:
YUV color space – default choice is BT601, alternate is BT709 (High Definition), BT2020 (UHD)
YUV color range – default choice is JPEG, alternate is MPEG

41.7 YouTube with Cinelerra + Basic Video Creation in 8 Easy Steps
To create a youtube or dailymotion video, you can easily follow the steps below. You will have to learn
a lot more about Cinelerra to take full advantage of its capabilities and make some really special
videos, but this is just to get a start and to see the possibilities.
1) Start Cinelerra; usually you can do this by clicking on Cinelerra icon or keyin {cin_path}/bin/cin .
2) In the “Program” window on the lower left side of your screen, left mouse click the “File” pulldown.
3) You will see “Load files” as the second choice so left mouse click this and find your video file to
load, highlight it, and check the green checkmark in the lower left hand corner to get it loaded.
4) Edit your video in the Program window using the basic commands of:
- play and then stop using the space bar
- move the mouse and then left click to move the insertion (location) pointer
- cut a section out by holding down the left mouse and drag, then keyin “x” to cut or “c” to copy
- paste a copy or cut section by moving the insertion pointer, then keyin “v”
5) Add a title by highlighting the “Video Effects” in the right hand side “Resources” window; then
highlighting the Title icon and dragging it to the “Program” window video track and dropping.
6) Click on the middle icon button (looks like a magnifying glass) on the brown-colored Title bar to
bring up the Title window bottom text box and keyin a title.
7) Use the “File” pulldown to select “Render” to create the desired video. In the “Render” window just
next to the empty box to the right of the “ffmpeg” file format, click on the down arrow shown there
to see the choices and pick “youtube”. Then move back up to keyin the path and filename to render
to. It will pick all of the defaults automatically for you so then just click on the green checkmark to
have it start. There is a progress bar in the main window, very bottom of the right hand side.
8) Keyin “q” in the main window to get out of Cinelerra and yes or no to save your edit session.
Youtube will allow the upload of the resulting rendered file as named. However, Dailymotion requires
that the file be named with an acceptable extension so you must rename the output file to have the
extension of .webm instead of .youtube.
There are currently 6 specific variations within the ffmpeg (file format) / youtube (file type) for
different video options. You see these when you click on the wrench to the right of the word Video &
then the Compression down arrow in the Video Preset window. The first 3 are based on Webm/Vp9
(credit Frederic Roenitz) and contain basic comments of usage and where to find more information.
The first 3 below, plus any of the VP9 files under the file type of “webm” are the recommended options
to use because they are freely usable in any circumstance.
sd.youtube
hd.youtube
uhd.youtube

Standard Definition use with default audio/Opus stereo.youtube
High Definition
““
Ultra High Definition “ “

Alternatives based on h264 and for non-commercial use are listed below. For Dailymotion, these must
be renamed to have a different extension of .mp4 instead of .youtube before uploading.
sd_h264.youtube
hd_h264.youtube
uhd_u264.youtube

Standard Definition – must change to audio stereo_with_h264.youtube
High Definition ““
Ultra High Definition - “ “

41.8 Repeat Play / Looping Method
There are 2 methods for repeat play or looping on the timeline and 1 method for both the Compositor
and the Viewer. This works in conjunction with any of the transport buttons or shortcuts in either
forward or reverse as usual. The 1 exception is that the Shift button can not be used to either add or
subtract audio within the repeat area.
Shift-L on the Timeline, repeats the selection per the algorithm outlined next. When setup, long green
lines are displayed across the entire set of tracks which shows the start and end of the loop.
1) Highlighted selection repeats loop and takes precedence over all other possibilities. If the cursor
is before the highlighted area, it will play up to the area and then repeat the highlighted section. If
the cursor is after the highlighted section, play will start at the beginning until you get to the
highlighted section and then repeat.
2) When both In and Out pointers are set, it repeats the section between [ and ].
3) If only one of the In or Out pointers is set, it loops the whole media.
.
Ctrl+Shift+transport button on the Timeline, Viewer, and Compositor
1) Repeats entire media if no In or Out pointer set.
2) In and Out pointer set, repeats area between pointers.
3) Only In pointer set, repeats from In to end of media.

41.9 Timelapse Sequence of Images, and Animation
For timelapse sequences, as the size of camera images increases to 70 megabytes and beyond, and
more images can be stored on a memory stick, more cache, memory, and system resources (such as file
descriptors) are used by cinelerra to load the images. This happens when each of the image files is
loaded and concatenated as edits. Therefore, you may need to load these images with an alternative
method. This technique may also be useful for just a bunch of pictures.
As documented, this section can be utilized in some way for the following list of types of “Sequence
files “. The first line of the sequence list file identifies the list codec.
PNGLIST = *.png
EXALIST = *.exa

PPMLIST = *.ppm
CR2LIST = *.cr2

TGALIST = *.tga
JPEGLIST = *.jpg

TIFFLIST = *.tiff

Using the example of jpeg’s, the jpeg list sequence file type is the easiest and fastest way to access a
sequence of jpg images as a single asset. A simple way to build a jpeglist sequence file is to create a
script as shown here and name it jpeglist.sh:
#!/bin/bash
out="$1"
dir=`dirname "$out"`
shift
geom=`jpegtopnm "$1" | head -2 | tail -1`
w=`(set - $geom; echo $1)`
h=`(set - $geom; echo $2)`
exec > $out
echo "JPEGLIST"
echo "# First line is always JPEGLIST"
echo "# Frame rate:"
echo "29.970030"
echo "# Width:"
echo "$w"
echo "# Height:"
echo "$h"
echo "# List of image files follows"
while [ $# -gt 0 ]; do
if [ x`dirname "$1"` = x"$dir" ]; then f=./`basename "$1"`; else f="$1"; fi
echo "$f"
shift
done
Then run this script as follows:
jpeglist.sh outfile infiles*.jpg
For example: jpeglist.sh /<path>/file.jpg /<path>/DSC*.jpg

If <path> is the same on both outfile and infiles, then file.jpg is created in the same directory as infiles,
the directory contains the entire asset, and the file list uses relative paths; otherwise the file list contains
absolute paths. Since this creates outfile list as a single asset, the memory demand and access time is
much lower. When you load the outfile in cinelerra, you will need to set "Try ffmpeg last" since
ffmpeg does not work with jpeglist sequence files.
An example output file from running this script residing in the directory where DSC*.jpg files exist is
shown below. To use this, turn off ffmpeg probes first, and open timelapse.jpg using File->Load files..
Example: timelapse.jpg
JPEGLIST
# First line is always JPEGLIST
# Frame rate:
29.970030
# Width:
6016
# Height:
4016
# List of image files follows
./DSC04948.jpg
./DSC04949.jpg
./DSC04950.jpg
./DSC04951.jpg
… (files in between)
./DSC04997.jpg
./DSC04998.jpg
Alternatively, a different method to open an image sequence is to use ffmpeg's image2 file format. To
do this, create 2 files in the same directory as the DSC*.jpg files named: DSC0%04d.opts, and
DSC0%04d.jpg . DSC0%04d.opts should contain the following lines which have to be modified to fit
your exact requirements for duration, start_number, and frame_rate. Example DSC0%04d.opts :
loglevel=verbose
threads=auto
format=image2
codec=mjpeg
start_number=4948
frame_rate=29.97
duration=17.36
Here is an example of the contents of the file DSC0%04d.jpg :
JPEG
In this case, make sure "Try ffmpeg first" is enabled, and load DSC0%04d.jpg. This will access the
media using ffmpeg which is slower so be patient.

41.10 Information about Backups and Perpetual Session
In an effort to minimize loss of work due to user, hardware, or software issues, cinelerra has some
backup capabilities.
Cinelerra automatically saves every editing operation to the current project on disk continuously to a
file named $HOME/.bcast5/backup.xml. In the unlikely event of a crash, when you restart cinelerra,
you should select File->Load backup in order to continue with the operations that were recorded before
the crash. If you have more than 1 instance of Cinelerra running, only the last editing operation made
in whichever instance it was last made, will overwrite the backup.
There is still 1 more backup that may save you. If for some reason you forgot to use “Load backup”
immediately when restarting, you have a second chance to use File→Load and select $HOME/.bcast5/
backup.prev as long as you only loaded a different file and have performed no editing operations. This
same file is also used by multiple instances of cinelerra.
Perpetual session is very useful for working on a project over many days so you can just quit before
shutting down and the next time you start up Cinelerra you will be right back where you left off. You
will retain all of your undo’s and redo’s. The binary file name is $HOME/.bcast5/perpetual.dat and as
long as Settings→Preferences, the Appearance tab has the Flag “Perpetual session” set this capability
takes effect. It is very important to understand that this is not the same as the continuously editingoperation-updated backup.xml file. The perpetual.dat file is only updated when you Quit cinelerra in
the normal manner. Which means if you interrupt the program, or kill it, or there is a segv or system
crash, the perpetual.dat file will only reflect the state of your project from when you last started
cinelerra and none of the editing/undo’s/redo’s you executed during the current session which was not
ended normally.
Some notes to keep in mind about Perpetual session are:
- when you Quit in the normal manner, it does not have to ask whether or not to save a backup
- takes disk space in .bcast5 area and this could get really big-screen
- after you complete a project, it is advisable to turn off the Perpetual session flag before quitting so
that when you start a new project, you can start with a fresh perpetual.dat by turning the flag on or
after stopping cinelerra, delete the current $HOME/.bcast5/perpetual.dat file
- only session data is backed up (not program feature setup)
- the files backup.xml and backup.prev will operate the same as before so that if there is a crash, you
will want to use File→Load backup in order to continue where you were interrupted.

41.11 Click to Play in Viewer and Compositor
In both the Viewer and Compositor windows, there is an arrow on the right hand side of the other
buttons in the editpanel. Mouse action can be toggled on/off via this arrow, which has a tooltip of
“Click to play” with the letter ‘p’ to be used for a shortcut. When enabled there is a gold-colored
shadow around the usual green-colored arrow. The purpose of enabling this capability is to make it
really easy to play the media in the window by just using the left mouse button to start or stop the play.
The entire main canvas surface becomes a big play button! Although the default is initially off, a good
reason to enable this, at least temporarily, is so that you can quickly review your video before a render.

left click
- forward play or stop forward play if already playing
middle wheel - single frame forward or back
middle click - reverse play or stop reverse play if already playing .Note that some 3 button
mice do not accommodate a middle click for reverse but you can find out by
testing with the command xev.

41.12 Preview Region Usage in the Compositor and Viewer
The timebar in the compositor and the viewer can be used to define a region known as the preview
region. This preview region is the region of the timeline which the slider affects. By using a preview
region inside the entire program and using the slider inside the preview region you can very precisely
and relatively quickly seek in the compositor and viewer. The preview region can be especially handy
when you have large pieces of media by previewing one section, then move to the next section.
The active preview region is the zone between the edge bars. The full range of the window slider
pointer action is down-scaled to the active preview region. To use this, set the preview active region as
a media time region of interest. Now addressing the timebar with the mouse only operates as if the
timebar is zoomed to the scale of the active preview zone. This has the effect of magnifying the
interesting media in terms of the mouse pointer addressing, for fine-tuning.
The arrow above the greencolored “play forward” transport button is on the timebar.

To create and use a preview region, hold down the right mouse button inside the timebar on either end
of the timebar close to the edge until you see a fat arrow. While continuously holding the right mouse
button down, drag the arrow away from the end towards the middle of the timebar until you have the
desired area outlined. The slider will be a light blue color while the selected preview region will
remain the same initial black color.
A left-facing arrow on the
right side of the blue slider
bar is used to drag the bar.
Here you can see the rightfacing arrow used to drag
the other end of the slider
bar. The black area between
is the actual preview area.

You can slide the preview zone left or right by holding the right mouse button over the preview zone
where you will see a fat double headed arrow. The selected area will move left or right as you drag and
still retains the same size.
Note the double-headed fat
arrow in the preview area used
to move the selection over.

Settings:
1) If no preview region is set, increasing the length of the media on the timeline by inserting media or
appending, has no effect on the non-selected preview region. That is, you will not see the blue slider
suddenly mysteriously appear.
2) If the preview region is set, when you replace the current project or file, the preview region is
automatically disabled.
3) If the preview region is set, when you append data or change the size of the current project, the
preview region may appear to either move, shrink, or grow depending on the new length of the
media on the timeline.
4) To disable the preview region, you will have to drag both the right and the left blue slider bars
completely to their corresponding end so that there is no longer any visible
A good method for taking advantage of the preview region is described here. On the main track
canvas, scroll to the beginning of the area of interest. When you do that, you will see in the compositor
the red indicator line of that location. Now in the compositor window, right mouse drag from the left
side of the edge of the timebar to create the blue slider bar line up to the red indicator. Back in the
main track canvas, move to the location of the area you want to end looking and again you will see the
red indicator line in the compositor. Use the right mouse drag from the right to stop at that end point.
Using this method is often easier than continuous usage of the single frame move which can be tedious.
One last interesting item of note – sometimes you may wish to see just a little more that is outside the
preview region and you can do so! You can actually move outside the compositor or viewer window
space and view more, at least until you hit the end of the monitor space.

41.13 Trim Feature with the Drag Handle
The Trim Feature using the drag handle provides some good ways to view your video while editing.
The playback position in the compositor is updated live and the view in the compositor can be split so
that in the left half of the compositor you can see the last frame of the left clip and in the right half the
first frame of the right clip. Dragging edits can not be extended past the beginning or the end.
First familiarize yourself with button operation; check your setup by executing the following step. In
the Settings-> Preferences, Interface tab, Editing section, clicking on the edit boundaries can be set as:
Button 1 - drag all following edits (edit and all following edits)
Button 2 - drag only 1 edit (this edit only)
Button 3 - drag source only (only changes edit playback starting point)
Now to use this feature, create a track with edits that have trims on the left and/or the right. The edit
boundary can be modified using "drag handles" at the boundary between the edits.
Left Mouse Button (LMB) usage:
- If you grab the edit handle from the right side, you will see a left arrow and dragging the boundary
will modify the right edit playback starting time

- If you grab the edit handle from the left side, you will see a right arrow and dragging the boundary
will modify the left edit playback ending time.
- In both cases, the composer will show the edit endpoint of the changed edit.
Shift LMB usage:
- The effect on the edits is the same as described above, but the composer will show a split screen of
the left and right edits as they appear at the drag handle boundary. Dragging will only change one of
the two images, since only one edit is being changed.
Middle Mouse Button (MMB) usage:
- Both the left and the right edit ending/starting times are updated. The image shown in the compositor
will be drawn from the side of the drag grab, that is the left if it is grabbed from the left, and the right
if it is grabbed from the right.
Shift MMB usage:
- The effect on the edits is the same as described above, but the composer will show a split screen of
the left and right edits as they appear at the drag handle boundary. Dragging will change both of the
two images, since both edits are being changed.
Right Mouse Button (RMB) usage:
- the start/end point of the current edit is moved, but the edit length is unchanged only one image
changes since only one edit endpoint is view is updated.
Shift RMB usage:
- The effect on the edits is the same as described above, but the composer will show a split screen of
the left and right edits as they appear at the drag handle boundary. Dragging will only change one of
the two images, since only one edit is being changed.
Screencast showing a split Compositor screen as a result of the Trim Feature.

42. Performance Tips
There are a few ways to get better speed-ups as explained in this section.

42.1 Optimized Playback of Large Format Video – X11 Direct
Normally, when Cinelerra 5 reads a video frame, it is copied into a "Vframe". This frame may also
need other actions performed on it, such as a color model change. In addition, ffmpeg and libzmpeg
"can_scale_input". So the read can be color transformed and scaled just by asking the library to do
that. This means that if the compositor is in a "good" state with no zoom, the VFrame read can be done
in the fastest render color model, and already scaled to the correct size for the compositor. In reality,
this is not what you need for editing, but quite often the "virtualconsole" is not used because the render
is media only – that is “just data”. If no data transforms are needed and the input scaling can be done,
the vrender program detects this, and tells the codec to transmit the data in a compatible way to the
compositor canvas. This is the X11 "direct" data path.
With the X11 video driver choice these large format files, such as 4K, will playback faster than either
X11-XV or X11-OpenGL. However, you still have the option to turn off the X11 direct data path if
you use Settings→Preferences, tab Playback A, set video driver to X11 and uncheck “use direct X11
render if possible”.

42.2 Speed-up of Ffmpeg plugin usage with OPTS files
You can speed up some ffmpeg plugins that are quite time-consuming, such as nlmeans. Cinelerra uses
6 primary rendering color models. All of them have 3 components at full scale. Direct usage of
nlmeans from the ffmpeg command line deals with planar less than full scale chroma (yuv420), which
means there is less data to manipulate. When cinelerra loads a video it uses full scale color models. In
other words:
cinelerra uses "yuv444"
ffmpeg uses "yuv420"
since nlmeans uses filters and many passes over the data, the amount of data is a big factor. If you load
a file in cinelerra with a same_directory_path_and_ filename.opts file containing the following line, the
full scale color modeling upgrade will not be performed until after nlmeans, and then the render is
faster:
video_filter=nlmeans=threads=8
When the file loads, however, it will initially take longer because it is running through the video filter.
The format "rgb" in ffmpeg uses more cpu time. For comparison, the ffmpeg line that would be used:
ffmpeg -i /tmp/filename.mpeg -threads 15 -vf format=rgb24,nlmeans=threads=8 \
-acodec ac3 -vcodec libx265 - y /tmp/x.mp4
This converts the input to rgb before nlmeans runs, and so it too is slower (because there is more color
data). You would ordinarily avoid this conversion by omitting the format=rgb24 parameter.

42.3 Some Settings Parameter Values
“Cache” in Settings→Preferences, Performance tab is used to store images on the timeline. One 1080
frame uses about 10 MB. The default setting is 256 and this is enough for testing and running.
However, why not use more memory if it is available. To experiment for testing a good number tuned
to the way you use your computer, set the cache to 0, bring up cin5, load a typical media file, play it
and run “top” on another terminal window to see how much memory is being used. In the “top”
display, look at "free" memory. Whatever your computer is not using, is a good number to use for
cache. If you start other programs, or change the design of the session so that it uses a lot of frame
storage, you may need to re-experiment over time.
Also in the Performance tab is “Seconds to preroll renders” configurable setting. At this time it is
unknown as to its purpose.
For system “swap” 1 GB sees to be more than sufficient. If the amount of memory being used by the
program is "close", then swap might save you but often if swapping becomes necessary, it presents
more problems and you end up killing cinelerra anyway.

43. Mixer Viewer / Multiple Cameras
Use the Mixer Viewer to see multiple media playing simultaneously in re-sizable mini-viewers. This
can be used in various ways and is useful to edit videos shot by multiple cameras from different
viewpoints that were simultaneously recorded in order to create a single good video. Everything will
have to be initially synced so you can decide which one of the camera angles is best suited at any time.
The number of cameras/mixers you can have is generally limited to the available resources on your
computer. Currently, the number of File Descriptors available in the O/S limits cameras to about 50. If
you have many “mixer viewers” you will probably want to use proxy mode whenever possible. Also,
in the Settings→Playback A tab “Video Out” section. uncheck “play every frame” and choosing a
Video Driver of X11 with “use direct X11 render if possible” checked, will provide better performance.
Screencast below shows 9 media sources in the left corner, the composed video in the right corner, the
timeline with the top video track with pieces of the 9 overwrites, and the choice in Resources of Mixed.

Easiest Method to Getting Started
0) This method assumes all of your media or cameras are aligned the way you want them already.
1) From the File pulldown, create a “New project” with the desired format for Audio and Video output
(or you can just use the default).
2) File->Load the media files you want to work with using “Create new resources only”.
3) In the Resources window, with the Media folder, highlight the list of media you want to “Mix”.
This is done using a ctrl or shift mouse button press as you would in a standard listbox selection.

4) Right click the mouse on the media selection and choose “Open mixers”.
This opens multiple mixer viewer windows, one for each media item that was highlighted. You can
do them 1 at a time instead. This also adds the source media tracks to the main window.
5) Now use the timeline to play and you will see all viewers/cameras playing. Stop when you get to the
end of the “good” camera playback.
6) Simply double click the “good” mixer viewer and from where you first started playing to the
playback insertion pointer is the source section, which will be pasted in the destination
video/audio tracks at the top of the new project.
7) Repeat steps 5-6. Start playing again, stop when you want, double click the desired mini-viewer!
Some Hints and Caveats:
You can easily overwrite a section of the new track by “selecting” a section on the timeline, then
double click on one of the mini-viewers to overwrite/replace that section.
If you edit the output tracks, it only edits output tracks, and the input tracks may no longer be lined up.
You can add a silent section by selecting past a section and start overwriting that section from then on.
If you use the cursor hairline to create the selection endpoint, it must be past the end of the destination.
The compositor shows composed media. This is the media that will be rendered.
The program always uses overwrite as the paste operation.
Use the timeline edit handles to move the start and end points of that section.
Only middle mouse drag handle operations should be used normally.
Other drags will displace the media source/destination timeline correspondence.
To re-tile the mixer windows after you have resized and moved them around, you can use the Window
pulldown of “Tile mixers” or the shortcut of Alt-t.
But, I want to use only the first set of audio tracks…
There are many cases where you may want to compose using media from several different tracks while
using the the same audio tracks as associated from a specific viewer. Since mixer source tracks can be
updated any time by using a mixer toggle, this makes it possible to do this.
Procedure to update the mixer audio source track list:
1) Single click to highlight the mixer window you want to re-associate to the audio track.
2) In that audio track’s patchbay click the expand toggle, the arrow on the right side.
3) In the expanded pane that appears, there is another arrow on the left side. This icon has the tooltip
of
“Mixer”. Click this and because in step #1 you highlighted the mixer window, it will now be toggled
on. Once you click the mixer icon it will then point up.
4) Now, disassociate any audio that is unwanted by expanding its patchbay and toggling off the mixer.
Expert Usage:
When you double click a mixer viewer window, it operates an “overwrite” paste operation. This moves
src (source) track edits to dst (destination) track edits over the same selected timeline region.
Src tracks should be not playable and not armed in the main window patchbay gui.
Dst tracks should be playable and armed in the main window patchbay gui.
Each mixer viewer maintains a list of the tracks which will be used as src. This list is made visible
selecting the window with the left mouse button. When the mixer viewer is selected, a highlight is

drawn around the media image. All track patchbay “mixer” toggles are updated to reflect the src tracks
included in the selected viewer src track list. The track patchbay toggles can be used to manage the list.
Turning on a toggle (pointing up) includes the track in the src track list.
Turning off a toggle (pointing right) removes the track from the src track list.
New Mixer viewers can be created using the main menu Window→Mixer Viewer, or with a shortcut of
Shift-M. When a new viewer is created, the currently enabled patchbay “mixer” toggles are used to
create the viewer source track list. The toggles are cleared after the window is created. This is to
improve the work flow. Use the following list of steps to create individual mixer viewers.
To create a list of mixer viewers:
1) Setup the session settings→format, width, height, frame rate, color model, aspect ratio.
2) Create dst tracks using the a/v track pulldowns (or use shortcuts ‘t’ / ‘T’), armed and playable.
3) Append src tracks using file→open → append tracks, or the resource window using pasting.
4) Using the track patchbay, disarm editing and disable playback of the a/v src tracks.
5) Using the track patchbay, mark the new tracks as “mixer” source to be added to the viewer.
6) Create a mixer viewer using the main menu pulldown, or the shift “M” shortcut.
7) Repeat steps 3 – 6 for each mixer viewer needed for the session editing.
When you single click a mixer window, it becomes selected and highlighted and all of the patchbay
mixer toggles are updated to reflect the state of the viewer’s src tracks. Tracks that will be src are
shown as enabled. If you change a toggle, the src tracks for the selected window will be modified.
This means you can associate or dis-associate any media track to any mixer window.
When you double click a mixer window, an overwrite paste is invoked. The mixer viewer’s src tracks
are overwritten to the dst tracks. The timeline region for both the source and destination are the same
for the overwrite paste function. The selection region is used if it is active. If the selection is empty,
that is it is a hairline, the selection region is from the end of the destination playable edits to the
selection cursor hairline. The hairline must be past the end of the playable edits on the destination
tracks.
The mixer viewer configuration is saved with the session data. When a saved session is loaded in
“replace project” or “replace project and concatenate tracks”, the mixer viewer will be reopened.
Using Proxy with “Open Mixers”
The best way to use proxy with your multiple cameras is to follow the steps below:
1) Load media with insertion strategy of “create resources only”.
2) Highlight the media in the Resources window and right click on this to choose “open mixers”.
3) Use the Settings pulldown and choose “Proxy settings...” to bring up the proxy menu.
4) Choose the size and other options you want and click the checkmark OK.
If you choose the option “Beep when done” you will hear a short beep if all media is already
proxied or a longer beep when all proxies have been created.
5) When your editing is complete, use Settings pulldown and proxy to “original size”.

44. Render Farm Usage
Render Farm uses background rendering, a feature of Cinelerra where the video is rendered in the
background, to speed up rendering significantly. Because rendering is memory and cpu intensive,
using multiple computers on a network via a render farm is a significant gain. With Cinelerra installed
on all nodes, the master node and the clients communicate via a network port that you specify.
Cinelerra can distribute the rendering tasks over the network to the other computers of the Render
Farm. The render farm software tries to process all of the rendering in parallel so that several
computers can be used to render the results. The "Total jobs to create" in the setup or labels on the
timeline are used to divide a render job into that specified number of tasks. Each background job is
assigned a timeline segment to process and the jobs are sent to the various computer nodes depending
upon the load balance. The jobs are processed by the nodes separately and written to individual files.
You will have to put the files back together via a load with concatenation or typically by using a
command line tool from a script.

Basic Steps to Start a Render Farm
The following steps are just a guideline to start your render farm. It is assumed that you already have
the master and client nodes communication, shared filesystem, permissions and usernames synched.
1) On the master computer, use Settings→Preferences, the Performance tab to set up a Render Farm:
a) check the “Use render farm” box
b) in the Hostname box, keyin your hostname or ip address such as 192.168.1.12 or localhost;
c) enter in a port number such as 401-405 or 1025 and click on Add Nodes;
d) you will see something like the following in the Nodes listbox to the right:
On
X
X
X
X
X
X
X

Hostname
192.168.1.12
192.168.1.12
192.168.1.12
192.168.1.12
192.168.1.12
localhost
localhost

Port
401
402
403
404
405
406
407

Framerate
0.0
0.0
0.0
0.0
0.0
0.0
0.0

e) set the Total number of jobs to create;
f) click OK on the bottom of the Preferences window.
2) On the client computers (192.168.1.12), start 5 background cinelerra tasks via:
cd /{path_to_cinelerra}
cin -d 401
cin -d 402
…
cin -d 405

3) On the master node (localhost), start the 2 background cinelerra tasks via:
cd /{path_to_cinelerra}
cin -d 406
cin -d 407
4) When your video is ready, setup a render job via File “Render” or “Batch Render” and check OK.
5) The results will be in the shared file path / filename that you selected in the render menu with the
additional numbered job section on the end as 001, 002, 003, … 099 (example, video.webm001).
6) When finished, load your new files on new tracks via File→Load “concatenate to existing tracks”
or if you used ffmpeg, run RenderMux from the Shell Scripts icon.
7) If you plan on doing more rendering, you can just leave the master/client jobs running to use again
and avoid having to restart them. Or you can kill them when you no longer are using them.

Render Farm Menu and Parameter Description
The screen cast below shows the menu used to set up your Render Farm using Settings→Preferences.

Project SMP cpus - although this field is not Render Farm specific, it is useful for Cinelerra to have the
cpu count and for using multiple threads.
Use render farm - check this to turn on the render farm option. Once checked ALL rendering will be
done via the farm including the usual Render (Shift-R). You may want to turn if off for small jobs.
Nodes listbox - displays all the nodes on the render farm and shows which ones are currently enabled.
The Nodes listbox has 4 columns – On, Hostname, Port, Framerate – which show the current values.
An X in the “On” designates that that host is currently enabled; Hostname shows the name of the host;
Port shows the port number that host uses; and Framerate will either be zero initially or the current
framerate value.
Hostname - this field is used to edit the hostname of an existing node or enter a new node.
Port - keyin the port number of an existing or new node here. You can also type in a range of port
numbers using a hyphen, for example 1501-1505 when you need to add many.
Apply Changes - this will allow you to edit an existing node and to then commit the changes to
hostname and port. The changes will not be committed if you do not click the OK button.
Add Nodes - Create a new node with the hostname and port settings.
Sort nodes - sorts the nodes list based on the hostname.
Delete Nodes - deletes whatever node is highlighted in the nodes list. You can highlight several at once
to have them all deleted.
Client Watchdog Timeout - a default value of 15 seconds is used here and the tumbler increments by 15
seconds. A value of 0 (zero) disables the watchdog so that if you have a slow client, it will not kill the
render job while waiting for that client to respond.
Total jobs to create - determines the number of jobs to dispatch to the render farm. Total jobs is used to
divide a render job into that specified number of tasks. Each background job is assigned a timeline
segment to process. The render farm software tries to process all of the rendering in parallel so that
several computers can be used to render the results.
To start, if you have computers of similar speed, a good number for “Total jobs to create” is the number
of computers multiplied by 3. You will want to adjust this according to the capabilities of your
computers and after viewing the framerates. Multiply them by 1 to have one job dispatched for every
node. If you have 10 client nodes and one master node, specify 33 to have a well balanced render farm.
(overridden if new file at each label is checked) – instead of the number of jobs being set to “Total jobs
to create”, there will be a job created for each labeled section. If in the render menu, the option “Create
new file at each label” is selected when no labels exist, only one job will be created. It may be quite
advantageous to set labels at certain points in the video to ensure that a key portion of the video will not
be split into 2 different jobs.
Reset rates - sets the framerate for all the nodes to 0. Frame rates are used to scale job sizes based on
CPU speed of the node. Frame rates are calculated only when render farm is enabled.
Framerates can really affect how the Render Farm works. The first time you use the render farm all of
the rates are displayed as 0 in the Settings→Preferences Performance tab in the Nodes box. As
rendering occurs, all of the nodes send back framerate values to the master node and the preferences
page is updated with these values. A rate accumulates based on speed. Once all nodes have a rate of
non-zero, the program gives out less work to lower rated nodes in an effort to make the total time for
the render to be almost constant.
Initially, when the framerate scaling values are zero, the program just uses package length – render size

divided by the number of packages to portion out the work (if not labels). If something goes wrong or
the rates become suspect, then all of the rest of the work will be dumped into the last job. When this
happens, you really should “reset rates” for the next render farm session to restart with a good balance.
{cinelerra pathname} -h displays some of the options.

Detailed Setup Description
CAUTION, any exact command lines worked as of 1/2018 on a Fedora system. These can change over
time and on different operating systems/levels. Always check/verify any command line before using.
1) Set up Cinelerra
A Cinelerra render farm is organized into a master node and any number of client nodes. The master
node is the computer which is running the gui. The client nodes are anywhere else on the network with
Cinelerra installed and are run from the command line. Before you start the master node for Cinelerra,
you need to set up a shared filesystem on the disk storage node as this is the node that will have the
common volume where all the data will be stored.
The location of the project and its files should be the same in the client computers as in the master
computer and to avoid problems of permissions, it is better to use the same user in master and clients.
For example, if you have the project in /home /<user>/project-video you must create the same directory
path on the clients, but empty. Sharing the directory of the location of your project on the master
computer can be done with NFS as described next. Alternatively, you can look up on the internet how
to use Samba to share a directory.
2) Create a shared filesystem and mount using NFS
All nodes in the render farm should use the same filesystem with the same paths to the project files on
all of the master and client nodes. This is easiest to do by setting up an NFS shared disk system.
1) On each of the computers, install the nfs software if not already installed. For example, on Debian 9
you will need to run: (be sure to check/verify before using any command line):
apt-get install nfs-kernel-server
2) On the computer that contains the disk storage to be shared, define the network filesystem. For
example to export /tmp, edit the /etc/exports file to add the following line:
/tmp 192.168.1.0/24(rw,fsid=1,no_root_squash,sync,no_subtree_check)
3) Next reset the exported nfs directories using: exportfs -ra
and you may have to start or restart nfs:
systemctl restart nfs
4) Each of the render farm computers must mount the exported nfs target path. To see the exports
which are visible from a client, login as root to the client machine and keyin:
showmount -e <ip-addr> using the ip address of the storage host

5) to access the host disk storage from the other computers in the render farm, mount the nfs export on
the corresponding target path: (be sure to check/verify before using any command line):
mount -t nfs <ip-addr>:/<path> <path>
where <path> is the storage host directory, and <ip-addr> is the network address of the storage host.
Because all of the computers must have the same directory path, create that same directory path with
the same uid/gid/permissions on each storage client computer ahead of time.
6) To make this permanent across reboots on the client nodes, add the following line to /etc/fstab:
{masternode}:/nfsshare /mnt nfs defaults 0 0
You can make this permanent on the disk storage host BUT the command lines shown, which were
correct in January 2018 on Fedora, may be different for your operating system or in the future. In
addition if your network is not up, there may be numerous problems. If you make a mistake, your
system may not boot. To make permanent, add the following line to /etc/fstab:
192.168.1.12:/tmp /tmp nfs rw,async,hard,intr,noexec,noauto 0 0
You will still have to mount the above manually because of the “noauto” parameter but you won’t
have to remember all of the other necessary parameters. Depending on your expertise level, you can
change that.
Later, to remove access to the storage host filesystem: umount <path>
Be aware that you may have to adjust any security or firewalls you have in place. Most firewalls will
require extra rules to allow nfs access. Many have built-in configurations for this.
3) Configure Rendering on Master Node
There is 1 master node which is running the Cinelerra gui and where the video will be edited and the
command given to start up the rendering. Any number of client computers can be run from the
command line only, so they can be headless since no X or any graphical libraries are needed. Of
course, the cinelerra software must be installed on each of the client computers.
1) Assuming you already have Cinelerra installed on the master node, start Cinelerra by clicking on the
icon or by typing the following command on the terminal screen: /{cinelerra_path}/cin .
2) Use the file pulldown Settings→Preferences, the Performance tab, to set up your Render Farm
options in the Render Farm pane.
3) Check the “Use render farm” option. By default, once you enable the option of Render Farm,
rendering is usually done using the render farm. Batch rendering can be done locally, or farmed.
4) Add the hostname or the IP address of each of the client nodes in the Hostname textbox and the port
number that you want to use in the Port textbox. You can make sure a port number is not already in
use by keying in on the command line: netstat -n -l -4 --protocol inet. Next, click on the Add Nodes
button and then you will see that host appear in the Nodes list box to the right. The ‘X’ in the first

column of the nodes box denotes that the node is active. To review the “standard” port allocations,
check the /etc/services file.
5) Enter the total jobs that you would like to be used in the ‘Total jobs’ textbox.
6) The default watchdog timer initial state is usually just fine but can be adjusted later if needed.
7) Click OK on the Preferences window when done.
4) Create Workflow
While working on the master computer, it is recommended that you keep all the resources being used
on the same shared disk. Load your video/audio piece and do your editing and preparation. Add any
desired plugins, such as a Title, to fine-tune your work. You want to make sure your video is ready to
be rendered into the final product.
5) Start the Client Nodes
To start up the client nodes run Cinelerra from the command line on each of the client computers using
the following command:
/{cinelerra_pathname}/cin -d [port #] ; for example /mnt1/bin/cinelerra -d 401
This starts cinelerra in command prompt mode so that it listens to the specified port number for
commands from the master node for rendering. When you start each of the clients up, you will see
some messages scroll by as each client is created on that computer, such as:
RenderFarmClient::main_loop: client started
RenderFarmClient::main_loop: Session started from 127.0.0.1
As it completes its jobs, you will should see:
RenderFarmClientThread::run: Session finished.
A quick way to start a sequence of clients is to use:
for n in `seq 1501 1505`; do cin -d $n; done
6) Render Using Render Farm
After you have followed the preceding steps, you are ready to use the render farm. Click on
File>Render… which opens the render dialog. The most important point here is to use for the “Output
path / Select a file to render to” a path/file name that is on the shared volume that is also mounted on
the clients. Click on OK to render. The cinelerra program divides the timeline into the number of jobs
specified by the user. These jobs are then dispatched to the various nodes depending upon the load
balance. The first segment will always render on the master node and the other segments will be farmed
out to the render nodes. Batch Rendering, as well as BD/DVD rendering, may use the render farm.
Each line in the batchbay can enable/disable the render farm. Typically, video can be rendered into
many file segments and concatenated, but normally audio is rendered as one monolithic file (not
farmed).

Another performance feature which can use the Render Farm is “Background Rendering”. This is also
enabled on the Performance preferences tab. The background render function generates a set of image
files by pre-rendering the timeline data on the fly. As the timeline is update by editing, the image data
is re-rendered to a “background render” storage path. The Render Farm will be used for this operation
if it is enabled at the same time as the “background render” feature.
7) Assemble the Output Files
Once all of the computer jobs are complete, you can put the output files together by using the shell
script, RenderMux (from the menubar “scripts” button just above FF), if the files were rendered using
ffmpeg, or you can load these by creating a new track and specifying concatenate to existing tracks in
the load dialog in the correct numerical order. File types which support direct copy can be
concatenated into a single file by rendering to the same file format with renderfarm disabled as long as
the track dimensions, output dimensions, and asset dimensions are equal.

Quick and Easy Render Farm Setup – The Buddy System Way
These steps are for quickly setting up render farm with the least amount of additional system work, but
it is non-optimal. It is useful in situations where a few people all show up with their laptops to work
together on the same video/audio file and you don’t want to bother setting up NFS for a shared disk.
1) Make sure the Cinelerra program is installed on all of the computers and the network between the
main computer and the client computers is working. Use the same version if possible.
2) Load your video file on the master node and use “File→Save as...” to save it to /tmp .
3) Move that same file with the same name to /tmp on all of the client computers via rsh or sneaker net
– the ONLY reason you are doing this is to avoid having to set up NFS or Samba on the buddy client
laptops that show up!
4) Edit your video/audio file to get it the way you want it and add the plugins, such as a Title, etc.
5) Check for a set of unused ports in /etc/services file, if username is root usually 401-425 are
available; if non-root, then 1024-1079.
6) On the master computer, in Settings→Preferences, the Performance tab
a) check the box “Use render farm”
b) keyin localhost for the hostname or an ip address of the buddy client node
c) keyin the desired port number for each client; and use “Add Node” for each host
d) set total jobs to the number of client computers+1 multiplied by 3 (or proportion to client speeds)
e) check OK
7) On each buddy client, create a job for each port: /{cinelerra_pathname}/cin -d port#
8) On the master, bring up the render menu and name the output files, for example /tmp/myoutput.mp4.
9) The client nodes output results will be on their local /tmp filesystems so you will have to again use
rsh/ftp or usb sneaker net to move them over to the main computer. File names will be the render
job output file name with port number tacked on ( e.g. /tmp/hb.mp4001...mp4005).
10) Load the files by concatenate to existing track on the master node or use RenderMux shell script.

Multi-core Computers Render Farm Setup (the “Epyc” method!)
If you are lucky enough to have a computer with a large cpu core count, setting up a render farm can
really take advantage of using all of the cpus. This is much faster than the default automatic threading

capability. Since you don’t need to communicate with other computers, you will not have to be
concerned about TCP communication or shared disks/files. The screencast below shows setup of the
render farm on a 16-core processor computer. Since you may be doing other work simultaneously
while rendering a large job, you will want to leave some of the cpus available for that.

Be sure to set "Project SMP cpus:" in the Performance tab window to 16 (or whatever).
Sharing Index Files
Because index files speed up displaying the video you may want to share these files with the clients on
a shared filesystem. There is a configuration option available in Settings→Preferences, the Interface
tab, that sets up in your preferences the location of the index files which you can put on a shared disk.
Screencast below shows part of the Preferences menu where you can change the index files setup.

Or, one of the convenient features of cin5 is the redirection of the path via CIN_CONFIG as in:
CIN_CONFIG=/<shared_file_pathname>/<filename_such_as_.bcast5> /<cinelerra_pathname>/cin .
This means that you can make project related configurations that do not impact the default $HOME
config. You can either export your default $HOME config or the CIN_CONFIG config to use on the
render farm.

Troubleshooting Tips
If you have problems running the Render Farm. Here is a list of items to check.
- Cinelerra must be installed on the master node and all client machines.
- It is best to have the same username available on all nodes to avoid problems with access rights.
- Check file permissions and ownership to ensure that the clients all have access.
- If a node does not have access to an input asset it will not die, but just display error messages.
- If a node can not access an output asset, the rendering will abort.
- A port in use when stopped may take up to 30 seconds to time out before you can restart the jobs.
- Each of the port combinations have to be unique across clients, and not already in use in the network.
- Cinelerra load balances on a first come, first serve basis. If the last section of the video is sent to the
slowest node, the render job will have to wait for the slowest node to finish. It would be better to
start on the slowest node with the earlier section of the video so keep that in mind when designating
port numbers.
- If not running as root, a port number in the higher range of 1024 and above must be used instead of
the 400+ range.
- The master and client jobs on the ports do not go away so if you want to stop them, you will have to
kill them via: kill PID# .
- Check to see if there are services listening on the ports to use: netstat -n -l -4 --protocol inet .
- There is a watchdog timer in Cinelerra and if there is no response from a client in the designated
number of seconds, it will kill the render job.
- The "localhost" should exist as 127.0.0.1 in /etc/hosts and as the "lo" network device in ifconfig.
- If the job loads become unbalanced, you may want to “reset rates” to start over for new framerates.
- If jobs are split in a key section on the timeline, you may wish to “use labels” to prevent this.
- For testing purposes, you may want to start a client in the foreground using “-f” instead of “-d”.
- If one of the client computers is unavailable, check to see if there is an X to the left of the nodename
in the Nodes listbox. Check the X to disable it which sets On to Off.
- A red message in the lower left hand corner of the main timeline that reads “Failed to start render
farm” often means that the client cinelerra programs were not started up.
- A message of “RenderFarmWatchdog::run 1 killing server thread #address#” means that the client did
not respond in time. You can adjust the timer in Settings→Preferences, Performance tab.
- When you get the message “RenderFarmClient::main_loop: bind port 400: Address already in use”,
use a different port.
- A message of “RenderFarmServerThread::open_client: unknown host abcompany” means that the
hostname of abcompany is not in /etc/hosts so you will have to add it or use the ip address instead.
- There are numerous error messages associated with file open/close/status or problems with the file
that should be dealt with according to what is printed out.
- Other illustrative messages may be shown such as: "RenderFarmClientThread::run: Session finished.
Warnings
If one of the render farm computers is connected to the internet, you should use a firewall to maintain
the safety of all of the computers. The ports have to be reachable for the intranet but you do not want
the ports to be open to the outside.

45. User Folders/Bins
Creating folders that are more specific to a particular project is helpful in better organizing your work.
This can be done by utilizing the files already loaded to the “master” Media or Clips folders in the
Resources window. Below are steps illustrating an easy way to set up a folder.
1) In the Resources window, in the location of the Video/Audio effects and Media folders, bring up the
“Folder...” popup by clicking the right mouse button. Highlight, then click “New Media or Clips”.

2) In the “New folder” popup as
shown below, type in your folder
name in the textbox. Click OK.

^
“Modify folder” can be used to ||
change the name of a folder.
“Delete folder” in the popup can be
used to delete a folder.
3) Select the “master” Media folder
to see which files are currently
loaded. Highlight the files there that
you want to copy to your new folder
(named Photos of Garden seen in
this screencast). Drag the files to the
left and when you see the Photos of
Garden folder become highlighted,
then drop there. You can drag and
drop any of the media from the
“master” Media at any time. It
flashes when the drop is successful.
Adding the Shift key before the actual drop, will allow for relative path filenames instead of full path.

But you might want to include or eliminate some of the media that exists in one of the folders that you
have set up already. In this case you will want to click on the “Modify folder” in the popup. When you
bring up the Modify folder window, if you already have files in that folder, you will see filters that were
generated automatically when you did a Drag and Drop.

Here is the filter that was
generated with the
original drop –>

When you click on the
Value portion of that
filter, the entire set of
files that are covered by
the filter rules pops up.
Now you can highlight a
target filename that you
would like to remove,
and just erase that line
and check the green
checkmark for OK.

To delete the entire set of files listed on the filter rule, highlight the rule line and hit the “Del” button.
To add a new filter rule, click on the “Add” button which will automatically add a default line after any
current lines. The default line will be a line that matches everything in the “master” Media folder
which is “Or Patterns Matches *”. Click the right mouse button on the current field underneath the
column header to see the choices available for each column.
Modifications will not be in effect until you click on the green arrow OK button or click on the Apply
button. But once you hit Apply, clicking on the red X button will not undo your changes. The
filter/search rules are applied in the order listed in the Modify folder window. You can change the
order of the filter rules by highlighting the rule you want to move and then drag and drop to a new
location.

The screencast below displays the available choices for each field.

Information about the columns and rules for the search filters in the Modify folder window follows.
Column headers:
Enable – this column is used to designate the state of that filter rule
Off
disable the filter
And
narrow your search; all of your search terms must be present
Or
broaden your search to include more values
And Not
exclude terms that do not contain the given value from your search results
Or Not
include terms that do not contain the given value from your search results
Target – this column designates which media asset attribute to look at
Patterns
each line contains a filename filter, matches the file path
Filesize
number of bytes in a file
Time
date file was created
Track Type track type of video, audio, or audio video (for both)
Width
Format width
Height
Format height
Framerate Video framerate
Samplerate Audio samplerate
Channels Number of audio channels
Duration
Playback time in seconds – it uses the largest of audio or video if contains both

Op – boolean operators used to narrow or broaden the relationship between your search terms
Around
about this value; use “+radius” for a search range: [target–radius ... target+radius]
Eq
equal to
Ge
greater than or equal to
Gt
greater than
Ne
not equal
Le
less than or equal
Lt
less than
Matches
exactly matches for strings
Value – the characteristic you are looking for with expressions that can be written with the following:
Number (decimal points are allowed and will be converted to a standard form):
inf – representing infinity
#[TtGgMmKk] - where # represents a number and the characters mean:
inf = infinity
T = 1099511627776
t = 1000000000000
G = 1073741824
g = 1000000000
M = 1048576
m = 1000000
K = 1024
k = 1000
Scalar:
Number
Number+Number
Date time:
date = year/month
date = year/month/day
time = hour:minute
time = hour:minute:second
date_time = date time
Duration:
day =
#day
| #days
week =
#week | #weeks
month =
#month | #months
year =
#year | #years
delta = secs
delta = mins:secs
delta = hours:mins:secs
Around time:
date time+duration

Around length:
duration+duration
Table showing the allowed usage:
target:
| eq ge gt ne le lt
matches around
++++++++++++++++++++++++++++++++++++++++++++++++++++++++
patterns
| <---- strcmp ---------> + filter + nearest
file_size | <---- arithmetic -------+------> + radius
mod_time
| <---- arithmetic -------+------> + radius
track_type | <---- member test ------+--------+------>
width
| <---- arithmetic -------+------> + radius
height
| <---- arithmetic -------+------> + radius
framerate | <---- arithmetic -------+------> + radius
samplerate | <---- arithmetic -------+------> + radius
channels
| <---- arithmetic -------+------> + radius
duration
| <---- arithmetic -------+------> + radius

where in the above, the filter can be:
filter=list
filter=token
list=[token]
list=[token]list
string=<chars>|<empty>
token=string
token=string*token
Examples with some caveats first:
1) “Or” generally includes or adds whereas “And” generally excludes or subtracts.
2) The filters only work on media in the folder; if there is no media, then there is nothing to search.
3) The examples below are not meant to be executed as a list of filters in Modify folder, they are just
single line examples to indicate what can work.
4) Sort is by filename base name (directory path not included automatically) except when the
“Around” operation is used and then it is sorted by that Target distance first and then filename.
Enable
Or
And Not
Or Not
And
Off
And
Or
Or

Target
Patterns
Filesize
Time
Duration
Samplerate
Framerate
Patterns
Time

Op
Matches
Lt
Ge
Eq
Ne
Around
Matches
Around

Value
- meaning
*
- all files from the Media folder are included
160000000 - no files that are less than 160MB in size
2018/07/30 06:13:00 - files not greater than or equal date
01:00
- files included must have 60 secs. Duration
44000
- off for now, but may want to include later
24+1
- files included all have 24 to 25 framerate
[*.mp4]
- all files with the extension of mp4
2018/08/02 06:00:00 + 02:00:00 - files at 4AM to 8 AM

APPENDIXES
Appendix A: Crash Handling Tips
This section is a handy guide for describing various kinds of software computer system failures. Only
some of these various lockups or crashes can be dealt with. Hopefully, it will help to have some hints
to know what kind of failure it is, or to save your work or to avoid future problems. For most of this,
your name must be root, although you can certainly try to see if it works for you when not root.
System lockups:
When the system locks up, it is usually a system problem. Normally an application program cannot
hose the system. It is a major goal of system design to prevent an application (app) from failing a
system interface. This does not mean an app can't mess things up.
Cinelerra crash:
This is covered in Section 6 – Crash Dumps for Analysis. Just a reminder that you must be root and by
providing a crash dump and as much other information as possible, you will be helping the developer to
analyze the problem and fix it so that it can be avoided in the future.
X Server crash:
Keyboard does not respond, screen is frozen, caps lock may operate LED light. Sometimes using ctrlalt-F1 ... ctrl-alt-F7 (etc.) will allow you to regain control of a VT console. You can use this to login
and check logs: eg. /var/log/Xorg.0.log, dmesg, journalctl … etc. If you have another computer, make
sure a terminal server is configured (for example: rsh, ssh, or telnet), then remote login via this other
computer and check the logs. Most important is to immediately note the current software state, and the
very last thing that preceded the crash, i.e. last button click, last keystroke, … or whatever.
Kernel crash:
The machine goes completely dead. The keyboard caps lock LED will probably be flashing. Most
likely the only way to see anything after the kernel crashes is to use a serial port console log and
usually kdb, the kernel debugger, and special cabling. This requires a lot of setup, and is normally
reserved for experts. Login from another computer will not work. Pinging the ip address will not
respond since the network stack is part of the kernel. There are some virtual machine setups that will
let you debug a “guest” kernel, but this also requires a lot of setup, and affects which kernel is currently
under test. The kdb route is preferable.
Keyboard grabs, Server grabs, and Deadlocks:
A grab is an X-server state where all events are forced to just one window event stream. This forces the
user to respond to the dialog. Things seems to be working, but no keypresses do anything useful.
The system clock and other programs will still be working. The network will work for remote logins.
Grabs can be canceled if the /etc/X11/xorg.conf X config contains special setup as shown below:
Section "ServerFlags"
Option
"HandleSpecialKeys" "Always"
Option
"AllowDeactivateGrabs" "True"
Option
"AllowClosedownGrabs" "True"
EndSection

Section "InputDevice"
Identifier "Keyboard"
Driver
"evdev"
...
Option "XkbOptions" "terminate:ctrl_alt_bksp"
Option "XkbOptions" "grab:break_actions"
EndSection
or to $HOME/.xinitrc, add:
# xkb terminate/grab actions disabled in xorg.conf, use:
setxkbmap -option "grab:break_actions"
setxkbmap -option "terminate:ctrl_alt_bksp"
ctrl-alt-bksp = terminate the X-server, may restart automatically
If your system is running in runlevel 5 (you might be at runlevel 3 for development), it also allows the
user to cancel a keyboard grab using:
ctrl-alt-keypad-* = ungrab
ctrl-alt-keypad-/, = ungrab, kill grab owner process
Modal forms (always on top, and usually ptr/kbd grab) dialog boxes can hose a system by putting a
form over another form holding a grab. This means the form that needs input may never get any, and
the effect is a deadlock. Usually you will have to restart X (ctrl-alt-bksp).
Window Manager issues:
The "desktop" window manager can intercept and modify all kinds of user input. Mostly, this is a good
thing, but can be a nuisance. If user keypresses can be programmed to trigger actions, then they may
be useful to send KILL or INTR to an app that seems to be holding X's attention. For example:
killall -INTR cinelerra, killall -9 cinelerra,
killall X, but you must run as root to be able do this
The ALT and META keys may be intercepted by the window manager, and this can cause unexpected
interface operation.

Appendix B - Developer's Section
B.1 How Builds Really Work and Even More Options
This section describes how builds really work if you want to know more about making changes or
understanding the process probably only for a developer or system administrator.
Builds occur in 4 basic steps:
1) unpack/patch source code

2) configure build
3) make build targets
4) installation
So, an example of what happens in 4 steps for a single-user build would be as follows:
1) unpack/patch source code
git clone –depth 1 “git:/…/target” cinelerra5
./autogen.sh
2) configure build
./configure –with-single-user
3) make build targets
make 2>&1 | tee log
4) installation
make install
A lot of things can be tweaked to change the results. Mostly these changes are parameters to the
configure step, which can change important build related items, like the application name, or where and
what the target system directories should be. This makes it possible to have several versions at the
same time on the same computer if needed. To see what it is that the makefiles use to build cinelerra,
look at the resulting toplevel global_config file which is created by the ./configure step.
Building cinelerra requires many thirdparty libraries, and it is recommended that you use the static
build version included in the git repo. Some of them are patched, and fix significant bugs. It is
important to note that because system installation historically has been with as many shared objects as
possible, the defaults are that any system library detected during configuration setup will be used, when
the package is built “--without-single-user”, which is the default build. To build with static thirdparty
libraries for system install to the system /usr area, use:
.configure --enable-static-build –prefix=/usr
Sometimes, additional package parameters and variables are needed during thirdparty builds. These
optional values occur before and after the “configure” and “make” commands during a build. A
presentation of the format of the package qualified variable names and how they appear in the build
procedure are:
pkg.cfg_vars
pkg.cfg_params
pkg.mak_vars
pkg.mak_params
pkg.cflags
pkg.cppflags

prepended to configure
appended to configure
prepended to make
appended to make
added as CFLAGS+=$(cflags) to pkg.vars
added as CPPFLAGS+=$(cppflags) to pkg.vars

These steps are done for EACH of the packages in the thirdparty build:
<pkg.cfg_vars> ./configure <pkg.cfg_params>
<pkg.mak_vars> make <pkg.mak_params>

The thirdparty Makefile has a set of default vars and params used to build each of the needed thirdparty
packages, but you can specify new or overriding values for these Makefile substitutions. These
thirdparty build config changes are specified in the toplevel file: cin_config. By using this file, you can
save the configuration changes made for the current build to use the next time you do a new build. For
example, to add an include file path to the giflib build, add this line to cin_config:
giflib.cflags := -I/usr/local/include/giflib5
To have a param/var change apply to all thirdparty builds, use:
CFG_VARS, CFG_PARAMS, MAK_VARS, MAK_PARAMS
CFLAGS, CXXFLAGS and LDFLAGS are forwarded to the thirdparty build environment via:
CFLAGS=-ggdb ./configure --with-single-user
However, there is no guarantee that the thirdparty build will honor the environmental flags.
Finally, there are build controls, which enable/disable and set build features.
A few of the more useful ./configure --parameters are:
--with-jobs=n
where n=number of build jobs; defaults to 1.5*cpus+2.
--enable-static-build build all 3rd party libs; defaults to yes if single-user, else no.
--with-single-user
build installs to <build_path>/bin; no system installation.
The ./configure command builds “global_config”. The global_config is read by the thirdparty/Makefile
to create the recipes and definitions used by the thirdparty build.
There are a lot of different options. Thirdparty library build control is available in the configure step of
the build. Thirdparty libraries are built on a demand basis. So if you use:
--enable-libname=auto # the static-build enable, or the lack of a system library causes a build
--enable-libname=yes # this forces the thirdparty build
--enable-libname=no # this forces no thirdparty build
Ffmpeg is a “strongly connected component” in the build linkage and widely influences the cinelerra
library demands. It is possible to make small additions to the ffmpeg configuration step using the
environment varaiable FFPMEG_EXTRA_CFG. For example, to eliminate the use of libvdpau (an
nvidia support library) in the ffmpeg configuration step after you have determined that it is causing an
error, use:
make clean
autogen.sh
export FFMPEG_EXTRA_CFG=" --disable-vdpau"
./configure …

B.2 Thirdparty Parallel Build
The Makefile in the thirdparty build directory employs a set of macros used to create a build rule set of
thirdparty library build dependencies. The standard build sequence of [source, config, build] is used to
prepare thirdparty products as static libraries. Build package dependency can be specified in the
Makefile std-build macro call. These Makefile macro calls define the rules used for each thirdparty
build. The expanded rule definitions may be viewed by using:
make -C thirdparty rules
Individual package libraries can be rebuilt, via:
make -C thirdparty <pkg>-clean; make -C thirdparty <pkg>
The rule targets create the set of thirdparty packages which are built from local source archive copies of
thirdparty source code and patches, if needed. The build rule set of dependencies allows for compiling
multiple thirdparty programs simultaneously using maximum computer resources. This parallel build
speeds up the process considerably. For example, these are full static build timings on the production
build machine (full build includes building all thirdparty programs as well as all of cinelerra):
1 cpu = 61 mins
12 cpus = 7.5 mins
24 cpus = 2 mins

B.3 Translation Assistance for Program Messages
There are several “po” files for various languages to make cinelerra more usable for non-English
countries. A program, xlat.C, assists in providing several variations of text files that can be used in
order to allow anyone to help make meaningful translations.
To build a new cin.po file, do the following after moving to cinelerra's directory:
./po/xlat.sh > /tmp/cin.po
To use the xlat.C program, first compile it with “c++ xlat.C”. You can see the usage help here:
# ./a.out
list csv ./a.out csv < data.csv > data.po
list po ./a.out po < data.po > data.csv
list po ./a.out dups < data.po
list po ./a.out nodups < data.po
get strings ./a.out key < xgettext.po
gen xlation ./a.out xlat xgettext.po xlat.csv
gen xlation ./a.out xlat - text,xlat ... < xgettext.po
This program has 6 commands where the desired command is the first parameter to a.out.:
1) “csv” = comma separated value file; to recreate a po from a csv file.
2) “po” = convert po to csv data; for example, what you need to convert ru.po to ru.csv.
You can even open the resulting *.csv in ooffice and update the key->value replacements
(fields separated by "," only and check quoted fields as text during import). These results can
be "Saved As" a csv file, and then used by xlat.C to reformulate a “po”.
3) “dups” = list only key/value items where either the key=value or value=””.
4) “nodups” = list only key/value items where key!=value and value!=””.
5) “key” = list cin.po key set.
6) “xlat” = overlay translation. This is the most important use and is described next.
The xlat command line parameters specify a new cin.po template, usually created with xlat.sh, and a
list of key/value files which are used to build a mapping for the desired translation. The mapping files
are added to the mapping in the order they appear on the command line, and any existing key is
replaced with the newest definition; so typically the newest key/value data is last in the command
parameters. Once the mapping is built, the first parameter, the new po template, is scanned and the
keys it contains are used to find the latest mapping in the key/value files. The new value replaces the
existing value in the template. For example, to overlay a new map onto an existing po:
c++ xlat.C
./a.out po < xx.po > /tmp/xx.csv
./a.out po < new.po > /tnp/new.csv
./a.out xlat xx.po /tmp/xx.csv /tmp/new.csv > /tmp/new.po
The first run preserves the existing mapping of xx.po, the second creates new mappings from new.po,
and the third merges the original and new mappings to create a po with new included/overriding xx.po.

Of course, you can also use the freely-available “poedit” program to provide translations!
Update: some words and abbreviations can lead to ambiguous language translations. Therefore, a new
addition is the usage of C_ and D_ in the program code to represent Contextual and Definitional
exceptions to the usual _ and N_ . You will see the following:
C_(“msgstr”) is translated to D_(“qual#msgstr”) by xlat.sh,
and invokes gettext with msgid = “qual#msgstr”.
When no 'po' translation is supplied, the qual# is removed, and only the default 'msgstr' text is
displayed. If a 'po' translation is defined for the current locale, then the translated msgid =
'qual#msgstr' is used to access the translated msgstr.
The default MSGQUAL is the basename of the C source file. For the file src_file.C, the default
MSGQUAL is
#define MSGQUAL “src_file”
It is used to define the qualifier needed to transform:
C_(“str”) to D_(“src_file#str”)
The resulting xlat.sh'd source is scanned by xgettext to create the initial cin.po. In other words:
_(s) does normal international text translation as always The msgid line is: msgid “s”
C_(s) makes it appear as if you used D_(“src_file#” s) The msgid line is: msgid “src_file#s”
If it does not translate, the default msgtext is “s”, not “src_file#s”
D_(qual#s) trys to look up _(qual#s) This msgid line is: msgid “qual#s”,
If it does not translate, the default msgtext is “s”, not “qual#s”
Summary:
use _(s) as usual in almost all cases
use C_(s) if this source file has specialized meaning for s
use D_(qual#s) if this source file has several meanings for s

C. Auxilliary Programs
C.1. Using Ydiff to check results
Delivered with Infinity cinelerra and in the cinelerra path, there is a file named “ydiff.C”. This
program compares the output from 2 files to see the differences . Go to that directory and keyin “make

ydiff”. Y
You can now use this to check the quality differences of various outputs. For example, in this same
directory keyin:
./ydiff /tmp/yourfile.mp4 /tmp/yourfile.mp4
Since you are comparing a file to itself, you will see a clean looking white window in the left-hand
corner and columns 2,3,4 will be all zeros. Run this same command with a 3rd spacing parameter of
-1 as shown below, and you will see artifacts of comparing 2 files starting in a different position.
./ydiff /tmp/yourfile.mp4 /tmp/yourfile.mp4 -1
Now render yourfile using different quality levels and run ydiff to compare the 2 results. You will see
only noise difference which accounts for the quality level. Columns 2,3,4 might no longer be exactly
zero but will represent only noise differences. The ydiff output is debug data with lines that show
frame size in bytes, sum of error, and sum of absolute value of error. The frames size is sort of useless,
the sum of error shows frame gray point drift and the abs error is the total linear color error between the
images. At the very end is the total gray point drift and total absolute error on the last line.
Screencasts below illustrate an exact match and then “giraffe” artifacts on 2 files spaced differently.

D. Shortcuts
Main Menu (- is a checkbox)
PULLDOWNS Menu Items
File
Pulldown

Edit
Pulldown

Keyframes
Pulldown

04/03/2018 update
Shortcuts
Description

New
Load files…
- load tool
- load tool
Save
Save As…
Export Project
Record…
Scan…
SubTitle…
Render…
Export EDL…
Batch Render..
BD Render…
DVD Render…
Quit
Dump EDL
Dump Plugins
Load Backup
Save Backup

'n'
'o'
‘Ctrl-a’
‘Ctrl-z’
's'
‘Shift-S’
‘Alt-s’
'r'
'Ctrl-Alt-s’
'Alt-y'
'Shift-R'
'Shift-E'
'Shift-B'
'Ctrl-d'
'Shift-D'
'q'

Undo clear
Redo
Cut
Split
Copy
Paste
Clear
Paste Silence
Mute Selection 'm'
Trim Selection
Select All
Shuffle Edits
Reverse Edits
Edit Length…
Align Edits
Trans. Length…
Detach trans.
Clear labels
Cut ads
paste subttl

'z'
'Shift-Z'
'x'
‘x’
'c'
'v’
'Del'
'Shift-Space'

Cut Keyframes
Copy Keyframes
Paste Keyframes
Clear Keyframes
Change to linear

'Shift-X'
'Shift-C'
'Shift-V'
'Shift-Del'

‘b’

'a'

'y'

Create new project
Load file(s)
Selects all files
Deselects any highlighted files
Save project
Save and name project
Save a project for easy moving
Open record window
Open dvb scan window
Open subtitle script window
Open render window
Open export EDL window
Open batch render window
Open create bluray disk window
Open create dvd disk window
Quit the program
Write current EDL to stdout
Write defined Plugins to stdout
Load auto-backup file “backup.xml”
Save auto-backup file “backup.xml”
Undo from history previous operation
Redo from history next opration
Copy selection to cut buffer and delete
Split edit into 2 sections at hairline cursor
Copy selection to cut buffer
Insert selection from cut buffer
Delete selection
Paste empty edit at selection or frame if none
Replace selection with empty edit
Replace track with selection
Toggle select all/none
Randomly reorder track edits
Reverse track edits
Change selected track given duration
Change selected corresp. track edits to start/end same
Change selected track transitions to given duration
Remove selected track transitions
Delete selected timeline label markers
Remove selected region, add to commercial trking db
Replace selected subtitle edit text w/ subtitle script text
Copy selected keyframes to cut buffer and delete
Copy selected keyframes to cut buffer
Paste keyframes in cut buffer
Delete selected keyframes
Change keyframe auto curves to piecewise linear

Change 2 smooth
Create curve type

Change selected keyframes auto curves to bezier
Set new keyframe type: smooth,linear,tangent,disjoint

Copy default key
Paste default key

'Alt-c'
'Alt-v'

Copy default keyframe to clipboard
Paste clipboard keyframe into default keyframe

Audio
Pulldown

Add track
Default Trans.
Map 1:1
Map 5.1:2
Attach Trans.
Attach Effect…
Render Effect…

't'
'u'

Append new empty audio track
Insert default audio transition at selected edit boundary
Setup audio mixing output = input
Setup audio mixing stereo = 5.1
Open audio transition select for insert at edit boundary
Open audio selection menu for insert at edit boundary
Open audio render select to render from select as pcm

Video
Pulldown

Add track
Default Trans.
Attach Trans.
Attach Effect…
Render Effect…

'Shift-T'
'Shift-U'

Append new empty video track
Insert default video transition at selected edit boundary
Open video transition select for insert at edit boundary
Open video effect selection for insert at edit boundary
Open video render select to render from select as pcm

Tracks
Pulldown

Move tracks up
Move trks down
Delete tracks
Delete last track
Concatenate trks
Append to Proj.
add Subttl

'Shift-Up'
'Shift-Down'

Circulate tracks up
Circulate tracks down
Delete all tracks
Delete last track
Concatenate tracks together
Add set of tracks
Add subtitle track

Format…
Preferences…
- Edit labels
- Edit effects
- Keyfrs fol. edits
- Align on frames
- Typeless keyfrs
Proxy Settings
Save settings
Loop Playback
Set bkg render

'Shift-F'
'Shift-P'

'Shift-L'
'Shift-G’

Open render format setup menu
Open preferences setup menu
Toggle labels follow edits
Toggle plugins follow edits
Toggle keyframes follow edits
Toggle align cursor
Toggle typeless keyframes mode
Bring up Proxy settings window
Save Cinelerra_rc
Set loop playback region to selection/all
Toggle background rendering

- Show assets
- Show titles
- Show trans.
- Fade
- Mute
- Overlay Mode
- Pan
- Plugin Autos
- Mask
- Speed
- Camera X
- Camera Y

'0'
'1'
'2'
'3'
'4'
'5'
'6'
'7'
'8'
'9'
‘Ctrl-Shift-X’
‘Ctrl-Shift-Y’

Toggle show asset data
Toggle show asset title
Toggle show transition effects
Toggle show fade auto curves
Toggle show mute auto curves
Toggle show mode auto curves
Toggle show pan auto curves
Toggle show plugin keyframes
Toggle show mask auto keyframes
Toggle show speed auto curves
Toggle show camera X auto curves
Toggle show camera Y auto curves

Settings
Pulldown

View
Pulldown

'd'
'Shift-N'
'Shift-Y'

‘Alt-r’

- Camera Z
- Projector X
- Projector Y
- Projector Z
Window
Pulldown

>_._

- Show Viewer
- Show Resrs.
- Show Compos.
- Show Overlays
- Show Levels
- Split X pane
- Split Y pane
Mixer Viewer
Tile mixers
Default Positions
Tile Left
Tile Right

‘Ctrl-Shift-Z’
‘Alt-Shift-X’
‘Alt-Shift-Y’
‘Alt-Shift-Z’

'Ctrl-1'
'Ctrl-2'
‘Shift-M’
‘Alt-t’
'Ctrl-p'

Toggle show camera Z auto curves
Toggle show projector X auto curves
Toggle show projector Y auto curves
Toggle show projector Z auto curves
Toggle show view window
Toggle show resources window
Toggle show compositor window
Toggle show auto overlay window
Toggle show audio levels window
Toggle ½ horiz track timeline window panes
Toggle ½ horiz track timeline window panes
Bring up a Mixer Viewer window
Tile mixer windows to original position/size
Reset window positions/size to defaults
Set window positions/sizes to tile left screen
Set window positions/size to tile right screen

shell cmds

Top rt. Corner Run scripts (setup in interface preferences)

BUTTONS

Menu Items

Shortcuts

Description

Transport
Buttons

Rewind
Fast reverse
Normal reverse
Frame reverse
Stop
Frame forward
Normal forward
Fast forward
Jump to end
(No button)
(No button)
(No button)
(No button)
(No button)
(No button)
(No button)
(No button)

'home'
'KP +' / Alt-p
'KP 6' / Alt-o
'KP 4' / Alt-u
'KP 0' / Alt-m
'KP 1' / Alt-j
'KP 3' / Alt-l
'KP Enter'/A-;
'end'
'KP 5' / Alt-i
'KP 2' / Alt-k
'Shift-KP1’
'Shift-KP2’
'Shift-KP3’
'Shift-KP4’
'Shift-KP5’
'Shift-KP6’
'Ctrl-KP#’
+Shift w/Alt
+Shift w/Ctrl

Jump to beginning
Double speed reverse play
Normal speed reverse play
Render previous frame
Stop playback
Render next frame
Normal speed forward play
Double speed forward play
Jump to end
Slow speed reverse play
Slow speed forward play
Render next frame and audio
Slow speed forward play without audio
Normal speed forward play without audio
Render previous frame and audio
Slow speed reverse play without audio
Normal speed reverse play without audio
If [ ] set, “KP2,3,5,6,+,enter” between in/out
Shift with Alt+x above, adds/removes audio
Loops play, all or between In/Out

Edit Modes

Auto Gen. Keys
Lock Labels
Editing choice
Editing choice

‘j’

Generate keyframes while tweeking
Lock labels from moving
Drag and drop editing mode
Cut and paste editing mode

Main Menu

Edit
In point
Operations Out point
To clip
Split

'[' or ‘<’
']' or ‘>’
‘Ctrl-t’
'i’
‘x’

Toggle In point timeline marker
Toggle Out point timeline marker
Clear both In and Out pointers
Copy selection and create clip
Split edit into 2 sections at hairline cursor

Cut
Copy
Paste
Toggle label
Previous label
Next label
Next label select
Prev label select
Next keyframe
Previous keyframe
Next keyframe select
Previous keyfr select
Previous edit
Next edit
Cut left label
Cut right label
Cut previous edit
Cut next edit
Fit
Auto Fit
Auto Fit
Undo
Redo
Manual Goto

'x'
Copy selection to cut buffer and delete
'c'
Copy selection to cut buffer
'v'
Insert selection from cut buffer
'l'
Toggle label at current position
'Ctrl ←'
Move to label before cursor
'Ctrl →'
Move to label after cursor
‘Ctrl-Shift→’ Select from cursor to next label
‘Ctrl-Shift←’ Select from cursor to previous label
‘k’
Move to next keyframe
‘Ctrl-k’
Move to previous keyframe
‘Shift-K’
Select from cursor to next keyframe
‘Ctrl-Shift-K’ Select from cursor to previous keyframe
'Alt ←'
Move to previous edit
'Alt →'
Move to next edit
Ctl-alt-shift'-<' Cut from insert pointer to previous label
Ctl-alt-shift -'>' Cut from insert pointer to next label
Ctrl-alt- ','
Cut from insert pointer to previous edit
Ctrl-alt- '.'
Cut from insert pointer to next edit
'f'
Fit time displayed to selection
'Alt-f'’
Fit the max/min range of all automation types
'Ctrl-alt-f’
Fit the max/min range of current automation types
'z'
Undo from history previous operation
'Shift-Z'
Redo from history next operation
'g'
Jump to time selected by popup

FFMpeg probes - FFMPEG early
early/late

Top rt. Corner Run ffmpeg open probes first / last

Main Window Key

Qualifier

Key

'e'
'1 through 9'
'1 through 8'
← (left arrow)
← (left arrow)
← (left arrow)
← (left arrow)
← (left arrow)
→ (right arrow)
→ (right arrow)
→ (right arrow)
→ (right arrow)
→ (right arrow)
, (comma)
, (comma)

Alt
Ctrl
Alt
Shift-ctrl
Shift-alt
Ctrl
Alt
Shift-ctrl
Shift-alt
Ctrl

Description
Toggle editing mode: from cut&paste or drag&drop
Toggle auto mode settings as in main menu shortcuts
Select asset pgm 1-8; reset format (remove other trks)
Scroll window timeline display left (not insertion pt)
Move cursor to label left of cursor (main shortcuts)
Move cursor to edit boundary left of cursor position
Move cursor to label left of cursor, expand selection
Move cursor to edit boundary left of cursor&expand
Scroll window timeline display right (not insertion pt)
Move cursor to label right of cursor (main shortcuts)
Move cursor to edit boundary right of cursor position
Move cursor to label right of cursor, expand selection
Move cursor to edit boundary right of cursor&expand
Scroll window timeline display left (not insertion pt)
Move cursor to label left of cursor (main shortcuts)

, (comma)
. (period)
. (period)
. (period)
UP (up arrow)
UP (up arrow)
UP (up arrow)
UP (up arrow)
DOWN arrow

Alt

DOWN arrow
DOWN arrow
DOWN arrow
PGUP (page up)
PGUP (page up)
Pgdn page down
Pgdn page down
Home
End

Ctrl
Alt
Ctrl-alt

Ctrl
Alt
Ctrl-alt

Ctrl
Shift
Shift
‘Ctrl+Shift’
‘Ctrl+Shift’
‘Ctrl+Shift’
‘Ctrl+Shift’

Decrease audio sample waveform scale
Decrease auto curve limits (zoombar selected curve)
Decrease all auto curve limits
Scroll current track horiz window pane up
Increase track scale geometry (zoom in track data)
Scroll current track horiz window pane down
Decrease track scale geometry (zoom out track data)
Move insertion point to beginning of timeline
Move insertion point to end of timeline
Over edit causes highlight section to extend to cursor
Over boundary of effect, trims only that effect
Over Hard Edge of Blade Cut, toggles marker
Between labels, highlights selection
Toggle single track arming status
Toggle all of the other tracks arming status
On plugin title bar, selects that area
On an edit, selects that area
On subtitle track, displays text in Line text
On fade/speed, synch video/audio ganged
On fade/speed, select keyframe position
Paste the last Video transition
Paste the last Audio transition
Proxy quick switch
Toggle on/off all XYZ of camera
Toggle on/off all XYZ of projector
Use window layout #1
Use window layout #2
Use window layout #3
Use window layout #4

Qualifier

Description

Left mouse btn
Middle mouse btn
Left mouse btn
Click label
Click In/Out

Ctrl
Ctrl
Hold LMB
Hold LMB

Changes to the next time format
Change to the previous time format
Moves cursor position on the timeline
Drag label to elsewhere
Drag In/Out pointer elsewhere

Shift/Move

Hold LMB

On Fade slider bar, sets gain to 100% or 0db

Menu Items

Shortcuts

Description

Toggle single trk
Toggle other trks

‘U’
‘u
‘r’
F1
F2
F1
F2
F3
F4

Timebar Key

Patchbay

Ctrl
Alt

Move cursor to edit boundary left of cursor position
Scroll window timeline display right (not insertion pt)
Move cursor to label right of cursor (main shortcuts)
Move cursor to edit boundary right of cursor position
Increase timeline duration (zoom out timeline)
Increase audio sample waveform scale
Increase auto curve limits (zoombar selected curve)
Increase all auto curve limits
Decrease timeline duration (zoom in timeline)

Ctrl
Ctrl
'Shift+click’
'Shift+click’
‘Shift+click’
Double click
'Tab’
'Shift-tab’
Double click
Double click
Double click
Double click
DoubleMMB

Compositor
BUTTONS

Keypresses

Protect video
Zoom view
Edit mask
+ Edit mask
+ Edit mask
+ Edit mask
+ Delete mask
Ruler
+ ruler hotkey
+ ruler hotkey
Adjust camera
Adjust projector
Crop layer/outpt
+ crop tool
+ crop tool

F1
F2
F3
Shift-drag pt.
Ctrl-drag pt.
Alt-drag mask
Shf+delete btn
F4
Ctrl
Alt
F5
F6
F7
Click-drag
Click-drag

Disable changes to the compositor output
Zoom in view without resizing the window
Brings up the mask editing tool
Hold down shift+left mouse to drag a point
Hold down Ctrl+left mouse to move control pointers
Hold down Alt+left mouse to translate mask
Hold down Shift + click Delete button to delete mask
Brings up the ruler for usage
Lock ruler to nearest 45 degree angle
Translate the ruler
Brings up the camera editing tool
Brings up the projector editing tool
Crop a layer or output
In video, starts a new rectangle
Over rectangle to reposition

+ crop tool
Get color
Show tool info
Show safe regs.

Alt-click
F8
F9
F10
‘p’
Shift+w/Ctrl

In cropping rectangle to translate
Detects color at current spot & stores temporary
Works with editing/cropping buttons
Draws safe regions in the video output
Turn on/off Click to Play
With transport btn. loops play; all or with []

Key

Qualifier

Description

Mid. click+drag
Right click
Lt clk Zoom
Lt clk Zoom
Lt clk Zoom
'+' or ‘=’
'-'

Timebar

Ctrl
Shift-alt

If zoom in, pans the view
Brings up zoom%/auto;reset cam/proj;hide ctrls
Zooms in
Zooms out
Zooms out
Zooms in video output
Zooms out video output

f
F11
F12
Click label
Click In/Out

Hold LMB
Hold LMB

Toggle on/off fullscreen
Reset camera
Reset projector
Drag label to elsewhere
Drag In/Out elsewhere

Key

Qualifier

Description

Left mouse btn
Middle mouse btn
Left mouse btn
Double click
Click label
Click In/Out
Fat arrow end

Ctrl
Ctrl
Hold LMB
Hold LMB
Hold RMB

Changes to the next time format
Change to the previous time format
Moves cursor position on the timeline
If between labels, selects that section
Drag label to elsewhere
Drag In/Out pointer elsewhere
Preview region drag on blue-colored bar

‘Left click’
Middle click

Same as in Main window
Same as in Main window
Only Protect enabled, start/stop forward play
Only Protect enabled, start/stop play reverse

Transport & (plus 3 below)
Edit Buttons (plus 3 below)

Middlewheel
‘p’

Only Protect enabled, plays forw/rev 1 frame
Turns on/off Click to Play button

Menu Items

Shortcuts

Description

Rewind
Fast reverse
Normal reverse
Frame reverse
Stop
Frame forward
Normal forward
Fast forward
Jump to end
(No button)
(No button)

'home'
'KP +' /Alt-p
'KP 6' / Alt-o
'KP 4' / Alt-u
'KP 0' / Alt-m
'KP 1' / Alt-j
'KP 3' / Alt-l
'KP Enter'/A-;
'end'
'KP 5' / Alt-i
'KP 2' / Alt-k
'KP#-Shift’
'Ctrl-KP#’
+Shift w/Alt
+Shift w/Ctrl
‘Left click’
Middle click
Middle wheel
‘p’
'[' or ‘<’
']' or ‘>’
‘Ctrl-t’
'v'
'b'

Jump to beginning
Toggle double speed reverse play
Toggle normal speed reverse play
Render previous frame
Stop playback
Render next frame
Toggle normal speed forward play
Toggle double speed forward play
Jump to end
Toggle slow speed reverse play
Toggle slow speed forward play
Shift added to KP #, adds or subtracts audio
If [ ] set, “KP2,3,5,6,+,enter” play between ptrs.
Shift with Alt+x above, adds/remove audio
Loops play; all or between In/Out
Start or stop play forward
Start or stop play reverse
Play forward or reverse 1 frame
Turns on/off Click to Play button
Toggle In point timeline marker
Toggle Out point timeline marker
Clear both In and Out pointers
Create splice
Overwrite

To clip
Copy
Splice
Overwrite
To clip
Copy
Show meters
Toggle label
Previous label
Next label
Manual Goto

'i‘
'c'
'v' + Shift
'b' + Shift
'i' + Shift
'c' + Shift
'l'
'Ctrl ←'
'Ctrl →'
'g'

Copy selection and create clip
Copy selection to cut buffer
Create splice of the entire clip
Overwrite using the entire clip
Copy all and create clip
Copy entire clip to cut buffer
Toggle show meters
Toggle label at current position
Move to label before cursor
Move to label after cursor
Jump to time selected by popup

Key

Qualifier

Description

Viewer
BUTTONS

In point
Out point
Splice
Overwrite

Keypresses

Right click

Timebar

Key
Left mouse btn
Double click
Click label
Click In/Out
Fat arrow end

Most WindowsESC

Brings up fullscreen/zoom/close menu

Qualifier

Description

Hold LMB
Hold LMB
Hold RMB

Moves cursor position on the timeline
If between labels, selects that section
Drag label to elsewhere
Drag In/Out pointer elsewhere
Preview region drag on blue-colored bar
Cancels operation if no one grabs first

ENTER

Mixer

Menu Items

Cancels operation if no one grabs first

Shortcuts

Description

Double click

On mixer window, pastes into timeline

An Event

Double click

Executes the item event (e.g. Load highlighted file)

Textboxes Key

Qualifier

Description

Tab
Tab
Esc
Left arrow
Left arrow
Left arrow
Left arrow
Right arrow
Right arrow
Right arrow
Right arrow
Up arrow
Down arrow
Up arrow
Down arrow
PGUP (page up)
Pgdn page down
PGUP (page up)
Pgdn page down
End
End
Home
Home
Backspace
Delete
Ctrl-c
Ctrl-v
Ctrl-x

(also+’Shift’)
(also+'Shift’)
(also+'Shift’)
Double click
Double click

Move cursor to the next textbox
Move cursor to the previous textbox
Cancels any active suggestions
Backs up 1 character
Backs up to beginning of word/next word
Selects/Deselects previous character highlight
Selects/Deselects previous word highlight
Moves forward 1 character
Moves to beginning of next word
Adds selection highlight to the next character
Expands highlight to the next word
Move up to next line, same position
Move down to next line, same position
Selects/Deselects up to the previous line X-coord
Select/Deselect down 1 line from the X-coord
Goes to the beginning of the page
Goes to the end of the page
Highlights selection above Ibeam to page start
Highlights selection below Ibeam to page end
Cancels selection and goes to end of line
Selects to end of line
Goes to the beginning of the line
Highlights from ibeam to beginning of line
Deletes the character in back of the ibeam
Deletes the next character
Copies selection to the 2nd cut buffer
Pastes selection from the 2nd cut buffer
Copies selection to 2nd cut buffer and delete
On word in textbox, highlites that word
On highlighted Probe order, enables/disables

Triple click

In subtitle script text, loads line into line text

'Shift’
with ibeam
'Ctrl’
'Shift’
'Ctrl-Shift’
with ibeam
'Ctrl’
'Shift’
'Ctrl-Shift’
'Shift’
'Shift’
'Shift’
'Shift’
'Shift’
'Shift’

Unicode

Ctrl-U
Enter
Esc
Backspace
A-F, 0-9

'Shift’

Go into Unicode enter mode
Fires the Unicode
Cancels Unicode state
Deletes previous character
Enters the hex code

Resources
Window

Key

Qualifier

Description

Drag Mouse

‘Shift’
Double click
Single click

Hold down Shift and drag to move text icon
Draw vicons off- loads media in Viewer
Draw vicons on- bigger thumbnail plays or stops

‘v’
‘o’
- load tool
- load tool
DEL key
DEL key
DEL key

‘Shift’
‘Ctrl+Shift’

Switch to next Display option
Opens Load files… menu
Selects all files
Deselects any highlighted files
Resources/Media, deletes highlighted from project
Resources/Media, deletes highlighted from disk + OK
Resources/plugin, deletes highlighted from disk + OK

‘Ctrl-a”
‘Ctrl-z’

Overlays
Window

Key

Qualifier

Description

LMB

‘Shift’

Turns off all else, or reverts to previous state

Record
Window

Menu Items

Shortcuts

Description

Start/pause
Label

'space bar’
'l’
Double click

Start and pause recording of current batch
Toggle label at current position
On channel in window, pops edit ch window

Menu Items

Shortcuts

Description

Double click
Double click

Select a channel
Add another channel
Edit the wording associated with the channel
Move the channel up in the selection
Move the channel down in the selection
Sort all of the channels numerically
Scan the available channels
Delete the selected channel
Select the device picture
In Find window, cursor moves to hilite program
On batchbay line, selects and loads ch info

Channels
BUTTONS

Select
Add…
Edit…
Move up
Move down
Sort
Scan
Delete
Picture…

Remote
Control

Commercial

MENU
KPTV
KPBOOK
KPHAND

Toggle remote control state (grabs/ungrabs keys)
Open or close the record window
Start/stop dvb channel scan
Quit cinelerra program
‘Shift-A’

Edit commercial

